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About this Guide 
The present Guide is a complete operation handbook of the signal processing 
package – WinPOS. This Guide is intended for Windows users and thus does not 
include any description of standard elements of the Windows graphic user interface 
(GUI).  

Structure of the Guide  
Part 1 tells about features, application areas, and design history of WinPOS.  

Part 2 contains the information necessary for installation and updating of WinPOS, 
PC requirements.  

Part 3 describes the interface and provides a general description of the WinPOS 
operation principles. This Part also covers references to description of all interface 
items and can be used as a handbook of the batch operation.  

Parts 4 to 11 contain detailed descriptions of the operation methods and the 
WinPOS interface.  

Appendix A contains mathematical descriptions of WinPOS algorithms.  

Appendix B contains guidelines for the algorithm applications.  

Appendix C contains WinPOS file formats. 

Appendix D contains troubleshooting instructions.  

Glossary is provided at the end of this Guide.  
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Conventions 
The following conventions are used in the present Guide for the reader's 
convenience. 

< > Angle brackets indicate function keys and their combinations, e.g., 
<Ctrl> 

→ The symbol → is used to divide the menu levels. E.g., 
File→Open… means that the item Open… shall be selected in the 
File menu. 

File Bold denotes the names of menu items or dialog box elements that 
can be selected and enabled by mouse button click. 

Signal Italic denotes the names of the Guide chapters, WinPOS windows 
explained in the Glossary at their first appearance in the text 
further. 

signal Monospace font denotes text or characters to be entered from the 
keyboard, lines of configuration files. 

 Important information, caution or recommendation. 
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Part 1. Introduction  

What is WinPOS  
The software product WinPOS is intended for processing of the measuring data by 
standard mathematical and statistical algorithms, graphic representation and 
documenting of the data.  

WinPOS includes:  

• Powerful graphic interface (2D & 3D),  
• Batch data processing,  
• More than 50 signal processing algorithms,  
• Support of scripts (VBScript) and plug-ins,  
• Graph plotting means,  
• Report preparation,  
• Vibration analysis,  
• Signals with the length of up to 2 · 109 values,  
• Integration with MR-300 and Recorder software packages,  
• Detailed User’s Guide and Programmer’s Guide,  
• Extended help.  

WinPOS delivery versions  
WinPOS is delivered in four main versions: View, Standard, Professional and 
Expert.  

Unlike Standard, WinPOS View contains a demo algorithm set mainly intended for 
the measurement data viewing and documenting.  

WinPOS editions Professional and Expert allow creation of own signal processing 
algorithms, automation of the input signal processing from the source file selection 
to the processing output documenting. 3D signals are also supported by two major 
versions only.  

WinPOS Expert allows 
the analysis of stochastic, 
dynamic processes, 
including vibration ones 
(See Part 10 Vibration 
analysis).  

 Algorithms Scripts, 
plug-ins 

3D 
signals 

Vibration 
analysis 

view  
standard   
professional  
expert  
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WinPOS measurement cycle 
RPE «MERA» manufactures and 
supplies hardware and software 
means intended for full 
automation of measurement data 
acquisition and processing. 
WinPOS represents one of the 
final stages of the measurement 
cycle.  

Portable multi-channel equipment 
sets, testbeds and monitoring 
systems are equipped with 
recording software (Recorder and 
MR-300). The recording software 
operating as a digital tape recorder 
is able to perform specialized data 
processing and control.  

Further the registered data are 
processed by WinPOS, the 
switching to WinPOS is 
performed by pressing the button 

 on the recording program 
toolbars.  

The WinPOS algorithms together 
with scripts and plug-ins make the 
implementation of complex 
processing procedures possible. 
The processing completion is 
assisted by a professional toolset 
for report drawing. WinPOS 
perfectly completes the 
development registration tools of 
RPE «MERA», and successfully 
applied both as a separate tool and 
in combination with other 
research packages. 

Target 
object 

MIC-300

Recorder 

MR-300

WinPOS

Stand 
Automation 
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WinPOS design history  
The name WinPOS means the signal 
processing package (POS) for Windows.  

In early 90s the signal processing package – 
POS developed by RPE «MERA» became a 
revolutionary by its options software. The 
program was applied to almost all industry 
branches and was successfully used by many 
R&D institutions.  

 In mid 90s the package POS-M was 
developed, making application of advanced 
POS solutions to monitoring and to the 
testbeds possible. The energy production 
enterprises, aviation and machine building 
companies, sea-based space launch facility 
«Sea Launch» still operate POS-M.  

The limitations of MS-DOS and growing 
requirements to the measurement data volumes 
and convenience of the data processing and 
representation, constrained the improvement 
of POS and POS-M in their existing forms. 
Hence, WinPOS was elaborated.  

WinPOS inherited the best features of POS 
(powerful mathematical toolset, simplicity and 
convenience of operation, extendibility), and 
pushed such features to a new modern level.  

WinPOS Expert replaced the dynamic 
analyzers developed by RPE «MERA», i.e., 
DAN and WDAN software.  

In 2004 the official registration certificate of 
the software “Signal Processing Package 
WinPOS” was obtained.  
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PC requirements 
WinPOS is installed at any PC with Microsoft Windows 98 and higher (Windows 
2000, XP, etc.).  

On PC one USB or LPT port must be free (the parallel port key is transparent for 
communications between the PC and the external LPT-unit, e.g., printer).  

The software requires no more than 20 Mbytes of the disc space (depend upon the 
delivery version). But it is desirable you have a reserve of the disc space  for a 
storage of the calculation results. The PC processor clock rate must be not less than 
1 GHz, and RAM - not less than 128 Mb to provide the appropriate calculation 
speed 

 
In the bottom right corner WinPos shows a free space on the chosen disk, suffice for a 
place of the temporary files and a saving the sessions. If it is not enough places on this disk 
either clear it or select the other partition of the hard disk as a work catalog of the WinPos. 
(See part 4, Fig. 4.7.) 

You need a graphic adapter with OpenGL hardware accelerator and a mouse with a 
scrolling wheel for the operation with 3D graphics. 
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Part 2. WinPOS installation  
Insert WinPOS CD to your PC CD-ROM 
drive. The WinPOS installation starts 
immediately. If autorun option is disabled, run 
the file Setup.exe from the CD root directory. 
Select «Install WinPOS» in the window.  

Follow the setup program instructions. Use the 
buttons < Back and Next > to switch the pages 
(Fig. 2.1), and when the setup is finished, press 
Install and Finish on the last page.  

In the course of installation you shall be 
offered to read the License agreement. 
Confirm your acceptance by clicking «I accept the license agreement».  

The installation program let you:  
• change the default installation path (C:\Program Files\MERA\WinPOS),  
• rename the program group in the Start menu,  
• select the installed software content: set complete or 

compact installation, or tick the necessary items (See 
Fig. 2.2),  

• place the shortcuts on the desktop and quick start bar 
to make the WinPOS start easier.  

When the installation is complete, your PC should be 
restarted. When WinPOS is updated, you can select «No, I will restart computer 
later».  

The WinPOS start requires a connection of an electronic USB-dongle or LPT-key. 
The installation program provides a detailed instruction on the connection and the  
operation of electronic keys in the file instruct.pdf (subdirectory \Active of the 
WinPOS installation folder).  

 

USB-dongle should not be connected to the computer before WinPOS is installed, otherwise 
Windows starts its search for the driver. Cancel the driver searching by the Windows New 
Hardware Found Wizard by pressing the button Cancel, and disconnect the USB-dongle 
from the computer. 

Windows NT/2000/XP requires the user to have the Administrator rights. In case the user 
has default rights, Windows NT disables the operations of installation, deletion and 
configuration of drivers.  

The Add Hardware Wizard is started by Windows XP after the USB-dongle has been inserted 
into the port. Follow instructions of the Wizard. Ignore the warning that drivers were not 
tested for compatibility with XP, and proceed with the installation process. 

Fig. 2.2. Software content 

Fig. 2.1. WinPOS setup window 
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WinPOS start  
WinPOS could be started from the desktop, quick start menu, and Windows Start 
menu. The recorded signals could be opened in WinPOS by clicking the MR-300 
and Recorder toolbar button or by double clicking the data file name (of MERA or 
USML format) in Windows Explorer.  

Version upgrade  
An upgraded WinPOS version can be downloaded from www.nppmera.ru 
(Support/Download section). The setup program filename depends upon the delivery 
version and version number of WinPOS. An example of the filename is given 
below:  

winpos-3.0.0.0-pro-setup.exe 

Where: 3.0.0.0 – version number, pro - delivery version (See Part 1, Section 
WinPOS delivery versions).  

The list of updates and corrections is provided in the file WhatsNew.txt that can be 
found in the WinPOS setup directory.  

To minimize download time, the setup program does not contain User’s Guide 
(WPUsersGuide.pdf) and Programmer’s Guide (WPProgrammersGuide.pdf) files. 
The latest versions of these documents could be downloaded from the same 
webpage. The downloaded versions saved in one catalog with the setup program will 
be installed in the same way as from CD. These files also can be copied to the 
WinPOS folder.  

 
The algorithms are delivered as a dynamic link library wpOperators.dll. At WinPos.exe start 
a menu item is added for each algorithm (Algorithms menu). The additional algorithm 
libraries are included by copying to the "DLL" subdirectory of the WinPOS folder. 

Upgrade of delivery version  

The WinPOS electronic key allows the start of its delivery version as well as lighter 
versions of the package. If WinPOS higher version has to be used. i.e., at the 
transition «View» → «Standard» → «Professional» → «Expert», the key can be 
remotely reprogrammed.  
After the higher version of WinPOS is paid, run the program GSRemote.exe from the WinPOS setup 
directory, select Update key memory, and then Create the question number. The obtained question 
number shall be sent to winpos@nppmera.ru. When a response number is received, select Process the 
response number and Update memory block in the same program, then enter response number to the 
respective field. If the update is successful, the ordered WinPOS version can be downloaded and 
installed. 
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Part 3. Getting started 

WinPOS features  
While WinPOS development a special attention was paid to optimization of the user 
interface, simplification of repeated operations without loss of flexibility and 
customization options.  

For example, to plot graphically all parameters in an open file, one movement of the 
mouse is necessary. The processing range can be set by one operation. Choose an 
algorithm in the context menu, customize it if necessary, press the button Done, and 
then you are able to view plotted results. 

This user interface model is based upon several principles.  

1. WYSIWYG (the actual items are processed). By default, 
any action is related to the signal(s) currently represented by 
the graph. If only a fragment of a signal is displayed - the 
processing will be performed within the selected range.  

2. All WinPOS objects are stored in the hierarchy structure - 
global tree, which performs in WinPOS the same functions 
as a catalog or file system in Windows. Any signal, graphic 
or algorithm has its name and place in the tree. Hence, even 
if the signal is not plotted, this signal can be accessed via the 
tree.  

3. Batch processing. The operation with folder of the tree 
enables processing of all objects of this folder. Hence, all 
signals of the folder, graph or page can be processed as one 
signal.  

The present part also contains a brief description of the WinPOS interface which 
(especially the Figures 3.1-3.3) can be further used as a reference book to study 
other parts of the Guide and further operation in WinPOS. 

 

WinPOS interface. Main window 
The program is controlled by the graphic interface, usual for Windows users. The 
view of the WinPOS main window is shown in Figure 3.1.  
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Fig. 3.1. WinPOS. General view 

Page 

 

Folder 

 

 Graph 

 

 Line 

 

 Signal 

 

Fig. 3.2. Context menu of the main WinPOS objects 
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File 

 

Vibroanalysis 

View 

 

Script 

 

   Algorithms 

 

    Window 

 

Tools 

 

Help 

 

Fig. 3.3.  Main menu  

 

The major part of the window is occupied by the workspace containing pages with 
graphs. Tree bar is usually placed on the left to the workspace. Signal tree is placed 
in the lower part of the workspace, and Graph tree in the upper part. 
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Signal tree  

All signals opened in WinPOS are placed to the global tree to 
the Signals folder. The content of this folder is shown in the 
Signal tree.  

The signals are grouped to folders. All calculation results get 
to the folder Results. The MERA and USML formats files are 
placed to the tree as signal folders when you open.  

Click on the glyph «+» on the left of the folder name to open the folder content, 
click «-» to hide it. Double click at the folder to create the graph page of the folder 
signals. Double click at the signal to open Add lines dialog (Fig. 3.5).  
 

Graph tree  

The top level of the signal tree consists of pages associated with 
the graphs, and the lines which plot a signal are associated with 
graphs.  

Any of the above items can be activated by double click at the 
name of page, graph or line. The selected page is displayed 

above all other pages in the workspace, the graph is marked by a, and the line is 
displayed above all other plots of the graph and is shown by bold font in the legend. 
See part 6 Viewing graphs.  
 

Main menu  

The general view of the main menu is shown in Figure 3.3. The full description of 
the main menu is provided in the respective parts of the present Guide (named in 
brackets).  

File: open and save files, save and load settings, exit. The lower part of the menu 
contains the list of recently open files. (See part 4. Signal loading and saving).  

Algorithms: the list of signal processing algorithms (See Part 9. Signal processing), 
save and load the algorithm settings.  

Vibroanalysis (WinPOS Expert only): the list of vibration analysis algorithms (See 
Part 10. Vibration analysis), save and load the algorithm settings.  

View: change view of WinPOS, enable and disable toolbars and secondary windows 
(See WinPOS secondary windows below). The enabled item is marked by a tick on 
the left.  
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Script (WinPOS Professional and Expert only): embedded editor, script running 
(See part 11. WinPOS scripts). The lower part of the menu contains the list of 
recently executed scripts.  

Tools: commands of the graph control panel, call settings dialog of the active graph 
and default settings (See Part 6 Signal viewing), documenting commands (duplicated 
on the main toolbar, See Part 8 Report drawing and printing).  

Window: commands of new page creation (See part 5. Graph creation), standard 
MDI Windows commands arranging pages in the workspace (usually all workspace 
is occupied by the current page). The lower part of the menu contains the list of 
created pages. The active page is marked by a tick.  

Help - access to the WinPOS help system (Contents…) and the information About 
WinPOS…: program version, technical support phone number, and other contact 
information.  
 

Context menu  

The WinPOS objects can be controlled by the context menu accessible by clicking 
the right mouse key over the selected item (Fig. 3.2).  

For example, to open the page context menu click the right mouse key over the page 
name in the graph tree.  

Graph context menu – click in the graph tree or over the graph field. The graph 
context menu also contains the page menu items.  

Line context menu – click in the graph tree or over the signal name in the legend.  

Folder and signal context menu – click in the signal tree.  
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Toolbars  

The most important WinPOS control commands are included into the toolbar. By 
customizing toolbars in the View menu the optimum set of tools for any task is 
selected. The numbers of parts of the present Guide containing the descriptions of 
these tools are given in brackets. The most convenient arrangement of toolbars can 
be selected by moving the toolbars with the mouse (drag the left side of the toolbar 
with the mouse).  

Main tool panel Additional tool panel 

 Create a new page (5) Modulation vibrocursor 

 Create a new 3D page (5) Harmonic vibrocursor 

 Signal load Differential cursor 

 Signal export (4) Extended information of a differential 
cursor 

 Group signals by origin Show marks, modes, breakpoints, settings 
and status 

 Add into the graph Set, rename, remove a marker (mode) 

 Open Signal Manager (7) Selection of a displaying mode  of the 
registration with pauses 

 Print Normalization with UTS(6) 

 Save page screenshot in file Edit panel 

 Screenshot in clipboard (8) Edit values 

Graph panel Change signal values 

 Spin of the graph Signals concatenation 

 Scaling of a graph Copy to a new signal  

 Show cursor Copy a signal fragment  

 Normalize graph Past into selected graph/page  

 Return to previous range Past  into a new graph /page 

 Grid Delete a signal fragment 

 Vertical lines from points of the signal (8) Cancellation of a signal editing  

 Plotting style Folder editing (7) 

 View mode The control panel of the table 

 Move and turn of a graph New table 
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 Set label  Save changes 

 Set comment Save table as… 

 Synchronization of  cursors (6) Undo last changes 

 Settings (5) Redo last changes (6) 

Scroll panel Work with MSOffice 

 Decrease speed Send page to MSWord 

 To the left Send page to MSExcel 

 Stop   

 To the right Min/max search 

 Increase speed Set the label on a minimum 

 Play Set the cursor on a maximum 

 Playback Set the cursor on a minimum 

 Volume control(6) Set the label on a maximum 
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WinPOS secondary windows  
Algorithm customization dialog  

 
Fig. 3.4. Algorithm customization dialog 

Most of the signal processing algorithms requires additional customization 
performed at selection of the processing option in the submenu Algorithms of the 
main menu or context menu. The right part of the customization window sets the 
data sources, and is similar for all algorithms. The left one contains the 
customization settings of the selected operator.  

The detailed description is provided in the Part 9. Signal processing.  
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Signal selection 

 
Fig 3.5. Signal selection  

The Select signal dialog is opened by the Browse button of the algorithm 
customization window and the save signal window (Fig. 3.5).  

In the left part of the window the signal is selected from the Signal tree or Graph 
tree (switched by tabs at the bottom of the tree window). The right part of the 
window contains brief information on the selected signals.  

Preview window at the bottom on the right is used for selection of a signal part for 
further work, as well as the input textboxes. 

In order to modify or select the range move the left and the right cursors in the 
preview window (at selection of the whole signal cursors are located at the graph 
margins), or type the exact values in the textboxes X or Ind. The checkboxes at the 
right of these fields are used for setting the range selection mode in case of batch 
processing of the signals from one folder (mark Max checkbox to select the whole 
signal).  
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See also Part 4, section Signal saving and Part 9 Signal processing.  

 
 

Signal manager 

 
Fig. 3.6. Signal manager 

The Signal manager is intended for a viewing and an editing of the data of files, 
signals, calibration characteristics, and a representing of the signal values in the  
table view. The Signal manager provides the options of copying, renaming, 
cataloging, reading and writing of the signals. This window is opened by the  
button or View→Signal manager.  

See also Part 7. Signal editing.  

The Signal manager window (Fig. 3.6) comprises two data panels and the toolbar. 
Each data panel can be represented as "tree" or "list". The right panel can contain the 
information on the selected object as “property page”.  

 

 If user has selected the signal from the Graph tree on the Graphs tab then the signal 
range displayed in X textboxes automatically set equal to the range of selected signal.   
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The panel view mode is changed by pressing the  buttons on 
the toolbar. Pressing the button causes cyclic changing of the panel view 
modes. The desired view mode can be selected by clicking the arrow on 
the right of the button and selecting the mode from the list.The purpose of buttons of 
the signal manager toolbar is described below.  

 F4 Create graph of the selected signal. 

 F3 Open file. Duplicates the command File→Open. 

 F2 Save as…. Duplicates the command File→Save as… 

 F5 
Copy. A new layout of signals and a range of values for copying is set in 
the opening dialog window. The option of originals removal allows  to 
substitute a copying of signals by operation of a moving. 

 F6 Rename signal. 

 F7 Create new folder in the signal tree. 

  Create new signal.  

 F8 Delete selected signal. 

 Alt+F1 Switch (set) left panel view.  

 Alt+F2 Switch (set) right panel view.  

  Show all WinPOS resources: the catalogs of signals, graphs and installed 
algorithms with the option to view the properties of all elements.  

 

Script editor  

 
Fig. 3.7. Script editor 
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WinPOS (Professional and Expert) allows creation of user’s signal processing 
algorithms, automation of the signal processing from the source file selection to the 
processing result documenting. WinPOS includes a convenient environment for 
editing, execution and debugging of scripts by VBScript (Fig. 3.7).  

More details are provided in the Part 11. WinPOS scripts and Programmer's Guide.  

Log  

The Log (Fig. 3.8) automatically registers all actions of the user (open and save files, 
execute algorithms, load configuration, etc.). 

 
Fig. 3.8. Log window 

The log can also be used as a notebook to include the remarks and comments of the 
user. This makes the log convenient tool for systematization of the data processing 
procedure. The log is opened by View→Log.  
Each log line contains the time, description of the event and the additional parameter 
line, e.g., the executed algorithm parameters.  
The log window shows the history of the current work session. The complete history 
is stored in the file winpos.log of the WinPOS folder.  
 

Vibro-calculator  

 
Fig. 3.9. Vibro-calculator 
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 This is WinPOS vibration parameter calculation window (Fig. 3.9). Other two 
vibration parameters are calculated using the fixed frequency of vibration and sole 
parameter (acceleration, speed or displacement). This window is opened by 
View→Vibro-calculator.  

Graph customization windows 

The arrangement of graphs on a page, 
view of graph, legend, representation 
format and color of signal lines can be 
selected in the graph customization 
windows. The Default graph 
customization window (see Fig. 3.10) 
changes the properties of new graphs. The 
view of existing graphs can be modified 
by the Graph customization window (Fig. 
5.9-5.19).  

More details are provided in the Part 5. 
Graph creation, section Graph 
customization. 

 
Fig. 3.10. Default graph set 

Help window  

 
Fig. 3.11. Help system window 
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The WinPOS help system contains the description of user interface, algorithms, 
vibration analysis, script writing guidelines, contact information, and URLs of 
updated versions of the User's Guide and Programmer's Guide. 

The help system is accessed by the key <F1>, via the menu Help→Content… or by 
the button Help in the algorithm settings. The WinPOS help is organized as a 
standard Windows help file (CHM), containing the index and the key word search 
system in addition to the list of help topics (Fig. 3.11). 
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Part 4. Signal loading and saving  

File formats  
WinPOS allows loading and saving of the 
data in the MERA and USML formats, as 
well as the operation with binary and text 
(ASCII) files, MS Excel tables (See Fig. 
4.1).  

The MERA and USML formats are 
intended for structured signal storage. The 
binary data of each parameter are 
completed by the signal description with 
calibration characteristics, and signal 
source description. 

MERA is a united storage format of the measurement information developed for 
application in the recording programs (MR-300 and Recorder) and WinPOS. The 
vibration analysis operates with the MERA files only.  

The main features of the MERA format are:  

• Practically unlimited number of signals,  
• Signal length - up to 2 · 109 measurements (up to 16 Gbytes),  
• The format is open, 
• Simple operations and easy extendibility,  
• Separated storage of binary data of each signal and description provides the 

following features:  
 Improved reliability,  
 Fast access to the parameters, including the options of editing, addition and 

deletion of signals.  

The USML format, elaborated in the reel tape recorder age, does not meet modern 
requirements because of some constraints. This format is implemented in WinPOS 
for the sake of compatibility (including the POS package).  

 
The USML files can be easily converted to MERA by Save as… menu. Note, at the 
reverse conversion (from MERA to USML) some additional data are lost (comments, 
marks, modes, etc.).  

The formats MERA and USML are described in the Appendix C. File formats.  

Fig.4.1 List of file formats 
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Signal loading  

 
Fig. 4.2 File open dialog 

Select File→Open…, or  button of 
the main toolbar, or press the key 
<F3>.  

The Open file dialog (Fig. 4.2) is a 
standard Windows dialog box, with the 
file preview window in the lower part.  

Select the data format from the File 
type drop-down list (Fig. 4.1).  

Choose the file and press Open button. 
A new signal or signal folder appears 
in the tree.  

The files MERA and USML are also 
opened from the Windows Explorer by 
double clicking at the file name.   

The signal name is derived from the MERA or USML format file, from the text file 
header, or from the binary file name. The name, measurement units and other signal 
properties can be modified in the Signal manager (See Part 7 Signal editing).  

The files of MERA and USML format contain full 
description of the signals. At least the sampling rate has to 
be set for correct creation of signals from binary or text files. 
The operation with the text files is assisted by the opening 
and saving wizards (See below).  

At opening of the binary file the Parameters dialog (Fig. 
4.3) is shown. The signal sampling rate (frequency or step by X axis), and the record 
start time are set.  

Signal saving  
In order to save the signals using the context menu of the page, graph, line, signal or 
folder, select the Save as… menu item. The data from the Signal tree can also be 
saved by selecting Save as… item of the File menu or by clicking the  button. 

The Save file dialog (Fig. 4.4) is a standard Windows dialog box, with the file 
preview window in the lower part.  

Select the data format from the File type drop-down list (Fig. 4.1).  

Fig. 4.3 Parameters 
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In case of the data saving from the 
signal tree, full signal ranges are saved. 
If the dialog opened from the context 
menu of the page, graph or line, the 
visible signal range will be saved.  

In order to modify the saved range and 
list of signals press the button Select… 
to open the signal selection window 
(Fig. 3.5).  

The File saving dialog (Fig. 4.4) is a 
standard Windows dialog box with the 
file preview window in the lower part.  

Text (ASCII) files  
At opening of a text file the Text file 
opening wizard runs (Fig. 4.5). The 
Text file saving wizard (Fig. 4.6) helps 
to create text files with the signal value columns.  

To switch between the wizard pages use the buttons <Back and Next>. When the 
customization is finished, press Done on the last page.  

Opening wizard  

The text file general format is set on the first page.  

The text is divided by columns on the second page.  

On the third page the columns are associated with the signals. If the file contains the 
time columns, the order of columns has to be specified; otherwise the sampling has 
to be set (the fields x0 contain the initial time values, dx – time step, f – frequency). 
The default signal names can also be modified in this list.  

Fig. 4.4. File saving  
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Step 1. 

 
Step 2. 
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Fig. 4.5. Step 3.  ASCII file opening wizard 

 

Saving wizard  

The first page contains the list of selected signals, and the order of columns of 
values and time is set. The column delimiter symbols can be set, the automated 
format of the table heading can be enabled: enable signal names (the time column 
name is set separately) and measurement units in the first two lines of the table. If 
you choose the Separate signal files option, the folder will be created with the name 
which is displayed in the File name field in the Save as… window. (Fig. 4.5). The 
separate files which contain calculations of only one signal will be put into this 
folder, and the file name will match the signal name. The text included into the field 
Title is placed over the table in the first lines of the file.  

On the second page the column width can be changed and the number of significant 
digits after the decimal point can be set separately for the signal values and the time 
columns, in accordance with the table preview.  
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Step 1 

 
Fig. 4.6.  Step 2. ASCII file saving wizard 
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 An opening of a big text file and a saving of big signals as text files can take much time. 

Use the <Esc> key for the breaking and the abolition of the operation 

Work sessions 
The results, received in the course of work, and graphs can be saved on a disk as a 
session. Having loaded a session, it is possible to return to the incomplete work..  

Automatic saving and restoring of the session  

The session can be automatically saved on an exit or periodically with the given 
interval. A periodical saving of a session will help to restore the work after a 
program or a machine failure.  

To automatically save of a session, choose this option on a bookmark the Common 
(Fig. 4.7) on the Default setting window (the menu Tools, the Default setting item 
…). For periodical saving it you have to set a time interval in seconds on the same 
page. 

 
Fig. 4.7. Default graphs settings 

When WinPos starts, the last automatically saved session can be loaded if the 
Automatic restoring of the session option was selected on the same page.  
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 Besides, you can load the last automatically saved session using the menu File -
>Restore last session ( Fig. 3.3). 

Working WinPOS directory 

The signals which were created during the program working are temporarily saved 
on a hard disk in the working WinПОС directory. The automatically saved session is 
located there. To change this directory you have to open the Common page on the 
Default setting window (Fig. 4.7), press the Browse … button   and select the 
necessary directory. When you select some directory, pay attention to the size of free 
space on the chosen disk (You can see it on a window of a directory choice). 

A manual saving and restoring of sessions  

If you want to interrupt working or choose another WinPos operation, but then to 
return to the interrupted process, you can save and load the session manually.   

Select Save a session as … in the File menu (Fig. 3.3) and choose a directory to save 
the session data. You can clear the session, having chosen File -> New session 
menu. To return to the some saved session choose File-> Restore a session… and 
then point the way to the saved session data. 

You can transfer the session to other computer, place into the archive and then to 
restore it, using the same menu points. But you have to remember that the session 
data don’t contain the files with basic data. (Instead of them the links to files are 
saved).  

Therefore you have to transfer the files with basic data when you want to carry a 
session.  

The list of such "external" files is put to the magazine during the saving (Fig. 3.8), 
and the proposal to open the magazine is displayed. And so if you want to transfer 
the session you have to copy the files from this list.  Put these "external" files to the 
directories with the same name before the session restoring on other computer. If 
you don’t do it, then at the time of a loading of the session the program will propose 
to find the missing files independently, using the dialogue of a choice of files. 
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Part 5. Graph creation 
At the WinPOS start a page with empty graph is created. New graph pages are also 
created automatically for the signal processing results (refer to Part 9) and at the 
dragging-and-dropping the signal or folder to the Graph tree.  

The most convenient and simple way of plotting the signal graph in WinPOS is to 
drag the signal from the Signal tree to the graph field or to the Graph tree by the 
mouse (Press the left mouse button at the signal name, move the cursor to the graph 
page, release the button).  

The graphs are controlled by the toolbars, menu Tools (Fig. 3.2), and the context 
menus.  

Graph types  
WinPOS creates 2D graphs (Fig. 5.1) and 3D graphs (Fig. 5.2).  

Several signals can be placed into one graph (Fig. 5.3), or several graphs can be 
plotted on the one page (Fig. 5.4).  

 

  Fig. 5.3 Fig. 5.4

Fig. 5.1 Fig. 5.2
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A separate axis of ordinates can be created for each signal. The axis can be 
represented separately (Fig. 5.5) or by several scales along one axis (Fig. 5.6). 

 

New page creation  

Press the  button on the main toolbar or select the Window→New page menu 
item, and a new page with an empty 2D graph is created.  

The 3D graph page is created by pressing the  button of the 3D graph toolbar.  

The page can be created using a template by clicking the Window→New page by 
template menu item, see Page templates below.  

The Window→Instant spectrum page menu item creates a page with two graphs: 
the source signal and the spectrum calculated at the cursor position or by the visible 
signal range, - see Part 9 Signal processing. Instant spectrum. 
 

Creating pages by template  
The page templates allow avoiding the repeated customization of the graphs, storing 
the signal view ranges, placement and format of the legend and comments. The 
templates are very useful tool for preparation of the reports with series of the graphs 
of pre-set format, for viewing the characteristic signal intervals.  

The item Save as template… of the context menu of page or graph saves the active 
page view as a template file (.tpl) and sets it as a current template.  

Window→New page by template creates a new page by the current template. If the 
template is not selected (see below), the same actions as at New window of the same 
menu are made.  

Fig. 5.5 Fig. 5.6
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Window→Select template… sets the current template by the template file selection 
window (.tpl).  
 

Adding the Graph 
Select the Add graph item of the context menu of the page or graph.  
 

Adding the Grid 
Press Add at the Y axis tab (Fig. 5.14) in the Graph setting dialog. Set the axis 
parameters and press Apply.  
 

Adding the Signal (Line) 
… with a new graph or page creation 

 
Fig. 5.7 Line addition 

 

Variant 1. Drag the signal from the signal tree and drop it to the page (marked by 
 glyph) in the graph tree, or into the empty field of the graph tree. In the last case 

a new page is created.  
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Variant 2. Double click the selected signal and open the Add lines dialog, select the 
desired page (Fig. 5.7) or select the New page option. Press the Ok button. 

… to the selected graph 

 
Fig. 5.8 Lines additions 

Variant 1. Drag the signal from the signal tree to the graph tree, drop it at the graph 
name (marked by  glyph). 

Variant 2. Double click the required graph in the graph tree and make it active. 
Copy the signal with the mouse to the selected graph. 

Variant 3. Double click the required signal to open the Add line dialog, select the 
desired graph (Fig. 5.8) or select New graph. Press Ok button. 

… to the selected coordinate axis 

Variant 1. Click the graph axis name and make it active (marked by bold). Copy the 
signal with the mouse from the signal tree to the graph.  

Variant 2. Double click the required signal to open the Add line dialog, select the 
desired graph. In the field Y axis select the desired axis or create a new one (New 
axis checkbox). Press Ok button.  

 The color of coordinate axis is selected by the color of the first line associated with this 
axis. 
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Adding the several signals, folder  
… to the one page (Fig. 5.4) 

Drag and drop the folder from the signal tree to the graph tree, or choose the graph 
from the folder’s contextual menu. 

… to the one graph (Fig. 5.3) 

Drag and drop the folder from the signal tree to the graph tree keeping the <Ctrl> 
key.  
 

Deleting page, graph, line, axis  
You can delete any page or a graph by the Delete graph and Delete page commands 
of the context menu of the page or the graph. The axis can be deleted from the 
Graph settings window (Y axis tab). To delete the line use  the context menu of the 
graph tree or the legend window.  
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Graph settings  
The graph view can be changed by the Graph settings window (Fig. 5.9). This 
window is opened by clicking the  toolbar button, or by pressing <Ctrl+O>, or by 
selecting the Settings… item from the menu of page, graph, line, as well as by 
selecting item of the Tools menu.  

User can set the parameters of all new graphs by selecting the Default settings… 
item of the Tools menu. The settings of already created graphs remain the same.  

The left part of the setting window contains the graph tree, the right part - the 
parameter tabs.  

 

 
Fig. 5.9 Graph settings. Page 

Fig. 5.9: The axis synchronization is set on the Page tab: Single X axis, Single Y 
axis. The scaling of all graphs on the page is simultaneous.  

The mutual placement of graphs is shown in Fig. 5.10.  

If table layout selected the table size can be set (the Graphs number fields). If one 
page contains more graphs than set, the hidden graphs are marked by dark glyph in 

 The settings are applied to any selected object and its daughter objects. 
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the tree. Such graph can be accessed by double click at the name in the tree or by 
right scroll bar.  
 

 

Fig. 5.11, Graph tab: change 
position and fields of the graph, 
alignment of the legend, and 
additional settings:  

Graph name - graph name is 
visible; 
Indent 10% (Y) - Y axis range 
is 10% greater than the signal 
peak-to-peak range; 
Grid values - signal values at 
the crossing points of the grid 
with the graph line is visible;  
Line numbers - graph line 
numbers is visible; 

 
 

Fig. 5.11 Graph settings. Graph  
 

Auto normalize - scale of Y axis is selected automatically by the maximum signal 
peak-to-peak range; Polar axes - plot/convert the graph in polar coordinates; 
Separate Y axes - each graph line has its own vertical axis. 
The axis position on the graph is set in the Separate Y-axes control group: 
Left from graph field – a vertical axis is plotted individually for each graph line, 
One above the other – an option of vertical division of the graph field according to 
the number of axes. 

Fig. 5.10. Graph placement on a page

Vertical Horizontal Table 
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Fig. 5.12 Graph settings. Line 
 

Fig. 5.12: Line tab:  
Name – the name of the line. 
Usually, it is a name file or a 
parameter name in the file 
MERA or USML. 
Y axis – Y axis, to which the line 
is attached. You can choose it 
from the list, in which all existing 
axes are displayed.  
Connect points – The points on 
the graph are connected by lines. 
Line type – a type of line, which 
connect points on the graph. A 
line can be solid, broken, dotted 
and stroke-dotted.  
 

 
Line color can be selected from the list or from the standard Color dialog which is 
appeared after using the >> button. 
Width – a line width is measured in points and can change from 1 to 5. 
Show points – each value on the graph is displayed by the symbol, which you can 
choose from the drop down list, using Type option. 
Point color – this option determines a point color. If you choose Auto option, the 
points will be painted the same color as the line. 
Point size - determines a point size.  
As histogram – a graph is presented as a histogram (For example, it is used for the 
displaying of octave spectrums). 
Transparent histogram - a histogram is displayed by a contour. It is convenient 
when you wish to draw a few histogram on same graph concurrently. 
Zeroth order interpolation - point values between dimensions aren’t interpolated. 
Vertical grid - on the graph vertical lines are drawn from signal points, 
corresponding measured values, to abscissa axis. 
Parametric signal - The signal is viewed as a dependence Y from an index. Values 
on X are used for a numbering of X axis. 
 

 

  



Part 5. Graph creation  

 47

Fig. 5.13: X axis tab: rename the 
X axis, set margins, and select 
the following: 
Logarithm - set logarithm scale; 
Format - definition of the scale 
type. Select the suitable format 
from the drop-down list (auto – 
automated format selection) or 
set the customized format. The 
sign # - one digit, 0 – zeroes have 
to be added to the formatted 
value, e – engineering format 
enabled, Т=%H:%M:%S – enables 
the display of astronomical time. 
Date - adds date to the graph, it is 
displayed under astronomical time.  

Fig. 5.13. Graph settings. X axis 
 

Fig. 5.14, Y axis tab. Select one 
axis from the drop-down list or 
Add new one. The button Delete 
deletes all axes except the last 
one. Range and color can be set 
for the selected axis. Logarithm 
– enables logarithmic scaling, if 
the axis values are greater than 0. 
Format - definition of the 
custom scale format (see Х axis 
above). 

 
Fig. 5.14. Graph settings. Y axis 
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Fig. 5.15. Graph settings. Legend 

User sets the format and font of 
the legend on the Legend tab 
(Fig. 5.15). User selects the list 
of legend columns and sets the 
number of digits after the 
decimal point (by double 
clicking the field) for each 
column. On the same page sizes 
of the simple form of the legend 
are set.  

The names of columns 
(characteristics) are explained in 
the paragraph Legend of the 
section Graph plotting (Part 8).  

 
Fig. 5.16. Graph settings. Color 

Color tab (Fig. 5.16) sets the 
colors of the selected page or 
graph. The color selection dialog 
is called by clicking the rectangle 
with current color of the element. 
The left rectangle represents the 
color of the element on the 
screen, and the right one is for 
print 
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3D graph  

At selection of 3D graph in the graph tree the set of tabs is changed in the right part 
of the settings window. 

By the Graph tab (Fig. 5.17) the 
graph margins can be set 
(Margins), the Fill mode can be 
selected (lines of X; Y; X and Y 
or plane (surface)), and the 
invisible lines can be hidden 
(Hide invisible lines). 

The user can make the graph 
name visible, place the scale on 
the right (Labels on right) and 
invert the Z axis direction (Invert 
Z axis), change the data 
interpretation along Y axis (Auto 
normalize and Color by max Y).   

Fig. 5.17 3D graph settings. Graph 

The context menu of the Color scale list allows changing, adding and removing 
colors and filling borders, and saving these settings. 

Fig. 5.18: by the Line tab the line 
can be renamed, the line width 
and color can be changed (like for 
2D graph), the brightness of 
foreground and background colors 
of the gradient fill can be set. In 
order to accelerate the 
representation the user can enable 
preview mode by setting the detail 
level. The number of grid lines at 
each axis is then reduced (or 
increased). 

 
Fig. 5.18 3D graph settings. Line 
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Fig. 5.19. 3D graph settings. Axis 

The Axis tab (Fig. 5.19) allows 
editing of the name and 
changing the range of each of 
three axes. The >> button near 
the axis name field allows 
addressing the editing history 
and selection of previously 
entered name. 

 

 

Default settings  

Default graphic settings are stored in the configuration file and are used for new 
page creation. The Page, Graph, Legend and Color tabs are the same as the graph 
customization tabs (see Fig. 5.9-12, 17-18).  

 
Fig. 5.20. Default settings. Lines 

Line tab (Fig. 5.20): 
Color list - when added to the graph the color of 
new line is selected from the list. To make the 
change, select the color pressing the >> button 
under the list and select a new color from the 
standard dialog box;  
Only points – Represent the signal values by 
separate points without connecting them;  
Spectrum as histogram - spectrum graphs are 
represented as histograms; 

Preview (3D) - used for 3D graph. Auto - 3D 
graph is created in the preview mode, if the 
number of points by one axis is less than the 
value specified in the Level textbox.  
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Axes Tab (Fig. 5.21): 
Name - axis names by default. Select 
the one  of the previously entered 
names by pressing >> button.  
Format - axis scale format.  
Font - fonts of scale labels and axis 
names. Additional font is used for 
selection of the active axis. The font 
is selected from the dialog by 
pressing the >> button on the right of 
the respective field. The font change 
imparts all graphs (already opened 
and new).  

  
Fig. 5.21. Default settings. Axes 

3D Graph Tab (Fig. 5.22): 
View mode – view of the main graph. 
Filling - the graph drawing technique 
as the lines by X axis, lines by Y axis, 
lines by both axes or like a surface. 
Hide invisible lines – invisible line 
deletion mode.  
Digits on right side – scale labels by 
axis Y and Z are in the right graph 
part. 
Invert Z axis - inversion of the axis 
Z to put the minimum value at the far 
end of the axis, and the maximum 
value - at the near end of the axis. 

Auto normalize – Y-axis auto 
scaling.  

 

 
Fig. 5.22. Default settings. 3D 

Color by max Y – color scale: 100% correspond to the maximum signal value,  0% – 
corresponds to the minimum signal value. 

Views - selection of the views to be represented on the page. 
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Part 6. Viewing the Signals 
At the signal viewing many actions are applied to the selected (current, active) 
graph, line, axis, rather than to the whole page. The current page is the page visible 
at the present moment or the top page if the pages are arrange by cascade. The active 
graph is marked by the symbol a in the top left corner of the graph. The current line 
is marked by bold in the legend and is displayed above all other lines. The name of 
the current axis is also shown by bold. See Fig. 6.1.  
 

 
The graph can be made current by clicking the mouse button in the graph filed, the 
line - by clicking at the signal name in the legend, the axis - by clicking at the axis 
name.  

Double click at the object in the Graph tree makes this object current. If the selected 
object was hidden, the activation of the necessary page is made; the graph is marked 
as active.  

Double click in the graph field allows the graph scaling up to the whole page. Such 
graph is marked by the symbol a m (active maximized). See the right graph of the 
Fig. 6.1. The previous graph sizes can be restored by another double click.  
 

Features of 3D graph viewing  
3D graphs are used for 3D signals viewing opened from the MERA format file or 
obtained by the spectrum calculation with the 3D option enabled. To represent a 
signal in 3D graph it must be dragged from the signal tree to the graph tree window 
or to the already existing 3D graph. The empty graph can be created by pressing the 

 button on the toolbar. The page may contain only one 3D graph of one signal.  

Fig. 6.1 Active graph and maximized active graph

Active axis of 
non-active graph 

Current line 

Active graph Active graph maximized
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The figure on the left shows the axes directions. As applied to 
3D spectrum, the frequency is put along the X axis, the portion 
start time along the Z axis, and spectrum amplitude values along 
the Y axis.   

3D graph page is usually divided into four parts: 3D graph area and three projections 
of the graph into coordinate planes - see Fig. 6.2.  

 
Fig. 6.2 3D graph page 

The views can be disabled by the Projections 
submenu of the page context menu. The main view 
and the top view cannot be disabled together, and 
the cross-sections of Z and X are disabled 
simultaneously. The views to be represented for a 
new page can be set in the default settings.  

The main view and the top view can be filled by 
three ways using the Line coloring context menu. 
With two-color or multi-color filling the graph 
contains a color scale bar displaying the 
correspondence of colors and values by Y (Fig. 
6.3).  
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Fig. 6.3 Versions of filling: one-color two-color, multi-color 

The color scale bar can be disabled and its orientation (vertical or horizontal) can be 
changed by the same menu or in the settings dialog which is open by the double 
mouse click. The position and size of the color scale bar can be changed by the 
mouse.  

Multi-color filling is enabled only for the line graph plotting by X or Y. For the top 
view, by pressing the  button on the toolbar the size and position are changed 
automatically in order not to enclose the graph by the scale. The scale must be 
placed quite near to the graph edge.  

 
Fig. 6.4 Graph with regular and inverted scale 

If necessary, the axis Z can be inverted (Invert Z axis of the graph context menu). If 
this option is applied graph is visible from the opposite side, without turning the 
graph and without changing directions of other axis (see Fig. 6.4).  

The graph may be represented in one of two viewing modes - "fixed view" and "free 
view" (Fig. 6.5). In the first mode the Х and Y axes of the graph are not changed, in 
the second mode the graph can be rotated arbitrary. The toolbar  button restores 
the graph to the initial view. At pressing the arrow on the right to the button, the 
menu which switches the graph viewing mode (fixed to free) appears. 
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Fig. 6.5 Fixed and free view of 3D graph  

The  button (Graph view customization) allows rotating the graph, change the 
axis length and origin position. To move the graph press and hold the <Shift> key 
and drag the graph by the mouse left button; the graph size is changed by the mouse 
scrolling wheel (do not press the left mouse button for that).  

To change the length of axes press and hold the <Alt> key, movement of the mouse 
cursor horizontally (with the left button pressed) changes the length of X, vertically - 
the length of Y; and the length of Z is changed by the mouse scrolling wheel.  

To rotate the graph press and hold the button <Ctrl>, movement of the mouse cursor 
horizontally (with the left button pressed) turns the graph around the imaginary 
vertical axis, vertically - around the imaginary axis perpendicular to the screen 
plane. The fixed view graph allows control of the Z axis direction only.  

The  button changes the graph filling mode. The "invisible" lines became visible 
or hidden by pressing the button. At pressing the arrow on the right of the button the 
menu allowing selection of the line plotting by X, Y, X and Y or by filled surface 
place appears. 

Cursor. Viewing the current values 
In the cursor mode the signal values can be viewed at the selected time point or, on 
the contrary, the time instance when the signal amplitude was, for example, 
maximal, can be identified.  

The cursor mode is enabled by the  button of toolbars of 2D and 3D graphs, as 
well as by Tools→Cursor menu item.  

 
The signal representation with a lot of values (300000 and more) may take tens of 
seconds. Such signal should be viewed in the decimated form which is enabled by the line 
context menu (Preview). 
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2D graph 

In the 2D graph the 
cursor is represented 
by black vertical line 
(see Fig. 6.6).  

The crossing point of 
the cursor with the 
signal line is marked 
by the horizontal line 
of the same color as 
the signal line. By 
pressing  arrow on 
the right of the  
button, the horizontal 
line mode is set: By 
all lines, or By one 
line (the crossing with 
the active line only is 
marked). 

The signal current values are represented in the legend: Xcur, Ycur., IndCur (current 
index).  

The cursor is moved by the mouse (hold the vertical line by pressing and holding the 
left mouse button and set the cursor to a new position). Press <←>, <→> keys or 
hold the <Ctrl> key while moving the cursor by mouse to move the cursor exactly 
by the signal discrete values (without interpolation). Press <Tab> key to set the 
cursor position by entering the number from the keyboard.  

Cursor synchronization  

If one page contains several graphs the cursors in each graph are moved 
independently. The Cursor synchronization ( ) button combines the cursors of all 
page graphs and allows movement of all cursors as one.  

3D graph 

In 3D graph the cursor is represented by two signal projections to the XY and YZ 
planes (see Fig. 6.7). In the projection windows the cursors of current values are also 
displayed: in the window Top view – as crossing, in the cross-section windows the 
cursors are shown as in 2D graphs, with the horizontal representation of the signal 
current level. 

Fig. 6.6 Cursor mode for 2D graph 
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Fig. 6.7 Cursor mode for 3D graph 

The current values are represented in the legend by the axes: X, Y, and Z.  

The cursor is moved by the mouse (the mouse cursor has  or  shape; press the 
left mouse button and move the cursor) or by the keys (press <←> and <→> to 
move the cursor along X axis, press <↓> and <↑> to move the cursor along Z axis) 
in any window. The cursor movements are synchronized in 3D graph window and in 
the projection windows. 

 

Graph zooming and scrolling 
Usually the whole signal value range is shown at creation of the graph. (This is set 
by marking Auto-normalizing checkbox of the Graph tab of the graph setting 
dialog. See Fig. 5.11). To study the details of the signal behavior within a short time 
interval the tools of zooming and scrolling are used.  

You can switch on a zooming and a shifting by the  and   toolbar buttons or  
using context menu (Mode) and the Tools menu or by mouse in combination with 
control keys. 
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2D graph  

• Zooming 

Select zooming mode:  

Graph zooming Tools→Zooming by X and Y, <Ctrl>+ mouse 
 Graph zooming by X Tools→Zooming by X, <Ctrl>+ mouse at X 
 Graph zooming by Y Tools→Zooming by Y, <Ctrl>+mouse at Y 

The zooming buttons of the toolbar are switched by <Ctrl+2>.  

 

Move the mouse cursor in the graph to begin of signal segment to be zoomed. Press 
and hold the left mouse button and mark the area to be zoomed on the graph 
(rectangle), release the button. The selected area takes the whole graph box. 

• Scrolling  

The viewing area can be scrolled in respect to the initial graph. Select scrolling 
mode:  

 Scroll graph Tools→Scrolling by X and Y, <Shift>+ mouse 
 Scroll graph by X Tools→Scrolling by X, <Shift>+ mouse at X 
 Scroll graph by Y Tools→Scrolling by Y, <Shift>+ mouse at Y 

The scrolling buttons of the toolbar are switched by <Ctrl+1>.  

Press and hold the left mouse button in the graph area and move the graph by the 
mouse cursor, release the button.  

• Restore the initial zooming  

The  button restores previous zooming or viewing area. Each click of the button 
undoes the last zooming operation.  

• Scroll bars 

 
The graph zooming mode is enabled automatically by pressing and holding <Ctrl> when 
selecting the area of the graph (zooming by both axis), and the area of one axis (zooming 
by one axis). 

 
The graph scrolling mode is enabled automatically by pressing and holding <Ctrl> when 
selecting the area of the graph (scrolling by both axis), and the area of one axis (zooming 
by one axis). 
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 The scroll bars located on the right and 
bottom borders of the graph change scale of the signal graph and shift it. The 
relative size and position of a scroll box indicates size and an arrangement of a 
displayed fragment. 

The  button increases scale,  - reduces. The , , , and  buttons are 
responsible for shift of the viewing area. Also it is possible to scroll the graph, 
having dragged a scroll box by the mouse. 

Automated scrolling  

 The control buttons of the graph automated scrolling by Х axis are 
grouped with the signal playback buttons (See Signal playback below):  - to the 
left,  - to the right,  – decrease scrolling rate,  - increase scrolling rate,  
- stop scrolling.  
 

3D graph 

• Zooming 

You can switch on a zooming by  toolbar button only. In the 3D graph mode 
zooming the axes X and Z only is possible. The frame by which the zoomed area is 
selected is shown by red on the graph. The frame margins are moved by the mouse 
(over the frame lines the mouse cursor takes the shape of ,  or , press the left 
mouse button and change the frame size, then press <Enter>). Figure 6.8 shows the 
graph view before and after pressing <Enter>.  

  
Fig. 6.8 Zooming of 3D graph (before and after pressing <Enter>) 

The frame can be also moved by the <←>/<→> and <↑>/<↓> keys. To move the 
right or top margin press and hold the <Shift> key. The zoom is changed at pressing 
the <Enter> button. The zoom of the Y axis is changed automatically. In the 
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zooming mode the current margins are represented in the Xmin, Xmax, Zmin, and 
Zmax fields of the legend. 

• Scrolling  

The scrolling is made in the cursor mode by moving the cursor by keys out of the 
displayed area of the graph. 

• Restoring of the initial zoom 

The graph is normalized by pressing the  button. The normalization sets the 
maximum ranges for the axis to make the whole graph visible. 

Signal playback 
The MR-300 recording program allows to attach a soundtrack (microphone is 
connected to MIC-300) to the measurement data (.MERA file). When viewing such 
file in the graph press the  button («Soundtrack playback»), and the soundtrack is 
played (“audio” parameter of the .MERA file). Simultaneously with playback the 
current cursor is moved in all graphs on the display (from left to right from the 
current position or from the start of the signal fragment).  

The  button (“Current signal playback”) allows playback of the 
current (not necessary sound) signal, and the signal frequency in this case 
is set to 22050 Hz, and the amplitude is normalized.  

The  button allows changing or muting (the lowest position) the 
playback volume. Press this button again to close the Volume window.  

Auxiliary signal information and parameter status 
WinPOS allows viewing 
the information on the 
signal recording session. 
The signal modes 
(“Start”, “Idling”, etc) of 
the test are displayed by 
named highlighted areas, 
the value markers – by 
green triangles (see Fig. 
6.9). 

 

Signal  Marker

Pause (Skip)

Fig. 6.9 The signal modes, marks, pauses 
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The user enables and disables the display of markers, modes, 
pauses, set values and statuses by the button on the auxiliary 
toolbar. By pressing the button the user toggles the display of 
all elements. By clicking the arrow at right side of the button 
the user shows the menu for displaying the elements 
individually. If the Save as default menu item is selected, 
then the settings will be saved as default. 

The information on markers and signal recording modes can 
be modified in the cursor mode.  

The marker is set by the button on the auxiliary toolbar or by 
selecting the Add marker menu item in the pop-up menu 
(appearing when user clicks the arrow on the right of this 
button). The mode is set by selecting the Add mode menu 
item. If you selected the For all lines option then the 
marker/mode would be set in all active graph lines. Otherwise 
it would be set only in the active line. 

 

The user selects a marker/mode to remove or rename 
it by moving the cursor to the marker or the mode 
start (in this case the marker color becomes red, 
while the mode is highlighted by a horizontal line 
above the graph field) and selects an operation in this 
same menu.  You can select a desired marker or 
mode in the marker list as well(one of the legend 
view modes). 

If there appeared gaps in the course of recording (due to hardware failures or if the 
Pause button was pressed) then gap place is marked by a dashed line with the signed 
time of the real time scale.  

 

The signal with gaps can be presented in three ways: 
• Simple – The time scale is depicted as if the signal was 

recorded without gaps and it is plotted continuously (Fig.6.11). 
• Brief – The time scale is non-uniform and the signal is plotted 

continuously (Fig.6.10). 
• Wide – The time scale is uniform, the signal is plotted as 

fragments with gaps (Fig.6.10). 
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Change 
status sign

Threshold 
level 

Fig. 6.11 Markers, gaps, set values, status change notches 

  
Fig. 6.10 Brief and wide signal with gaps views 

The WinPOS program enables to show the signal set values on the graph: the 
regions above or below the set value will change to the set value color.  

The signal status changes 
(excess, uncertainty, etc) 
are marked by vertical 
hairlines on the graph 
upper boundary. When 
the cursor is moved the 
current signal status 
information is displayed 
in the status bar.  

Figure 6.11 shows the 
signal graph with plotted 
ancillary information. 
The display of markers, 
gaps, set values and 
signal status change 
marks is enabled. 

If the signals were recorded with TRS (Time Reference System) data WinPOS will 
show them in the Common Time Scale. Press the  button for signal viewing in 
the CTS, and press the button once again for returning to the recording time scale. 
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Specialized cursors 
Harmonic cursor is intended for identification of 
harmonics of the calculated spectrum of the 
signal. At pressing the  button the cursor 
setting dialog is open. 

Set the necessary number of additional cursors 
(harmonic grid lines) and press Ok. Select the 
main harmonic by moving the main cursor. Move 
the additional cursors by the mouse to match their 
lines to the respective harmonics. For better 
visibility the color of the cursor lines imposed to 
the spectrum are changed to red (by default). See 
Fig. 6.12. The frequency values - position of the 
main cursor and interval between secondary 
cursors are displayed in the right top corner of the 
graph. The cursor setting window is opened by 
double mouse click in this window (Fig. 6.16). 

Modulation cursor ( ) assists searching the 
groups of sidebands in the frequency band. 
Cursor control is similar to the harmonic cursor 
control (Fig. 6.13).  

Differential cursor ( , Fig. 6.14) calculates the 
difference between two signal values by X and Y 
axes, as well as calculates the definite integral 
(the area under the signal line).   

 
Fig. 6.15. Differential cursor 

In differential cursor mode the  button calls 
the speed calculation window (V) by the preset 
distance (S) and measured movement dX (Fig. 
6.15). 

Fig. 6.12. Harmonic cursor 

Fig. 6.13. Modulation cursor 

Fig. 6.14. Differential cursor 
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Fig. 6.16. Cursor properties 

 

Tabular representation of signals 
The table allows tolook through signals in the form of columns of the values attached to 
the common time scale.  

 
Fig. 6.17.  Tabular representation of signals 
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Press the  button on the management panel of the table. To add a signal into the 
table it is necessary to drag a signal (or a folder) by mouse to the page of the table. 
Use the contextual menu of a column to remove a signal from the table (a Fig. 6.17, 
item Delete a column). This menu is appeared by pressing by the right button of a 
mouse on a cap of the column. Also standard functions of editing (to copy, insert, 
etc.), addition of an empty line or a column are accessible, using the contextual 
menu of a column and a line.  

You can change the values of signal in the table cells. The active cell is marked by a 
frame. The changed values are displayed by red color.  

You can use  and  buttons for a cancellation of the changes or for the repeated 
input. Save the changes using   button.  

Press the  button to print a selected fragment of the table.  

The  button (Save as …) allows exporting the table data to a file of CSV format 
(Common Separated Values).  

Hot keys for viewing  
 

<F5> Switching between the windows of the graph tree /signal tree 
/workspace (page) 

<Ctrl+Tab> Switching between the pages 
<Ctrl+3> Switch on and switch off  the cursor mode for a graph  
<Ctrl+1> Switch on and switch off  the scrolling modes for a graph  
<Ctrl+2> Switch on and switch off  the zoom modes for a graph  
<Ctrl+G> Switching the graph grid mode 
<Ctrl+F> Set marker at the cursor position  
<Ctrl+O> Open the settings window 
<Ctrl+~> To return to the previous scale, position 
<Ctrl+L> To display/hide vertical lines from values of a signal 
<Ctrl+P> Print the active page 

The following keys operate only on the active page. If nothing happens after 
pressing the buttons, probably the signal tree or the graph tree is selected. Then press 
once or twice <F5> or click the mouse button over the page.  

<G> To make the next graph active 
<Y> To make the next Y axis active 
<L> To make the next line active 
<+>, <-> To zoom out/in by X axis of the active graph 
<Shift+"+","-"> To zoom out/in by Y axis of the active graph 
<←>, <→>  Graph scrolling by X axis  
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In the cursor mode - movement of the cursor by Х axis  
<Shift+←,→> In the cursor mode - graph scrolling by X axis 
<Tab> Set cursor to the preset position 
<↑>, <↓> Graph scrolling by active Y axis  

Other hot keys (work not only at viewing the graph): 

<Esc> Interruption of a current operation (calculation, drawing, etc.) 
<F1> Call of a help window 
<F3> Call of the Open window 
<Space> In the signals tree : excludes a signal from processing 
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Part 7. Editing of signals and files 
This part of the User’s Guide describes how to use WinPOS program for: 

• correcting signals and measurement files,  
• deleting signals or signal fragments containing no meaningful data,  
• creating new signals and measurement files. 

The WinPOS program creates new signals automatically by executing algorithms 
(see Part 9 “Signal Processing”). Besides that you can: 

• create a new signal by copying the source signal or its fragment, 
• combine several signals or fragments to a new signal, 
• create a signal presenting one parameter as a function of another,  
• generate an artificial signal programmatically. 

 

 
Fig. 7.1. Signal manager. Properties 

You can activate editing functions in the main window by the Edit toolbar and 
compose measurement files in the signal tree window.  
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The Signal Manager (see Fig.7.1) helps to modify signal properties and handle the 
signal tabular presentation. The Signal Manager control elements are described in 
Part 3 of the WinPOS Secondary Windows (Part 3). 

File Editing 
The measurement file information fields can be modified on the Signal Manager 
pages (see Fig.3.6). The procedure of adding signals to a file is described in the 
Signal Copying section below. To delete a signal from a file select Delete menu item 
in the signal context menu in the signal tree window, or click the  toolbar button 
in the Signal Manager.  

Actually the file will be modified on the disk only after the Save or Save as 
operation (for a new file) is executed. See Part 4 “Signal Loading and Saving” for 
details. 

Signal Copying 
Using the signal window 

To copy a signal using the signal tree is as simple as to put a signal in a graph. Press 
left mouse button on the signal name in the signal tree and holding down the button 
move the mouse cursor to the folder the signal is to be copied in. Release the mouse 
button when mouse cursor is above the folder name.  The signal is copied in the 
given folder. 
 

Using the Signal Manager window 

 
Fig. 7.2. Signal manager. Signal copying 

• Enable the signal tree view in the 
left and right panels by pressing 
the Signal Manager  
buttons.   

• Select a destination folder in one 
of these panels and select a signal 
to be copied in the other panel.  

• Press the  button.  

Check the paths in the “From” and “To” fields in the Copy dialog (Fig.7.2) and 
press ОK. The signal will be copied to the destination folder. The signal will be not 
copied, and only moved to the chosen folder, when the Remove Source checkbox is 
checked.. 
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Signal Fragment Copying 
Using the graph editing panel 
• Enable the double cursor (see Fig.7.3.1). 
• Select a signal fragment of interest and press  button on the Edit toolbar 

(Fig.7.3.2). The selected fragment information will be saved in the internal 
exchange buffer. 

• Press  button on the Edit toolbar (Fig.7.3, 3). A new signal will be created 
and shown in the graph (Fig.7.3.4). 

  

 
  

Fig. 7.3. Copy operation steps 

When copying the data they are not physically doubled. Instead the resulting signal 
is supplemented with a reference to the initial data for handling the given signal. It 
follows from the above-said that you must not remove the signals whose data were 
copied till the moment the resulting signals are removed. Besides that the source 
signal modification may bring about resulting signal changes as well. 
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Using the Signal Manager 

 
Fig. 7.4 Creation of a new signal  

Execute the operations you executed for copying an entire signal but set a new index 
range in the Copy range fields in the Copy dialog (Fig.7.2), . 

Or create a new signal having set the old one as a source. 
• Press  button on the Signal Manager toolbar.  
• Mark Y from another signal in the Y frame in the window of Fig.7.4, press 

Browse… button and select the source signal or its fragment in the signal 
selection window (Fig. 3.5).  

• Mark X from another signal in the X frame, press Browse… button and select 
the same signal as for Y axis. 

• Type the new signal name and press OK. The new signal will be placed in the 
New Signals folder of the signal tree.  
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Signal Splicing 
Using the graph editing panel 

You can add copied signal or fragment to another signal.  

• Copy a signal in the way described in the paragraph “Signal Fragment Copying 
using the graph editing panel”. See Figures 7.3. 

• Select a graph with a signal to be complemented with a fragment, then press  
toolbar button. If the current value cursor is enabled the source fragment will be 
inserted in the cursor position. Otherwise, it will be inserted in the signal end. 
The arrow on the right of   button enables to forcedly set the insertion mode: 
in the cursor position (prohibited when the cursor is disabled), in the signal start 
or end .  

If a fragment is copied in an existing signal it would be necessary to have the same 
data type and calibration curve of the two signals. 
  

Automated Signal Splicing 

The automated signal splicing function may be useful when splicing the fragments 
of a signal data distributed among different measurement files.  

• Put the signals to be spliced in a single graph. 
• Press  button on the Edit toolbar.  

The active graph signals will be combined in a single signal in the sequence of the 
graph legend. The resulting signal will possess all properties (frequency, start time, 
calibration curve, etc) of the first signal. The splice points are marked with source 
signal names.  The result signal is put in the New Signals folder of the WinPOS 
signal tree. 

Parametric and Polar Signals 
Using the Parametric Graph algorithm 

Part 9 describes the procedure of constructing the Parametric Graph algorithm for 
producing parametric or polar signals. If you need to plot parametric graphs often 
you should expedite the algorithm activation.  

• Set the “Parametric Graph” as default algorithm (in the algorithm setting 
window).  

 
When a fragment of one signal is copied in the start of another signal the latter signal start 
time (the initial value along the X-axis) is made equal to the start time of the copied 
fragment.  
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• Press Select signal in the context menu of the signal to be used as a function 
parameter.  

• Holding down <Alt> key drag and drop the signal to the graph by the mouse in 
the way you create an ordinary graph.  

The default algorithm will be executed and a parametric graph instead of an ordinary 
one will be plotted as a result.  

Using the Create New Signal dialog in the Signal Manager 

• Press  button on the Signal Manager toolbar.  
• Mark Y of the other signal in the Y frame (see Fig.7.4), press Browse… button 

and select the source signal or its fragment in the signal selection window 
(Fig.3.5).  

• Mark Y of the other signal in the X frame, press Browse… and select the signal 
with the value corresponding to the new X-axis.  

• Type the new signal name and press OK. The new signal will be put in the New 
Signals folder of the WinPOS signal tree.  

Program Signal Generator  
An artificial signal can be generated by the WinPOS Professional and Expert 
versions. You can activate supplied plug-in for signal generation by the   
toolbar, or load a sample script from the WinPOS installation, or you can write on 
your own a script, program or plug-in (an attachable module) basically in any 
programming language supporting the OLE technology. See Part 11 “WinPOS 
Automation” and “Programmer’s Guide”.  

Signal Fragment Deletion 
Deletion of signal fragments free of useful information significantly reduces the 
measurement data size and processing time. However one should remember that in 
this case the data-to-time scale timing may be distorted. 
 

Using the graph editing panel 

• Enable the double cursor and select a fragment to be removed (Fig.7.5.1).  

• Press  button on the Edit toolbar (Fig.7.5.2). Confirm the operation. The 
selected signal fragment will be removed and a break mark will be set in its place 
(Fig.7.5.4).   

When a signal fragment is removed the data are not removed physically till the time 
the signal is saved on a disk (Fig.7.5.4). 

 When a new signal is created using other two signals the new signal length will be equal to 
the length of the shortest of the source signals.  
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Fig. 7.5  Signal fragment deletion steps 

 

Using the Signal Manager 

 
Fig. 7.6  Changing the signal length 

• Select a signal in the Signal Manager.  
• Press the Change signal length… button next to the Length field on the 

Properties tab (Fig.7.1).  
• Select a signal fragment in the Change Signal Length dialog window (Fig.7.6) by 

the cursors (on window opening the cursors are set at the signal start) or type 
precise values in the corresponding fields.  
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• Select an operation in the drop-down list: 
 Crop (leave) the given interval, 
 Delete the given interval, 
 Insert the given number of values.  

• Press OK. 

The signal length will be changed right after confirmation and can’t be cancelled. 

Editing Cancellation 
Postponed editing operations (such as copying, insertion, and deletion by the editing 
panel) may be cancelled.  

Select a modified signal graph and press  panel on the Edit toolbar. Confirm the 
operation. The signal will be freed of all editing data and it will be restored in its 
initial form. If a signal completely consists of copied fragments of other signals it 
will be removed at editing cancellation. 
 

Folder (file) handling  
Editing operations (such as copying, insertion, and deletion made using Edit toolbar) 
can be executed on all folder (or file) signals simultaneously in the same way, as 
described below for a single signal. 

• Open a signal in the graph and press  toolbar toggle (Fig. 7.7, 1-2). 
• Execute all necessary operations with the selected signal. Similar operations will 

be simultaneously executed with all other signals in the folder (Fig.7.7, 3-4). 
• Press    toolbar toggle again for exit from the folder handling mode. 
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Fig. 7.7. Folder editing 
 

 

Signal Characteristics Modification 
Main Signal Properties 

Open the Signal manager (select View→Signal manager menu item or press  
toolbar button). Select the signal in the left window. The Properties tab of the signal 
(Fig. 7.1) allows changing of the signal name, measurement unit, type of 
characteristic; addition of description, changing the sampling rate; setting the start 
time.  

In order to set the start time for all signals of the folder at once, the button 
Synchronous start is provided. 

The minimum and maximum values are calculated automatically at plotting the 
graph. The sign “unknown” in the respective fields means that the values are not yet 
calculated. The calculation can be manually started by pressing the Calculate 
min/max button.  

The signal characteristics are changed after pressing the Apply button.  
 

 Selection of a specific signal makes no effect on the results. When editing a folder you can 
select a signal for the next operation differing from the initially selected signal. 
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Calibration Curve (Scale) Modification 

 
Fig. 7.8. Signal manager. Calibration 

Select a signal from the Signal manager. At the Calibration tab (Fig. 7.6) the 
calibration curve (CC) of the signal is displayed as a tree with coefficients. In the 
bottom part of tab the coefficient values can be added, deleted or edited. At addition 
of a new calibration the calibration type shall be set in the Add calibration curve 
dialog box (Fig. 7.9).  

 
Fig. 7.9. Add calibration curve 

For example, if it is necessary to recalculate the ADC codes to Volts, and the values 
in Volts to kg/cm2, select Transformation sequence option in the dialog box and 
add two CCs.  

The signal values in codes (before CC application) are placed in the Preview tab in 
the column y (codes). The fourth column contains the signal measurement units after 
the transformation. (See Fig. 7.10.)  
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Signal Value Editing   
Tabular Values Editing 

 
Fig. 7.10. Signal manager. Preview 

Select the signal from the Signal manager. The Preview tab (Fig. 7.10) contains the 
signal values in the table.  

If the required value isn’t displayed on the screen within the limits of 1000 values it 
is necessary to switch on an editing mode of a table cell by double click of a mouse 
on any cell in the index column or the x column and then enter the required value of 
a displacement or time. The jump to the required value occurs after the mouse click 
outside of a field of an edited cell  

The signal value can also be changed by double click at the cell of the y column. The 
table value is changed by the mouse click outside the edited cell, and the signal data 
is changed after pressing the Apply button only.  

Values by the axis x of the signals with non-uniform step can be changed too, by 
checking of Edit X checkbox. However, the abscissa scrolling mode in this case is 
disabled.  

The number of digits after decimal point can be changed by the right 
mouse click at the cell. The control element appears in the cell filed, 
and the accuracy of digit representation is either increased by the 

right button of this element or reduced by the left button. The accuracy change 
impacts the whole table column.  
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Graph Interval Editing 

 
Fig. 7.11. Signal editing. Draw lines 

 
Fig. 7.12. Signal editing. Erase above 

 
Fig. 7.13. Signal editing. Erase below 

In order to change the signal values at 
several points press the  button on the 
right to the Replace signal value ( ) 
button.  

Select the signal value change mode in 
the submenu. Mark the value selection 
area by the mouse (holding the left mouse 
button move the mouse cursor, release 
the button). The signal values to be 
changed will be shown by a lighter color.  

The cut line (red) means the following:  

In the Draw lines mode - replace the 
signal values with the values of this line 
(Fig. 7.11),  

In the Erase above mode - the values 
above the line are replaced with the line 
points, and the values below remain the 
same (Fig. 7.12),  

In the Erase below mode - the values 
below the cut line are erased and replaced 
with the line values (Fig. 7.13). 

 

 

Single Value Modification 

 
Fig. 7.14. Data editing 

In order to change the signal(y) value of the selected point 
switch to the cursor mode, place the cursor to the desired 
point and press the Data editing ( ) button on the editing 
toolbar.  

Enter new signal value at this point in the Data editing 
dialog box (Fig. 7.14). Press Change. 

 

 The replacement of signal values cannot be undone. When entering the 
value replacement mode a respective warning is displayed.  
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Part 8. Graph plotting and report drawing  

Graph plotting  
For better information and representation of the results, WinPOS includes such 
elements of graph plotting as the legend, line numbers, grid values, marks, notes and 
comments (See Fig. 8.1).  

        
Fig. 8.1. Improvement of the graph self-descriptiveness 

On the Graph tab (Fig. 5.11) of the graph customization dialog the representation of 
the Graph name, Line numbers, Grid values can be enabled or disabled, and the 
placement of the legend can be selected.  

Legend  

The legend is one of basic elements of the graph. The legend can be presented in one 
of three types - simple, full and as the list of labels. In the simple legend form only 
the names of lines are displayed. If the cursor mode is switched on, the current 
cursor position and values of each line in this point is displayed.  

A full form of the legend is a table in which for each signal a few parameters are 
displayed: a rate of digitization, the value of  X and Y at the point of the cursor, etc. 

Legend

Line number

Grid values
Graph 
name 
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The full list of accessible parameters is shown in the table 8.1. On the Legend tab in 
the Graph settings window (Fig. 5.15) you can choose columns which will be shown 
in the legend. There is an option to display or hide the legend on the same tab. As 
well as you can choose this option using the graph context menu. (Show legend). It 
is possible to change the size of the legend field: grasp the border of the field by the 
cursor of a mouse and move it to the required side 

Table 8.1. The list of accessible columns in the full form of a legend: 

Name Name of the line(signal), the color and number of the line is displayed near 
Fs Sampling rate of the signal 
dX Step on the X axis, dx = 1/Fs 
Cur X Current lines cursor 
Cur Y Signal value in the cursor point  
Cur idx Index of the value in the cursor point 
L ind Index of the first value on the graph 
R idx Index of the last value on the graph 
Xbeg-Xfin Current range on X 
Ymin-Ymax minimum and maximum values of the signal on a current range on X 
Y range Difference of the maximal and minimal values on a current range 
Min Y Minimum signal value on a whole range  
Max Y Maximum signal value on a whole range 
Mean Mathematical expectation of the signal on a current range on X 
RMS RMS of the signal on a current range on X 
Length Number of the signal values  

The list of all tags, markers and the modes, which are present on the graph, can be 
displayed in a legend. 

 
Line numbers  

At simultaneous representation of several signal lines at a graph the change of each 
parameter can be tracked by color highlighting of each signal. However, if the lines 
are too numerous, or the graph is printed in black-and-white copy, the color 
representation is not enough. The lines are numbered in the rectangle at the 
respective line in the graph window and in the legend near the signal name. The line 
numbering is enabled by the Graph tab of the settings window (see above).  

Hidden lines  

If a graph has too many lines, and they enclose each other, some lines can be 
temporary hidden but they will still be present in the graph. In order to hide the 
graph lines select the Hide line item of the line context menu (called from the 
legend and from the graph tree) or press the <Space> key at the selected line in the 
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graph tree. The hidden line is marked in the legend by a crossed number sign 
( ), and in the tree - by a special glyph standing before the name: .  

The active line is always plotted above other lines.  

Grid values  

The grid signal values facilitate viewing of the signal changes on the hard copy, 
replacing the cursors in some respect. The numbers in the column placed in the same 
order as the signals in the legend, and have the some color. The values of the hidden 
line (see above) are represented to preserve the order of values. This mode is 
enabled by the Graph tab in the settings (see above).  

Coordinate grid  

The coordinate grid view 
is changed by sequential 
clicks on the  button or 
by drop-down menu (click 
arrow near the button), or 
by Tools menu. The 
following settings can be 
made: Grid by X and Y, Grid by X, Grid by Y (see Fig. 8.2) and Hide grid.  
 

Line view 

The signal is usually represented on the graph by a solid line, the signal points are 
connected with segments (1st order interpolation). Such mode allows the estimation 
of the signal form and changes. However, such mode does not provide viewing o 
separate measurements (points). 

 

The vertical line plotting mode from the signal points (see the 2nd graph in the Fig. 
8.3) helps to resolve the above problem. This mode is helpful for more accurate 
association with the time axis and for comparison of the signals with different 

 Hidden lines as well as hidden signals (see Part 9 Signal processing) are elapsed from the 
processing by the algorithms. 

Fig. 8.3a. Kinds of graph line representation 

Fig. 8.2. Kinds of the coordinate grid 
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sampling rates. The mode is enabled by ticking Vertical lines on the Line tab in the 
graph settings (Fig. 5.12) or by the  button on the graph toolbar.  

In some cases, e.g., while viewing telemetric signals, the mode of signal 
representation by separate measurement points (3rd graph in the Fig. 8.3) can be 
helpful. Such mode is enabled by ticking No point connection on the Line tab in the 
graph settings (Fig. 5.12).  
 

Fig. 8.4. Line selection 

If lines of several slowly varying parameters in one graph is badly discernible by 
colors (for example, at a monochrome printing), it is possible to change the shading 
of a line or to mark values of a signal by badges as it is shown on fig. 8.4. For this 
you need to open the Line tab in the Graph settings window and then the Type of a 
point option. (Fig. 5.12). 

Spectrum representation by histograms  

 
Fig. 8.5. Different ways of line representation  

Usually spectrums are represented by curves with vertical lines (see Fig. 8.5), but in 
the  Lines tab in the Default settings … window you can set the spectrum a 
representation in the form of histograms if to select the Spectrum histogram 
checkbox.  
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Labels  

 
Fig. 8.6. Types of labels 

The labels allow addition of precise 
signal values to the graph at the 
selected points and commenting the 
signal segments (Fig. 8.6).  

Switch to the cursor mode by 
clicking the  toolbar button. Set 
the cursor at the desired value. Press 
the  button - Add label (flag) (or 
<Ctrl+F>). Point the label position 
by clicking the left mouse button. 

Click the  sign on the left of the  button to select label type: In one line, In all 
lines or Text.  

Editing or deletion is performed by double click in the label field.  

To move the label press and hold the left mouse button in the label field, then move 
the rectangle to a new position, and release the button. The labels size is selected 
automatically and cannot be changed.  

In the label customization dialogs (Fig. 8.7) Transparent background option can 
be enabled. For the label values the format precision can be set (number of digits 
after the point), and the short graph line names (Y1, Y2, Y3, and further in 
accordance with signal ordering in the legend) can be replaced with the 
corresponding signal names.  

The label text is edited in the Text field (Fig. 8.7). The >> button opens the window 
of history with the lines of previously entered text.  

   
Fig. 8.7. Customization of labels  
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Comments 

 
Fig. 8.8. Comment 

Press the  button (Add comment). 
«Draw» a rectangle for the comment 
text by the mouse (press and hold the 
mouse button in the graph plotting 
field and then move the cursor, 
drawing the future comment area with 
the rectangle). For editing (Fig. 8.9, the 
Comment textbox) or deletion double 
click the comment field.  

The >> button opens the input window 
history.  

The Info button adds comment from 
the MERA or USML format file.  

The Move comment field allows 
alignment of the comment along one of 
the graph sides.  

To move the comment press and hold 
the mouse left button in the text field, 
then move the rectangle to a new 
position, and release the button.  

 
Fig. 8.9. Commentary settings 

The comment size can be changed by moving its frame (the mouse cursor over the 
frame is replaced with arrows pointing the movement direction: press the left mouse 
button and move the frame). 

Graph printing and saving  
Page printing  

The active page is printed from the preview window (Fig. 8.10) which is opened by 
the  button of the main toolbar or by the menu Tools→print… 

The Page…button of this window allows setting the borders sizes and selecting the 
paper source and orientation by a standard Windows dialog box.  

The Save button creates a graphic file (in BMP format) with the page view. The 
Load button allows finding and printing a previously saved page. 

The Print button opens a standard dialog of selection and setting the printer and 
printing.  
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Fig. 8.10. Preview. Comment  

Comment  

Wide-graph print, emulation  

The Comment… button of the 
preview window (see Fig. 8.10) 
allows addition of a comment at the 
bottom of the page when printing.  
Printing by the roll-fed printer (see 
Fig. 8.11) produces more 
convenient for further study graphs 
with better detalization by the time 
axis. If reel feeding is not supported 
by the printer, the wide-graph print 
is emulated by separate sheet. In 
that case high resolution by the time 
axis can be obtained by gluing these 
sheets into one. 

 
Fig. 8.11. Wide graph print setup  

In the Wide graph print setting window the printer can be selected by the 
Change…button), also set Scale (resolution margins, dX…=…mm, related to the 
Paper length field) and set the Margins. The X range is set by the current graph.  
The Wide graph print window can be opened by the Tools→Reel printing… 
menu. 
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Image saving  

The current graph page can be saved in a graphic file (BMP format) by pressing the 
button of the main toolbar or by the Tools→Save image in file… menu (a 

standard file selection dialog box is opened).  

Graph copying via the clipboard  

 
Fig. 8.12. Graph in the WordPad document 

This tool allows insertion of WinPOS graphs directly into the text document to 
illustrate your reports (see Fig. 8.12).  

The  button and the menu item Tools→ Copy image to clipboard create a copy 
of the current page in the clipboard. In order to include the WinPOS graph into the 
text document, move the cursor to the desired place of the document and select the 
Insert command in the context menu of your text processor or press <Shift+Ins> on 
the keyboard. 
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Part 9. Signal processing 
WinPOS allows digital processing of the stored data by using a large number of 
embedded standard algorithms. The WinPOS scripts (see Part11) allow creation of 
customized processing programs with application of standard algorithms.  

Operations Sequence 
The sequence of signal processing can be 
divided into five steps.  

This algorithm can be applied to a signal, 
or to a folder with several signals, or to all 
signals on the page or graph, or to one 
signal line. 

At the selection of the page, graph, or 
signal line the algorithm is applied to the 
viewed range of values, by the WYSIWYG principle.  

If a folder with signals or a graph is selected for processing, then the signal can be 
elapsed from the processing by pressing the <space> key on signal name in the 
signal tree, or on the graph line name in the graph tree, or by hiding the graph line 
(see Part 8. Graph plotting). The elapsed signal is marked in the tree by a special 
glyph before the name: .  

Step 1-2. Select signals – Select algorithm 

1. Choose an object, to which the algorithm will be applied. 

2. Open the context menu of the object to be processed (see Part 3, section Context 
menu and Fig. 3.2) and select the Algorithms submenu, then select the algorithm.  

 Step 1-2. Select algorithm - Select signals  

1. Choose the algorithm from the Algorithms submenu of the main menu (see Fig. 
3.3). In the algorithm customization dialog box (Fig. 9.1) press the Select button 
near the Sources field.  

2. Press the Browse button, which is near the Source field in the Algorithm settings 
window, and choose the object and set the range of the processing by the Select 
signals dialog (Fig. 3.5). By default chosen algorithm is applied to a current line of 
the active chart. 

Step 3. Customize algorithm  

A selection of any algorithm, except Probabilistic Analysis, opens the Algorithm 
settings window (Fig. 9.1).  

Select signals Select algorithm 
 

    Select algorithm       Select signals 
 

Customize algorithm 
 

Execute algorithm 
 

Create new resulting graphs 
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Fig. 9.1. Customization of algorithms. Auto spectrum   

The right part of the customization window is similar for all algorithms, containing 
the settings of data sources, and result names. The left part is related to 
customization of the selected algorithm (operator). The algorithm customization is 
described below. 

The main part of algorithms receives one source signal only at the input, and 
produces one resulting signal. However, for example, for Cross spectrum algorithm 
two sources must be specified, and the Auto spectrum algorithm calculates the Real 
and Imag resulting signals.  

The range of the signal values and indices selected for processing is displayed under 
the Source field. In order to change the processed value range or to select signals use 
the Select key and the Signal selection dialog box (Fig. 3.5). The Apply button 
allows storing of the settings without algorithm execution. Brief information on the 
algorithm is obtained by the Help button.  

 Step 4. Execute algorithm  

The calculations are started by pressing the Execute button and can be monitored by 
the indicators placed at the bottom of the WinPOS main window. The right indicator 
shows a general status of calculations, the name of the processed signal; the 



Part 9. Signal processing 

 91

calculation progress is shown on the left. The calculations can be interrupted by the 
<Esc> key. 

The calculated signals are placed to the Results folder. The processed signal names 
are completed with shortened algorithm name as a suffix. In case of the signal folder 
processing resulting folder name is completed with such suffix but not the signal 
names inside.  

 Step 5. Plot the result graphs  

After the calculations are completed the page with calculation results is 
automatically created and made as current (see figure below).  

If only one signal is processed, a page with two graphs is created: the source signal 
(within the selected range) and the resulting one. If the algorithm includes two 
sources or two results, then one graph shall be created for each signal (up to four 
graphs).  

At the batch signal processing the result page is created and the source signals are 
not included into this page.  

   
Fig. 9.2. Results of Spectrum calculation of the single signal and of all the signals in the folder 

In order to set the preferable viewing range of 
the resulting signal, the Show interval option 
must be checked, and the value range by the 
abscissa of the resulting graph must be set in 
the dialog box.  

Proper application of processing algorithms assumes basic knowledge of higher 
mathematics, and physical processes occurring during testing, as well as 
measurement methods. Though descriptions of all algorithms can be found in the 
higher mathematics reference books, The Appendix A. Processing algorithms 
contains the main formulae and comments of the algorithm implementation in 
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WinPOS. The Appendix B. Recommendations to the Processing algorithm 
application helps to make a correct choice of algorithms in order to achieve the 
necessary results. 

The settings of the algorithms are automatically stored at the closing WinPOS, at the 
saving the séance (see p. 4). In order to save several settings, e.g., for different 
processing scenarios, use the Algorithms→Save settings and Algorithms→Load 
settings items.  

Fast Algorithm Activation 
1. If you often use some algorithm during processing you can expedite noticeably 

the process in the following way: 

• Mark the Default algorithm checkbox (see Fig.9.1); 
• Drag the signal holding down the <Alt> key from the signal tree to the 

graph as you do when creating a graph (see Part.5. Graph Creation). 

The default algorithm will be executed and you will see at once the result on the 
graph instead of the source signal graph. 

2. If you use the algorithms processing two sources then you can set in advance the 
second source. Press Select signal in the signal context menu. The signal is 
marked with the   sign in the signal tree. 

 

Press Advanced button (see Fig.9.1) for 
making the fast activation function more 
convenient for you.  

Mark the following in the Advanced settings 
dialog: 

 

Always open settings dialog – for changing settings of the default algorithm at fast 
activation (otherwise the algorithm will be activated with current settings), 

Show results in new window – for putting the results on a new page (otherwise the 
result will be where it was dragged to by the mouse), 

Show source signals – for creating pages with source signals (otherwise only 
resulting signal graphs will be plotted). 

Customization of standard WinPOS algorithms  
Auto spectrum  
Spectrum Type:  
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PSD - power spectrum density (result dimension: units2/Hz),  
PS - power spectrum (units2), 
ESD - energy spectrum density (units2·s/Hz),  
AmpSp - amplitude spectrum (units),  
Real&Imag - real and imaginary spectrum parts,  
Amp&Phase - amplitude and phase.  

Number of FFT points - 
number of points (size of 
portion) by which the 
spectrum is calculated: 32, 64, 
128, 256, 512, 1024, 2048, 4096, 
8192, 16384, 32768, 65536, 
131072,  262144. 

Number of FFT portions - 
the number of portions for 
averaging. The maximum 
possible number of portions 
is set by default, depending 
on the selected number of 
FFT points, portions shifts 
and the data file size. 

 
Fig. 9.3. Auto spectrum 

3D – the spectrums calculated by portions are not averaged but put along the Z axis. 
The number of FFT portions is the resulting ‘depth’ by Z axis. See the 3D spectrum 
section below. 

Portion shift - shift of the next portion start after calculation by the previous 
portion: 1, ¼N, ½N, ¾N, N, where N - number of FFT points.  

 Window type: rectangular, triangular, Hanning, Blackman, FLAT-TOP  

Values: effective (RMS), amplitude: Peak, Max Peak, Peak-Peak.  

Centering – removing the constant component of the signal.  

Logarithm – The “Taking the logarithm” algorithm will be applied to the result (see 
below Fig. 9.9). Press the >> button on the right of the logarithm parameter field to 
modify the factor (10 or 20) and to enter a reference value. 

Transformation – The “Spectrum Transformation” algorithm will be applied to the 
result (see below Fig. 9.10). Press the >> button on the right of the transformation 
parameter field to modify the parameters.  
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Zero padding – Allowance for calculation of the signals with the length smaller 
than the number of FFT points. It can help to eliminate the uncertainties conditioned 
by the presence of signal narrow band components. 

Time on X axis - is accessible, if a three-dimensional spectrum is calculated (the 
option 3D is chosen). If this option is switched, then time will be put along the X 
axis of the resultant three-dimensional spectrum, and on Z axis – a frequency. 

 
Octave spectrum 

 
Fig. 9.4. Octave spectrum 

Spectrum type – the 
calculated spectrum type: 
octave, third-octave, 1/12-
octave. 

FFT portions – the 
number of portions the 
spectrum will be averaged 
by. A maximum 
practicable value is set by 
default. 

Values – A result type is 
set: RMS, RMS-to-
bandwidth ratio, power-to-
bandwidth ratio. 

Spectrum Calculation Method: FFT, Band-pass filters. 

3D – the spectrums calculated by portions are not averaged but put along the Z axis. 
The number of FFT portions is the resulting ‘depth’ by Z axis. See the 3D spectrum 
section below. 

High quality – available only for calculation applying the filtration method; in this 
case the band-pass filters of a higher order are used.  

Octave ratio (G) – a coefficient used for calculating octave boundaries or an octave 
portion. 

Centering – elimination of the signal constant component. 

Logarithm – the “Taking the logarithm” algorithm will be applied to the result. The 
>> button opens the logarithm settings window. 
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Transformation – the “Spectrum Transformation” algorithm will be applied to the 
result. The >> button opens the algorithm settings window. 

Cross spectrum 

Spectrum Type: 

PSD - power spectrum 
density, 

Real & Imaginary - real 
and imaginary parts of 
the spectrum, 

 
Fig. 9.5. Cross spectrum 

Amplitude & Phase - amplitude and phase. Other settings - see Auto spectrum 

Complex spectrum  

Spectrum Type – Real & Imaginary 
- the real and imaginary parts of the 
spectrum only.  

Other settings - see Auto spectrum 

 
      Fig. 9.6. Complex spectrum 

Coherence function  

Function Type: 

COHERENCE – coherence function;  

INCOHER – non-coherence function; 
COP – coherent output power,  
INCOP – non-coherent output 
power, 
S/N - signal-to-noise ratio.  
Other settings - see Auto spectrum 

 
Fig. 9.7. Coherence spectrum 

 

 
. 
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Transfer function  

 

Spectrum Type: the function H1 or the 
function H2.  

Other settings - see Auto spectrum 

Taking the Logarithm 

 

Logarithm: 10*logX or 20*logX 
coefficient is set. 

Maximum/reference value. Selection 
of reference value (Uref, see Appendix 
A): the maximum value of the source 
signal or the value specified in the input 
field.  

Spectrum transformation  

Transformation: 

1 - none, 1
ω

 - once, 
2

1
ω

- double, 
2

2 2
ω

- switch from the acceleration spectrum to the 

movement spectrum,  1 ω⋅  - single differentiation, 21 ω⋅ - double differentiation.  

  

Low frequency and SNR – HPF settings.  

The spectrum values can be multiplied by 
the correction function values. The 
function is set by pairs of figures: a 
frequency and relevant amplitude 
multiplication factor.  

Mark the Corrector checkbox for 
attaching the correction function. 
To put in the frequency and factor values 
activate the table cell by double click, 
enter the figure and press the <Enter> 
key. Use the <Ins> and <Del> keys for 
inserting and deleting strings.  Fig. 9.10. Spectrum transformation 

Fig. 9.9. Taking the logarithm 

Fig. 9.8. Transfer function
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Press Save and select a file in the standard save dialog for saving the entered 
characteristic to a file. 

To load a function from a disk press Load button, select the From file… menu item 
and select the file. Press Load and select A, B or C function (see [7] and [8] in the 
Appendix B) for loading frequency (acoustic) characteristics of the third-octave 
spectrum.   

Characteristics are stored in the CSV (Comma-Separated Value) format files. You 
can open a characteristic file in MS Excel or as a text file. 
 

Hilbert transformation 

The operation is executed applying the fast Fourier 
transform (FFT).  

Set the block size (FFT points) and the number of 
blocks (FFT portions). 

Centering – suppression of source signal constant 
component. 

Fig. 9.11. Hilbert 
transformation 



WinPOS. User’s Guide 

 98

IIR filtering 

 
Fig. 9.12. IIR filtering 

Approximation type: Butterworth, Chebyshev or elliptic.  
Filter type: HPF – high pass filter, Bandpass filter, LPF – low pass filter.  
The bipole numbers defines the filter order (see FIR filtering below).  
Cut-off frequency - the filter cut-off frequency by the level of –3 dB. The higher 
frequency is intended for LPF, the lower - for HPF. Both frequencies are set for the 
bandpass filter.  
Bandpass irregularity - the variation of attenuation in the passband of the filter.  
Signal frequency - the input signal sampling rate is set by default.  
In the central part of the filter parameter settings window the graphs of amplitude-
frequency, phase and impulse (on the Pulse tab) filter responses are plotted in 
respect to the set parameters. The change of the filter or approximation type is 
immediately represented by the response graphs; after changing the numeric 
parameters press the Apply button for the graph updating.  
The following condition should be observed when the parameter setting:  

2 100s

co

F
F

< <  , where Fco – filter cut-off frequency, Fs - sampling rate. 
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FIR filtering 

 
Fig. 9.13. FIR filtering 

Approximation type: Fourier series.  
Filter type: HPF – high pass filter, bandpass filter, LPF – low pass filter; bandstop 
filter.  
 

Type of Window - to perform Fourier transformations: Hamming or Hann. 
The filter Order defines the curvature, i.e., the amplitude-frequency response 
decrease rate at transfer from the passband to the stopband. The higher is the filter 
order, the more accurate its passband is generated, and, consequently, the less is the 
number of unwanted components of the input signal is applied to the output. 
Cut-off frequency - the filter cut-off frequency by the level of –3 dB. Both 
frequencies are set for the bandpass and bandstop filters. The high frequency is set 
for LPF, the low - for HPF. 
Signal frequency - the input signal sampling rate is set by default.  

In the central part of the filter parameter settings window the graphs of amplitude-
frequency, phase and impulse (on the Pulse tab) filter responses are plotted in 
respect to the set parameters. The change of the filter or approximation type is 
immediately represented by the response graphs; after changing the numeric 
parameters press the Apply button for the graph updating.  
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Median filtering  

 

Filter type: discrete or analog.  
Number of Points - width of filter aperture can be 
only odd.  
Threshold - used for the discrete filter at automated 
definition of levels, defines the possible value 
variations within one level; used for analog filter to 
define the tolerated variation of the signal value from 
the median, when the current value of signal is not 
replaced with median value. 
 High and Low levels - the respective signal levels 
used by discrete filter only.  

Auto level definition - automated determination of the top and bottom signal levels 
in respect to the pre-set threshold. 

Envelope  

 

Select a method for calculating the envelope in the 
Method frame: either the peak-detector or Hilbert 
transformation 
If the peak-detector method is to be applied select 
the Coefficient (C) determining the “time 
constant”. 
If the Hilbert transformation method is to be applied 
set the block size (FFT points) and the number of 
blocks (FFT portions). 

Centering – centering of the source signal, removing its constant component. 

Derivation 

 

Method: 3 and 5 points. 

 

        

Fig. 9.16 Derivation 

Fig. 9.15. Envelope 

Fig. 9.14. Median filtration 
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Integration (antiderivative) 
Method: Euler, Hanning, RC-chain or as 
application to the vibration analysis. 

Centering – removing source signal constant 
component. 

Averaging points number – see Appendix A. 
(for RC series only).  

Only for vibration integration:  
Transient process – the transient process 
suppression mode,  

Points and Cut-off frequency - FFT settings 

 

 

Normalization  

Minimum, maximum – extreme values of the 
result,  

Enable shift – the signal is shifted to fill the 
pre-set range (the min and max fields set the 
minimum and maximum values of the new 
signal). 

 

 

Auto correlation, Cross-correlation 

Number of Points – sample length 
 

Arithmetic operations  

For performance of the elementary arithmetic 
actions: 
• Choose the Function field,  
• Select the operation from the drop down list, 

• enter the number into a Constant field at a 
choice of actions with values of one signal   

 

 

The operations with buffers are performed with pairs of values of the chosen signals.  

If the time scales of signals do not coincide, then for each measurement of the first 
signal the value of the second signal, interpolated at the same time, is taken (linear 
interpolation). 

Fig. 9.20. Arithmetic operations 

Fig. 9.19

Fig. 9.18

Fig. 9.17. Integration 
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It is possible to perform the more hard operations with the signal values if to write a 
expression or formula (it is accessible for the professional and expert versions only) 

• Choose the Function field,  
• Type the arithmetic expression using the VBS syntax (Visual Basic Script) or select 

the earlier typed expression from the drop down list 

An expression can contain numbers, designations of signals, the characters of 
arithmetic operations (,-, *,/,), parentheses and calls of mathematical functions. For a 
designation of entrance signals latin letters A (the first signal) and B (the second 
signal) are used. Besides it is possible to use value of variable I - an index of the 
next value (0 corresponds to the beginning of the chosen range of an entrance 
signal).  

The formula will be serially applied to all values of the first entrance signal (A). If 
there is a second signal  in the expression (B), then for the each value of the first 
signal the value of the second signal, corresponding the same time (at absence - it is 
interpolated) will be taken. 

Examples of correct expressions:  
ATN(A) 
10*SIN(A) + 3.33*COS(B) 
(0.1*B*B - 0.7*A + 17)/(A+12.345) 
(A-20)^3+(A-7)^2+A-0.15 

The list of the mathematical functions: 
ABS - the module of number, 
ATN - arctangent, 
COS - cosine, 
EXP - an exhibitor, 

LOG - the natural logarithm, 
SIN - a sine, 
SQR - a square root of number, 
TAN – a tangent 

Probability density 

 

Method: histogram or kernel estimation,  

Type: hit probability or distribution density.  

Number of Points - number of points of the 
output signal length. 

Centering 

A suppression of a constant component. No additional settings. 

Fig. 9.21. Probability density 
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Probabilistic analysis  

Estimations of mathematical 
expectation, dispersion, RMS, 
skewness, and kurtosis 
(“peakedness”) are logged. 

 
Fig. 9.22. Probabilistic analysis 

Resampling 

Source signal Frequency and Step – 
sampling parameters of the source 
signal.  

New frequency, new step – sampling 
parameters of a new signal.  

Approximation type: linear 
interpolation, 2nd order polynomial, 
cubic local splines or approximation by 
the 1st-6th order polynomial applying 
the least-squares method. 

 

 

The button Filter settings allows assigning of the IIR and FIR parameters, if w/o 
filtering option is not selected.  

Keep type of data – the resulting signal has the same format (e.g., two-byte signed 
integer) of the data element as the source signal. In such cases at the frequency 
increase some characteristic "shelves" can be observed due to limited resolution of 
the source data format.  
 

Parametric graph 

The algorithm allows creating graphs of dependency of a 
parameter from another one and graphs in polar coordinates. 

Select Parametric result if the signals along X and Y axes 
bound to the same time scale. In this case, the signal along the 
X axis is taken as the base for the new signal. Result signal 
values along Y axis will have matching time with values of signal along Y axis. 
Source signals may be of different sampling rate. 

Fig. 9.23. Resampling 

Fig. 9.24 
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Select Y1(Y2) if the signals bound by value indices (usually these are the signals of 
equal sampling rate). 

To plot a graph in polar coordinates select Polar result and select as sources module 
(amplitude) signal and phase (in degrees or radians) signal. 
 

Instant spectrum  
By the menu item 

Windows→Instant 
spectrum a specialized 
page for the spectrum 
calculation "on the fly" 
can be created (Fig. 9.25).  

This page contains two 
graphs: the source signal 
is to be added to the first 
graph, and the signal 
spectrum is shown by the 
lower graph. The signals 
can be added to (deleted 
from) the top graph only.  

The spectrum is calculated 
in the current range and recalculated when it is changed. If this range is less than the 
portion length specified in the algorithm settings, the calculation is not performed 
and spectrum is not represented. If the cursor mode is enabled, the spectrum is 
calculated by one portion selected by the cursor position (the cursor pointing at the 
portion center) irrespective of the current range.  

In order to change the spectrum settings open the page context menu of the instant 
spectrum (click the right mouse button) and select the Algorithm settings item (see 
Fig. 9.26).  

The following spectrum types: "Real & Imag", "Amp & Phase" are not calculated. 

In the same way it is possible to investigate a probability of the hit, the density of 
probability and DDP for a visible part of a signal (Fig. 9.27). Open the contextual 
menu of the Spectrum analysis window. Select the Algorithm selection point (Fig. 
9.26) and than choose Density of probability. Choose the Autospectrum for the 
return of switching.  

 

Fig. 9.25. Instant spectrum page
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Fig. 9.26. Customization of instant spectrum 

  

 
Fig. 9.27 The page of a quick calculation DDP 
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Wavelet analysis 
Wavelet - transformation of signals is one of sorts of spectral analysis, such as 
classical Fourier transform. The feature of a wavelet t-transformation is a possibility 
of the analysis of a signal with localization simultaneously on time and on a 
frequency. wavelet s are the generalized name of mathematical functions sets of a 
definite form which are local in time and on a frequency and in which all functions 
are result from one base (generating) by means of its shifts and expansions on time 
axis. 

 
Fig. 9.28 Initial signal 

 
Fig. 9.29 Wavelet - transformation (morlet – wavelet, m = 6) 

 
Fig. 9.30 Wavelet- transformation (morlet – wavelet, m = 12) 

In the current implementation the algorithm is limited by the wavelet of the type 
"Morlet". 
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Fig. 9.31 "Morlet" wavelet 

Settings  

 
Fig. 9.32 Wavelet settings 

Type – type of a calculated characteristic (amplitude, amplitude & phase, real & 
imaginary).  

Wavelet function – type of a wavelet function, only the wavelet of the type "Morlet" 
is available in the current version.  

Wavelet parameter - a quantity defining a type of a wavelet function. larger values 
correspond to a larger localization on a frequency, smaller – on time.  
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Offset of a window - offset of a window during the calculation of the next portion. A 
value larger than one allows diminishing a volume of calculations at the expense of 
a smaller resolution on time of the resulting signal.   
frequency range – a range of frequencies in which  wavelet  is carried out, and a step 
of a change of frequencies. The smaller step the resolution on time is better but the 
volume of calculations is greater.  

3D spectrum  

 
Fig. 9.28 Calculated result of 3D amplitude spectrum 

For some signals 3D spectrum provides more informative representation of the 
measured processes. The spectrums calculated by portions are not averaged in such 
case but put along the Z axis.  

By setting the 3D flag in the auto spectrum settings (see Fig. 9.1),  
3D amplitude spectrum, power spectrum, power density spectrum, and energy 
density spectrum can be calculated. The Number of FFT portions field defines the 
result size (‘depth’) by Z. The axis Z is digitized in seconds, showing the time of 
start of the next portion. Similarly the 3D-octave spectrum (see fig. 9.4 and 9.29) is 
plotted.  
In the cursor mode (see Part 6. Viewing the signals) the 3D signal projection allows 
detailed inspection of the spectrum parts. Z cross-section is a conventional 2D 
spectrum calculated by portions with an offset equal to Z (specified above the 
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graph). X cross-section shows the amplitudes as functions of time at a fixed 
frequency (see X value in the label above the graph).  

 
Fig. 9.29 Calculated result of 3D 1/12 -Octave spectrum 
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Part 10. Analysis of dynamic processes and 
vibrations  

WinPOS allows the analysis of stochastic, dynamic processes, including the 
vibration ones. The tools from the Vibration analysis menu are used in such 
applications as:  

• Multi-channel processing of dynamic processes,  
• Estimation of rotor vibration status (on stationary modes),  
• Parameter calculations in the start/stopway modes,  
• Processing of strain measurement data,  
• Processing of audio signals,  
• Processing of transient pressure and noises.  

The input data file obtained by the measurements contains the signals of different 
sensors (accelerometers, linear variable differential transformers, proximity probes, 
microphones, strain sensors, resistance temperature detectors, thermocouples, etc.). 
The vibration analysis algorithms allow plotting of selected characteristics of these 
signals as a function of time or study the signal characteristics in association with 
the tachosignals. Such analysis is applied to the vibration inspections of the 
equipment with rotating parts, e.g., turbines. The same characteristics can be 
documented as a vibration report of a product, i.e., as files or special tables (See the 
section Vibration report below).  

To access the vibration analysis algorithms select the Vibration analysis item of the 
program main menu (See Fig. 3.3).  

The order of processing, obtaining and storing the results is the same as described 
above for the standard algorithms. Note, the amplitude-phase-frequency response is 
calculated for the MERA and USML format (*.usm, *.mera) file only.  

Calculated characteristics  
• Tacho, 
• Amplitude/RMS/peak-to-peak value and phase of harmonics,  
• Amplitude/RMS/amplitude-phase response,  
• Amplitude/RMS/peak-to-peak value,  
• Mathematical expectation,  
• Low frequency vibration,  
• RMS value in the band,  
• Spectrum characteristics.  
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Calculation details  
The selected time range of the signal is divided into an integer number of intervals 
with equal length, defined either by the user or by the tachosignal. Then the user 
desired characteristic is calculated by the array of points corresponding to the 
specified length, and the time function with a resolution given by =d

s

NT
F

 is 

produced, where: Fs – the source signal sampling rate; N – number of points in the 
array. The first calculated point is associated with the start of the range (Tn), the next 
one is associated with T= Tn+ Td, etc. The general formula is: Ti=Tn+Td ·  i. Note, 
after such conversion the resulting signal has the sampling rate of =

s
d

FF
N

.  

The calculated characteristic can be represented as [ ]( ) F( X )=i iY T , where: i - the 
number of interval starting from zero, Ti - the time matching i interval, Y- calculated 
signal characteristic, [X]i - array of points of i interval.  

At change of time resolution of the signal characteristic the proportional decrease of 
length of the processed intervals should be considered. This effect causes the change 
of the processed signal bandwidth.  

Mathematical expectation (MV - Mean Value) is defined by the formula estimating 
the average of the discrete data set.  

[ ] k
k

Sum X
MV

N
= , where: N – number of points in the selection [X]k  

Amplitude. The mean value is found. Then the maximum and the minimum values 
in respect to the mean value are found, and the greatest absolute value is derived 
from the obtained maximum and minimum values.  

[ ] [ ]Max(Abs(Min( ),Abs(Max( ))k k kA X MV X MV= − −  
Peak-to-Peak value. The minimum and maximum values are found, the peak-to-
peak value is calculated by subtraction of the minimum value from the maximum 
one.  

[ ] [ ]Max( ) Min( )= −k k kP X X  
Root Mean Square value is the signal power characteristic. Calculated according to 
formula:  

[ ] 2( )kX MV
RMS

N
−

= ∑  

Amplitude and phase frequency characteristics. The power (amplitude, root-
mean square value, or peak-to-peak value) of the selected harmonic element is 
defined in the point array by the cosine-sine conversion, corresponding to the 
resulting signal passing through narrow-band LPF with automatically adjustable 
central frequency. The bandwidth of the analyzing filter is represented as ∆ =

sFf
N

, 

where: Fs – the source signal sampling rate; N – number of points in the array (to be 
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set at the algorithm customization).  

The phase is defined as a difference of arguments of the selected harmonic 
component and imaginary cosine function, the peak of positive semi period of which 
corresponds to the tachosignal mark. Hence, the tachosignal passing over a certain 
threshold is associated with the cosine wave with a zero phase offset.  

Harmonic analysis is performed by the discrete Fourier transform to calculate the 
amplitude and phase at the pre-set frequency. This method is equal to application of 
the bandpass non-recursive filter with the central frequency being multiple of the 
tachofrequency fi and the filter frequency bandwidth ∆f:  

fi=i⋅fT , where:  i - harmonic number (may be fractional); 
  fT – tachofrequency; 
  fi - central frequency of the filter pass band;  

∆f=(Fs⋅k%
 )/100 ⋅k

ENB , where: Fs  - sampling frequency;  
k

ENB - equivalent noise band (see the Appendix B. 
Processing algorithm application guidelines for details); 
k

%
 - adjustment coefficient of the filter pass band (% of 

the pass band filter in respect to the signal sampling 
frequency).  

Note: The formulae of Fourier discrete transform serve as a basis only. In order to make the algorithm 
closer to the calculated one, the additional research works have been carried out. By the results of such 
works some fine issues about the algorithm (when the standard technique provided an instable practical 
implementation) were considered and improved. 
In order to verify the calculated results in respect to the harmonic analysis algorithms contained in the 
WinPOS package, special Bruel&Kjaer equipment was used. The identity of results was proved by the 
conducted tests.  
 

Sequence processing (trends) 
This algorithm allows time representation of the signal instantaneous characteristics. 
The Sequence processing window (Fig. 10.1) is opened by the Vibration 
analysis→sequential processing (trends) menu item. 

The window is divided into two parts. The top part contains three functional areas – 
the group of processing options, the window containing the selected signals list, and 
the control group to select a file for processing and specify the file to save the 
results. The lower part of the window has a graph for the results preview. Preview 
allows interruption of the processing by the <Esc> key in case of evident failure, and 
taking of the appropriate measures. (This option is important while processing big 
files, when the calculation time may be of great importance).  
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Fig. 10.1. Sequence processing (trends) 

The customization of this algorithm includes setting of the calculation parameters, 
the averaging time and selection of the file/signals for the analysis.  

The calculation parameter is entered into the Operation type field by selection of the 
average (mathematical expectation), root mean square (RMS) value, amplitude, 
peak-to-peak value (double amplitude) from drop-down list of the possible 
operations.  

The averaging time is set in the Portion size fields in samples (points) either in 
second.  

Select by the Browse button a signal or a folder in the Select signal dialog (Fig. 3.5). 
The signal names and frequencies are shown in the Signal list; the signals to be 
processed are marked by a tick near the signal name. In order to process all signals 
check the Select all checkbox. The resulting file name is shown in the Destination 
field.  

Press the Execute button to start the processing. The progress can be monitored in 
the preview window. The resulting signals are displayed as separate graphs for each 
signal. 
 



Part 10. Analysis of dynamic processes and vibrations 

 115 

Calculation of band RMS value  

 
Fig. 10.2. Calculation of band RMS 

To perform the time research of the signal power estimation per a pre-set frequency 
range, select Vibration analysis→Band RMS menu item. The Calculation of band 
RMS window (Fig. 10.2) is differentiated from the Sequence processing window 
(Fig. 10.1) by the processing options, where the frequency range and FFT 
parameters are set. In the Top frequency field any negative number can be specified, 
and the maximal value of frequency will be accepted. as the top border of a 
frequency range. The Integration field allows calculation of vibration acceleration, 
vibration speed and vibration displacement.  

Calculation of amplitude-phase-frequency response 
This group of algorithms allows representation of the signal harmonics in time or as 
a function of frequency. Select the Vibration analysis→Calculation of amplitude- 
phase-frequency - response menu item. The Calculation of amplitude-phase-
frequency response window (Fig. 10.3) is differentiated from the Sequence 
processing window (Fig. 10.1) by the processing options. 

The amplitude-phase-frequency response is calculated for the MERA and USML 
format files (*.usm, *.mera) only.  
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Fig. 10.3. Calculation of amplitude-phase-frequency response 

In order to calculate an amplitude-phase-frequency response choose initial signals, 
having marked them by a tick, set the tachosignal, having pressed the right button of 
the mouse on the tachosignal's name in the list of signals and having chosen the 
Tachosignal point from the contextual menu. It is not necessary to mark by the tick 
itself tachosignal.  

 
If frequencies of digitization of the initial signals are differ, then an over-digitization them 
is carried out to a greater frequency before the calculation. At the same time the 
additional error is set, depending on a difference between frequencies.  On the average, 
the size of an error is within the limits of 1 %. 

Similarly a tachosignal it is possible to set a basic signal. In this case AFC of the 
initial signals is divided on AFC of the basic signal.  

A phase is calculated as the difference of the basis signal and the initial one. The 
same signal can be simultaneously by the basis signal and by the tachosignal. The 
influence of the basis signal on the result of the algorithm is shown on the figure 
10.4.  

The settings are separated into two groups:  basic settings and additional, which are 
on the individual tabs. The settings of the characteristic and the processing of the 
tachosignal are on the same tab. 
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Fig. 10.4.  An Influence of a basis signal on a result of a calculation of amplitude-phase-

frequency response 

The basic settings of the characteristic 

Operetion - defines the 
counted characteristic: 

• Amplitude (Harmonic 
amplitude), phase (Phase), 
amplitude and phase 
(Amplitude/Phase) of the 
selected harmonics;  

• Frequency as function of 
time – tachocharacteristic 
(Tacho);  

• Amplitude sum – effective 
value (RMS), the amplitude 
or peak-to-peak value of 
the signal general level (by all harmonics), see below. 

Harmonic- an ordinal number of the harmonic. To the right of this field it is 
possible to specify the type of the result: RMS, A – the amplitude, 2*A – the peak-
to-peak value; 

Х axis -  defines a dimension of the calculated characteristic on axis X (Hz - 
frequency, sec. – time, or RPM - revolutions) is set.  
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Bandwidth - the bandwidth of the analyzing filer in Hz. At a change of the 
bandwidth the values in the Block size field are also changed.  

Block size - definition of the size of the portion by which the calculation is 
performed. The size can be set in samples or seconds.  

 Integration - defines a kind of  a transformation with the calculated characteristic 
in  the frequency area:: none, single and double integration.  

The basic settings Tacho 

Hi-Level and Lo- Level - accordingly positive and negative levels. The consecutive 
transition of a signal through these levels is considered as a front of a signal. Such 
algorithm of the definition of the signal front considerably raises a noise stability of 
the algorithm. 

Level - defines units in which absolute or relative levels (in percentage of the 
maximal – the peak-to-peak value) are set.  

Phase correction - the value from which the phase starts to change. 

The additional settings of the characteristic 

 

Frequency step - the step of the 
frequency change. If some 
values get in the same range, the 
resulting value will be taken as 
either average or maximum 
(depending upon the mode is 
chosen in the field on the right).  
That makes sense only if Hz or 
RPM are selected in the X axis 
field.  

 Window - defines a type of a weight window:: Rectangular, 
Triangular, Hanning, Blackman. The choice of a window influences 
an effective bandwidth of the analyzing filter. 

Sort - the obtained data are sorted by increase of the calculated 
frequency. The sorting can be demanded in the event that the frequency of the 
tachosignal changed not monotonously. 

Monotonous phase - allows to the phase to change out of the range of 0-360 
degrees.  

The additional settings Tacho 
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Front (Positive or Negative) - defines the tachosignal front, from which the phase 
will be calculated.  

Max. step - The maximum  permissible difference between two successive reading. 
If this value is exceeded, a random peak has occurred. This option is used if 
Smoothing is enabled. 

Multiplier – the coefficient by which the calculated value of the frequency of the 
tachosignal is multiplied. It is necessary to perform such operation in the cases, 
when the rotation frequency has been measured via some reducer but not on the 
inspected shaft directly.  Then the rotation frequency of the inspected equipment 
equals the product of the reduction coefficient and the measured rotation frequency 
of the secondary shaft.  

Pulse duration - the minimum allowable "regular" duration of the tachosignal (in 
shares from the calculated maximal duration of an impulse of the gauge of turns) for 
the performance of a time filtration.  In some cases the presence of rotor defects 
leads to that besides a “ regular “signal of the gauge of turns the handicaps are 
imposed on the tachosignal, which deteriorate a normal work  of the program 
processing. The essential difference of these handicaps is them considerably smaller 
duration. The time filtration removes such signals from the record of the tachosignal, 
the duration of which less of the value set in the Pulse duration field.   The time 
filtering is enabled if only the Filtering checkbox is checked. The source signal is 
filtered, and the result of the filtration is used in calculations.  

Filtering - enables a filtering of the source signal throughout width of impulses (see 
Pulse duration above).  

Smoothing - an additional amplitude filtering of the tachosignal. The purpose of 
such filtering is to exclude random amplitude peaks of the tachosignal. Several 
successive values (frame) are analyzed, and if within such frame the signal 
amplitude is above the pre-set value (tolerable increase rate, or peak – set in the 
Max.step field), the linear interpolation of the frame values is performed.  

Fig. 10.5. A graphic presentation of peculiarities of the PFC calculation 
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The calculation is performed by the Execute button. At the time of calculations the 
characteristics are displayed on the preview panel (bottom). 

Recommendations for an algorithm setting 

AFC is calculated by different ways, depending on what is chosen in the Operation 
field - Amplitude or Amplitude/phase, results can differ a little. Generally, the 
preference should be given to operations Amplitude/phase even if a calculation of a 
phase is not required, however sometimes the Amplitude operation can give more 
correct results.  

The size of the block should be chosen such that at the minimum a few full periods 
are placed into this block on all range of a frequency change. If too small block is 
chosen, on some areas the algorithm cannot calculate a frequency over the 
tachosignal. However, it is not necessary to choose too big size of the block, because 
there will be a loss of the information owing to the averaging a plenty of values.  

The levels for calculation tacho are recommended to set in relative units (percent), 
especially, if the amplitude of the tachosignal essentially changes with time. In this 
case, absolute values will be calculated separately on each block. 

 
Note, if the calculated graph contains negative frequency (time) values that means a 
failure of the tachosignal.  There was no a crossing through a certain threshold or  the 
tachosignal dropped to zero. In this case the settings of the tachosignal analysis should 
be verified. 
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Vibration Report  

The algorithm is intended for batch calculation of vibration characteristics and 
generation of the report by the industrial standards. The list of characteristics 
calculated by the present algorithm and their symbols are provided in the table 
below:  

Characteristic Symbol 
Tacho n / f 
Harmonic RMS value e(f) 
Harmonic amplitude a(f) 
Harmonic peak-to-peak value r(f) 
Harmonic phase F(f) 
Harmonic RMS value vs. frequency  es(f) 
Amplitude vs. frequency as(f) 
Peak-to-peak value (Amplitude*2) vs. frequency rs(f) 
RMS value e 
Amplitude a 
Peak-to-peak value r 
Mathematical Expectation (Mean Value) m 
LFV (Low frequency vibration) h / fh 
Band RMS value  f suffix 
Spectrum analysis F / K(f) 

In the Vibration Report mode the above estimations are calculated separately for 
each revolution of the rotating equipment parts with the signal interpolation between 
the samples. The tachosignal is used to divide the whole signal implementation into 
revolutions.  

In the energy industry the table representation (Microsoft Excel, XLS format) of 
vibration characteristics is used for the static analysis. See Fig. 10.4.  

In the aviation industry, as a rule, the processing results have to be represented in 
text format, e.g., RTF. See Fig. 10.5.  

Consequently, two operation modes of the vibration report algorithms are provided:  

• Placement of results into the signal tree (WinPOS mode);  

• Placement of results into the Excel tables (Excel mode).  

Both modes have the means of switching to another mode with preservation of the 
calculated parameter settings.  
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Fig. 10.6. Excel table with the vibration parameters 

 
Fig. 10.7. RTF table with the vibration parameters  
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WinPOS Mode  

When the Vibration Report menu item is selected, the settings window is created 
for the WinPOS mode (Fig. 10.8).  

 
Fig. 10.8 Vibration Report settings window  

Where: 1 – list of channels; 2 – list of characteristics (estimations); 3 – calculation progress 
preview window; 4 – Excel table selection button (switching to the Excel mode); 5 – selected 

characteristic options. 

On the panel (1) all signals (channels) of the selected file are shown. The channels to 
be processed by the present algorithm must be ticked. To mark all channels use the 
Select all option. The second column of the list contains symbolic names of 
characteristics calculated for the respective channels. The window (2) shows the 
characteristics prepared for use in the calculations. New characteristics are added 
and the exiting characteristics are removed by the Add and Remove buttons located 
below this list. The characteristics calculated for the selected channel are marked by 
ticks. When the characteristic is selected in the list, the options of this characteristic 
are shown on the right.  
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In course of the algorithm execution the panel (3) shows the calculation process of 
the current characteristic. The calculation can be interrupted at any time by pressing 
the <ESC> key. Switching to the Excel mode is made by pressing the button (4) 
selecting an Excel file and a worksheet in it.  

Characteristic calculation settings  

Tacho  
Name - name of characteristic.  
Y axis - units of the calculated tachocharacteristic by Y 
axis: Hz or rev.  
Passband width - the passband width of the analyzing 
filter in Hz. At a change of the passband width the values 
in the Block size field are changed too.  
Block size - the block size (in samples or seconds) by 
which the calculation is performed.  
Frequency step - frequency range step. If several values 
are found in one range, the average or the maximum 
resulting value shall be used (depending upon the mode 
selected in the drop-down list on the right).  
Hi level, Lo level - positive and negative signal levels used 

for the signal front detection.  
Front - the tachosignal front from which the phase is calculated.  
Multiplier - coefficient by which the calculated tachosignal value is multiplied. 
Max.step - maximum tolerable difference of two successive samples. If Smoothing is enabled, and the 
value is exceeded, the random peak is occurred.  
Smoothing - peak smoothing enabled.  
Pulse duration - maximum tolerable pulse duration (as multiplier of the calculated maximum pulse 
duration of revolution sensor). Used only if filtering is enabled.  
Filtering - enables the source signal filtering by the pulse duration.  
Phase correction - starting value of the phase  

Amplitude and phase of harmonic  
Name - name of characteristic.  

Harmonic - harmonic order (it is required only for 
amplitude and a phase of a harmonic). 
Tachosignal - name of the tachosignal.  
X axis - units of the calculated tachocharacteristic by X 
axis: Hz or rev.  
Passband width - the passband width of the analyzing 
filter in Hz. This value is set by the tacho settings.  
Block size - the block size (in samples or seconds) by 
which the calculation is performed. This value is set by the 
tacho settings.  
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Frequency step - frequency range step. If several values 
are found in one range, the average or the maximum 
resulting value shall be used (depending upon the mode 
selected in the menu on the right). This value is set by the 
tacho settings.  
Window - type of the weight window.  

Integration - the characteristic conversion 
type in the frequency domain: none, single 
and double integration.  
Sort - data sorting by the X axis.  
Monotonous phase - allows the phase changing beyond 
the range of 0-360 degrees. Used for the phase calculations 
only.  

RMS value, amplitude and peak-to-peek value of source signal as 
function of tachofrequency  
The settings are similar to the harmonic amplitude settings. Only the fields Name, Tachosignal, X axis, 
Integration and Sorting are enabled.  
 

RMS value, amplitude, peak-to-peak 
value and Mathematical Expectation  
Name - name of characteristic.  
Block size - the block size (in samples or seconds) by 
which the calculation is performed.  
Integration - the characteristic conversion type in the 
frequency domain: none, single and double integration. 

LFV  
Name - name of characteristic.  
Characteristic type - the calculated characteristic type.  
Cutoff frequency - the frequency dividing high and low 
frequency ranges.  
Number of FFT points - the number of points by which 
the spectrum is calculated.  
Integration - the characteristic conversion type in the 
frequency domain: none, single and double integration.  
 

Band RMS value 
Name - name of characteristic.  
Low frequency – lower limit of the frequency range.  
High frequency – higher limit of the frequency range.  
Spectrum type – control is disabled. The power spectrum 
is always calculated.  
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Number of FFT points – the number of points by which the spectrum is calculated.  
Integration – the characteristic conversion type in the frequency domain: none, single and double 
integration.  
 

Spectrum analysis  
Name - name of characteristic.  
Characteristic - type of the calculated characteristic.  
Tachosignal - name of the source tachosignal.  
Number of FFT points - the number of points by which 
the spectrum is calculated.  
Integration – the characteristic conversion type in the 
frequency domain: none, single and double integration.  

After finishing calculations the result window (Fig. 10.9) is opened automatically. 
Besides, all calculation results are placed as signals into the signal tree to the branch 
called by the processed file name with addition of the suffix «_VR».  

 
Fig. 10.9. Results of vibration report calculations 

Where: 1 – toolbar; 2 – characteristic graphs; 3 – characteristic table; 4 – list of modes; 5 – list 
of marks. 
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After finishing calculations and opening the result window the first two 
characteristics are displayed in the graphs (2) by default. Further the number of 
graphs and the represented signals can be modified (by the  button on the 
toolbar) by selection of the active graph and marking the desired signals or 
characteristics with a tick in the characteristic table (3).  

In turn, the characteristic table has two views switching by the  button on the 
toolbar. The first view is shown in Fig. 10.7. The first column contains the names of 
the source signals, the second - the calculated characteristics, and the third - the 
characteristic values at the point defined by the cursor position in the active graph. 
In the next columns the characteristic values at the mark points are represented. The 
table contains the markers within the selected signal mode range only.  

If the source signals contain signal modes (see Auxiliary signal information and 
parameter status section of Part 6. Signal viewing), the modes will be listed in the 
window (4), otherwise, the list has one line only: "Whole signal". Under the list of 
signal modes the list of marks (5) is provided. The list contains all marks set in the 
selected signal mode range; the marks outside this range are not shown. At the 
selection of the mark the cursor of all graphs shall be moved to the mark, and the X 
axis range of the graph is changed when necessary to display the selected mark. The 
marks are added or removed by the toolbar buttons.  

The generated report can be saved as a table in an RTF format file.  

The purpose of the result window toolbar buttons is described below.  

 

General view - viewing only the signal graph and processing results. 
Operations with the input data are possible. The graph view cannot be 
modified.  

 

Scrolling, the graph shifting by both axis (X and Y) simultaneously. To make 
the shift press and hold the left mouse button in the graph window, and then 
move the mouse cursor to the desired direction. The signal graph is shifted 
with the cursor.  

 

Zooming by both axis (X and Y) simultaneously. To zoom in the graph move 
the cursor to the start/end of the area to be zoomed. Press and hold the left 
mouse button and move the cursor to the desired direction, to the start/end of 
the area to be zoomed. The rectangular frame of the zoomed area will be 
shown by dotted line in the graph window. At release of the left mouse button 
the interval will be zoomed in the whole viewing window. 

 Zooming by X axis. 

 Zooming by Y axis. 
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 Cursor mode (vertical and horizontal lines in the graph window). 

 Return to the previous axis range of the graph axis.  

 Vertical lines from the signal values to X axis.  

 
Set the scale by the X axis to display all measured points from the maximum to 
the minimum value in the viewing window (normalization by X). 

 
Set the scale by the Y axis to display all measured points from the maximum to 
the minimum value in the viewing window (normalization by Y).  

 Customization. Allows setting the graph representation parameters.  

 Set the number of graphs in the window.  

 Switch the characteristic table views.  

 
Synchronization of cursors. The button is active when the cursor mode is 
enabled and the number of graphs on the page more than one.  

 Set the mark at one or all signals at the cursor position.  

 Remove the mark selected from the list of marks.  

 Save the characteristic table to an RTF format file.  

 Print graphs.  

The second view of characteristic table is shown below.  

 
In this view the source channels are shown in columns, and the characteristics set in 
the Vibration Report settings window are shown in rows. The table cells contain the 
characteristic values calculated by the respective channels, at the position of selected 
mark or cursor in the active graph (if this position does not match the selected 
mark). If the particular characteristic has not been calculated by all channels, the 
respective table cells are left empty.  

If the source signals contain signal modes, the modes will be listed in the window 
(4), otherwise, the list has one line only: "Whole signal". Under the list of signal 
modes the list of marks (5) is provided. The list contains all marks set in the selected 
signal mode range; the marks outside this range are not shown. At the selection of 
the mark the cursor of all graphs shall be moved to the mark, and the X axis range of 
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the graph is changed when necessary to display the selected mark. The marks are 
added and removed by the  and  buttons on the toolbar.  

In order to obtain the final report in RTF format file (an example is shown in Fig. 
10.5), the markers should be set while viewing of the calculation results (see Fig. 
10.7).  

After the table formatting is completed, the report can be saved in an RTF format 
file. Press the  button on the toolbar and specify the filename. Further the report 
file can be processed by Microsoft Word or WordPad, or imported to the user's 
applications. 

Excel Mode 

Vibration Report allows calculation of vibration parameters by the 
pre-set templates and storing the results to the Excel file.  

This option is accessible by the Excel button at the right top 
corner of the Vibration Report settings window. When this button 
is pressed, the drop-down menu is shown. Select Open table 
menu item to open an XLS format file. A standard open file 
dialog appears.  

After the table is 
selected, the 
window in which all 
pages of the given 
file are enumerated 
opens (Fig. 10.10). 
Select the page 
containing the 
required template 
and press OK. 

 

 
Fig. 10.10. Page selection window 

Attention! The selected table is only a template to generate the report. All settings 
required for calculations are taken from the .INI file (the name of this file matches 
with the name of selected XLS format file), that must be found in the same folder 
with the XLS format file.  

After that the settings are read and the characteristic list is populated. If the 
processed file is already opened, the characteristics are automatically linked to the 
channels by the following criterion: if the channel with this name has the 
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characteristics list in the settings file, then only the specified characteristics are set to 
this channel. Otherwise, all the characteristics except tacho are linked to the channel. 
In the “Result” field the file name and the page for the calculation results are 
specified.  

If necessary, the user can change any settings before calculations. The list of 
characteristics and their options can be saved in the settings file by selection of the 
«Save settings» items from the above menu.  

The calculation progress is displayed on the graph in the lower part of the Vibration 
Report settings window (see Fig 10.8). After the calculation is completed, the 
generated table is automatically opened by Microsoft Excel (if installed). 

Sample templates (Excel tables):  

1. 

 

2. 

 
3. 
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4. 
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Campbell diagram  
Campbell diagram is applied to the analysis of dynamic processes, mainly, in the 
transient modes.  

 
Fig. 10.11. Settings window of Campbell diagram calculations  

In order to perform the calculations the tachosignal must be set by pressing the 
signal name in the list of signals with the right mouse button, and by selection of the 
Tachosignal item in the context menu. The tachocharacteristic describing the 
change of the rotation rate as a function of the test time is calculated by this signal. 
For each value of the obtained characteristic being within the specified 
tachofrequency range the amplitude spectrum is plotted by the respective data block 
of selected signals. More details on the intermediate spectrum calculation method 
are provided in the section Order analysis.  

The peaks (maxima) are searched in the frequency spectrum specified in the settings. 
Such peaks are sorted by the amplitude or frequency, accordingly to the settings. 
The Figure shows the maximum values to be selected from the one spectrum when 
being sorted by the frequency (upper graph) and by the amplitude (lower graph).  
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Fig. 10.12. Options of the spectrum peaks selection  

If several values of tachocharacteristic are found in the same range (defined by the 
pre-set frequency step), either average or maximum peak values are selected, 
depending upon the method specified in the settings (to the right from the 
“Frequency step” field). This may happen if a large frequency step is selected, or at 
this interval the frequency was changed slowly, or the frequency change was not 
monotonous.  

Tachofrequency, spectrum peak frequency, amplitude (RMS or peak-to-peak value) 
and the order (the spectrum peak frequency to the tachofrequency ratio) for each 
peak are stored in a separate signal (in Results folder). After calculation is completed 
the window containing the results represented by a table or a diagram is displayed.  

Settings  

The settings are divided into two groups: the algorithm settings and 
tachocharacteristic settings. The tachocharacteristic settings are described above, in 
the Vibration Report section.  

X Axis - the size by X axis 
(tachofrequency range): in Hz or rev.  
Frequency step - the step of the 
tachofrequency changing. If several values 
are found in the one range, then the 
averaged or maximum value is taken as a 
resulting one (depending upon the mode 
selected in the drop-down list to the right 
of the field).  

 Only the signals with the sampling rate matching the sampling rate of tacho signal are 
included into the calculations.  
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Tachofrequency range - the minimum and maximum values of the tachofrequency 
.  
Spectrum frequency range - the minimum and the maximum values of the 
frequencies where the spectrum maximum values are searched. If a negative value is 
specified as the maximum value, (e.g., "-1"), the maximum frequency value is set 
automatically.  
Block size - the block size (in samples) to perform the calculations. The type of 
values - RMS/Amplitude/Peak-to-peak Value is selected on the right from this field.  
Harmonic quantity - the number of peaks in the spectrum for plotting the diagram.  
Sorting by amplitude - if this option is selected, the peaks found in the spectrum 
are sorted by the amplitude, otherwise - be frequency.  
 
Result window  

  
Fig. 10.13. Campbell diagram window  

All calculated signals are contained in the list in the left part of the window. Their 
names consist of the source signal name and the number of maximum, e.g. “Test_2”. 
The calculation results can be viewed as table or diagram. The views are switched 
by the  and  toolbar buttons.  
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The table represents only 
one signal which is 
selected from the list. 
The first column of the 
table contains the 
tachofrequency values,  

Fig. 10.14. Calculated results in table 

the second - the spectrum peak frequency, the third – the order of harmonics (the 
maximum frequency divided by the tachofrequency), the fourth - the spectrum value 
at a given point. For all columns except the first one, the rounding can be tuned in 
the settings window opened by the  toolbar button. The  toolbar button saves 
the selected signals in a text file or a Microsoft Excel file.  

The diagram shows the spectrum peak frequencies as a function of the 
tachofrequency. The signals with the selected names in the list are displayed in the 
diagram. All signals obtained in one channel are represented by the same color in the 
diagram.  

  
Fig. 10.15. Views of Campbell diagram  

The points on the diagram are shown by the markers. The marker has shape of either 
dot, or vertical line, or circle. The line heights and circle diameters depend upon the 
signal values (RMS, amplitude or peak-to-peak value) at a given point. This 
dependence is set by the "Zoom" control group (see Fig. 10.16). If the option "value 
in %" is selected, then the maximum value among all signals is 
equal to 100%.  

The zoom can be changed by dragging the zoom scale box top 
with the mouse.  
The range of the X axis matches that of tachocharacteristic. If the automatic Y range 
detection is enabled, the range is set from zero to the maximum value of the 
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spectrum frequency of all signals represented by the diagram. The automatic 
detection of the range by Y can be disabled, and the required values can be set 
manually. Except for the grid by the axes X and Y, the diagram contains an 
additional grid showing the multiple harmonics (orders). The order of the first and 
the last lines as well as the step between the lines can be set.  

By pressing the  toolbar button the diagram is printed out.  

 
Fig. 10.16. Campbell diagram settings 

Representation - the shape of the 
markers to be displayed - dots, 
vertical lines, or circles.  
Scale - dependence of the signal 
value and the size of its marker on the 
diagram. The size is set in pixels, the 
signal value - in the absolute units or 
in percents. If the markers are 
displayed by dots, this control group 
is disabled and the size of the marker 
is 2 × 2 pixels. 
Y Axis range - enable or disable 
automatic Y range detection; if 
detection is disabled, the range is set 
manually. 

Order lines – this control group sets the step of the order line representation and 
their first and last number.  If automatic setting is enabled then first order is assigned 
to 1, the last order is detected automatically, and the step (order increment) is 1. 
Otherwise the settings are assigned manually. 
Rounding - setting of the rounding precision for values in all table columns, except 
the first column.  
Save as default settings - if this option is checked, all changes of settings are saved 
in the file WinPOS.cfg and will be used at next session.  

Order analysis  
The order analysis is applied to the dynamic processes, mainly in transient modes, 
such as run up and run down. A 3D signal is the result of calculations, where the 
spectrum frequency or the harmonic order is put by the X axis, the tachofrequency 
or time - by the Z axis, and amplitude, peak-to-peak value or RMS - by the Y axis. 
For calculations the source tachosignal must be set, by clicking the tachosignal name 
in the list of signals with the right mouse button and selecting the Tachosignal 
context menu item. Tachocharacteristic is calculated by this signal. If frequency (in 
Hz or RPM) is specified in the settings of Z axis, the frequency range specified in 
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the settings (the Tachofrequency range field) is selected for the characteristic. If 
seconds are selected at the Z axis, further calculations is performed over the whole 
frequency range, i.e., with the whole signal.  

For each tachocharacteristic value within the above range a respective data block is 
selected from the source signal. 

 
Fig. 10.17. Order analysis settings window  

For example: the value of tachocharacteristic is calculated by the block with the size 
of 1024 samples, starting at the 10th second. Then, the block of 1024 samples 
starting from the 10th second of recording session is taken from the source signal 
from the sensor. The spectrum with the selected settings is calculated by this block 
and then stored in the resulting signal as a current cross-section by the Z axis. If the 
orders are selected in the settings of the X axis, the frequencies of the spectrum are 

 Only the signals with the sampling rate matching the sampling rate of tachosignal are 
included in the calculations.  
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divided by the frequency of the tachocharacteristic, at which the spectrum is 
obtained.  

 
Fig. 10.18. Range selection for spectrum calculation  

1 - Tachocharacteristic;  
2 - Source signal from the tachometer (tachosignal);  
3 - Source signal from the sensor;  
4 - Spectrum of the selected block of sensor signal.  

If frequency is selected by the axis Z, and several values of tachocharacteristic are 
found in the same range defined by the set frequency step, only one spectrum is 

written to the resulting 
signal in the given range. 
This effect occurs if a 
large frequency step is 
selected, or frequency is 
changed slowly or 
monotonously at the 
given range.  

Fig. 10.19 shows the Fig. 10.19
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points of the same range by similar color. The frequency step is 1 Hz (shown by red 
vertical line). In the ranges 104.5 - 105.5 Hz (1) and 103.5 - 104.5 Hz (2) the 
tachocharacteristic is not monotonous, hence, two values are found in these 
spectrums. Three values are found in the range 102.5 - 103.5 Hz (3) due to slow 
tachocharacteristic changes.  

The method of obtaining the resulting spectrum is specified by the settings (on the 
right to the Frequency step field). The first spectrum calculated for the given range, 
or the spectrum obtained by averaging of several spectrums, or the spectrum 
obtained by selection of maximal values of several spectrums can be taken as a 
resulting one.  

Fig. 10.20 demonstrates 
the results of application 
of different methods to 
four source spectrums 
shown by the top graph. 
The second graph shows 
the first spectrum, the 
third - averaged 
spectrum, the fourth - the 
maximum spectrum.  

After calculations the 
result is represented by a 
3D graph.  

 

 Fig. 10.21. Viewing the order analysis results as 3D graph  

Fig. 10.20 
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Settings  
The settings are divided into two groups: the algorithm settings and the 
tachocharacteristic settings. The tachocharacteristic settings are described in the 
Vibration Report section.  

Axis X / Axis Z - the size by the axes X and Z. 
The values in Hertz or the orders can be set by 
the axis X, and the values in seconds, Hertz or 
rpm can be set by the axis Z.  
Frequency step - the step of the 
tachofrequency increment. The kinds of 
method of spectrum calculation are selected 
from the drop-down list to the right of the 
Frequency step field. The methods are 
described above.  Tachofrequency range - the 

minimum and maximum values of the tachocharacteristic for the calculations.  
Order range - the minimum and the maximum values to be set for the X axis in the 
resulting signal, if the orders are selected by the X axis.  
Step by X axis - the step at which resampling is made while recalculating the 
spectrum frequencies into orders. The less is this value the more precisely the form 
of the resulting spectrum matches that of the source spectrum (the size of the 
resulting signal is increased in this case).  
Block size - the block size (in samples) to perform the calculations. The type of 
values - RMS/Amplitude/Peak-to-Peak Value is selected on the right from this field.  
FFT type - the spectrum type.  
Window type – the type of the weight window used for the spectrum calculations.  
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Part 11. WinPOS scripting features 

WinPOS scripts  
WinPOS provides the user with the interfaces for creation of own scripts, plug-ins or 
applications, operating with the data and algorithms of WinPOS almost in any 
modern programming environment.  

Borland Delphi is the best solution for writing own effective processing algorithms, 
processing of large amount of data, creation of applications based upon WinPOS but 
requiring additional customization or being able to generate specialized reports. 
Borland C++ Builder, Microsoft Visual C++, Visual Basic or FoxPro can also be 
used.  

However, Visual Basic Script is more suitable for writing small WinPOS scripts or 
simple algorithms. VBScript is included into the Microsoft Windows delivery 
package, requires no separate compiler, and a convenient environment for editing 
and debugging of scripts is included into WinPOS.  

The script editor (Fig. 11.1) is opened by the Script→Script editor… menu item. 

The script editor is a 
text editor with syntax 
highlighting and a 
standard toolset that 
can be accessed by 
menu, toolbar and hot 
keys/ 

The script editor 
provides the user with 
all necessary tools for 
the script execution 
while debugging: 
breakpoints and step 
by step execution, 
viewing of local 
variables and the call 
stack, calculation of 
expressions. 

 
Fig. 11.1. Script editor 
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A detailed description of the script editor, interfaces, methods of program 
documenting and samples are provided in the Programmer's Guide.  

The script execution could be started in several ways:  

• From the script editor - Debug→Run/Break (<Ctrl+F10>),  

• Select Script→Run script… in the WinPOS main window or select one of 
previously executed scripts from the same menu.  

• From the command line (“winpos.exe myscript.wps”).  

A typical example of the first program by VBScript is given below:  

 
 

The line «Hello, world!» will be printed in the Script editor panel.  

Start from the command line  
The file names - USML(.usm), MERA(.mera) or script files(.wps) can be specified 
(separated by a space) as the WinPOS command line parameters. In this case the 
data files are placed to the signal tree, and the script is executed. The data file 
(USML or MERA) can be placed to the graph page by the -s key.  

WinPos.exe [-h] [[-s] [usmlfile1.usm]..[-s] 
 [-q]..[usmlfileN.usm]] [[wpsfile1.wps]..[wpsfileM.wps]]  

List of command line keys  
-s Open all files after the ”-s” key in graphs  
-q Cancel the ”-s” key effect  
-h Information on the command line keys and parameters 

Examples  
 WinPos.exe -h  
   - WinPOS Help is opened  
 

 WinPos.exe test.mera u123_45.usm start.mera 
   - 3 files are added to the signal tree  
 

 WinPos.exe test.usm u123_45.usm -s start.mera error.usm -q finish.usm 
   - 5 files are added to the signal tree,  start.usm and error.usm files are opened in the graphs  
 

 WinPos.exe myscript.wps  
   - the myscript.wps script is executed  
 

 WinPos.exe test.mera myscript.wps  
   - the test..mera file is opened and the script myscript.wps is executed  
  

sub main 
  DebugPrint “Hello, world!” 
end sub 
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Appendix A. Processing algorithms  

Introduction 
In order to avoid any possible methodological discrepancies, this section contains 
the formulas and short explanations, in accordance with which the data processing 
algorithms are executed.  

The WinPOS package allows you to perform data processing of the following types:  
spectrum analysis, correlation analysis, filtering, envelope calculation, integration, 
differentiation, and to calculate estimates of the following characteristics: 
probability frequency distribution, mathematical expectation (mean value), 
dispersion (variance), root mean square error, skewness and kurtosis. 

The frequency analysis is based on the Fourier transformation. The determining 
expressions for the Fourier transformation of the input sequence {x(n)} n=0,..,N-1 
are: 
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The calculation procedure for the discrete Fourier transformation (DFT) is the fast 
Fourier transformation (FFT) algorithm. The discussion of the specific algorithm, 
which is built into the WinPOS package, is given below. 

In most practical cases the x(n) values are real, and the FFT algorithm is designed 
for complex numbers. In order to eliminate this redundancy and load the imaginary 
part of the input data, the input stream is divided into two sequences, in the 
following way: the odd numbered points represent one sequence, while the even 
numbered points represent the other sequence. Then, one of these sequences will 
represent the real part, and the other will represent the imaginary part of the input 
array for the FFT algorithm. 

Thus, given the {x(n)}, n=0,..,N-1 input sequence and denoting 
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Which gives us: 
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Then we form the input array: Z(k) =f(k) + ih(k), where k=0,1,..., N/2-1, and apply 
the FFT time thinning algorithm, with the substitution of the base equal to 2, with 
the binary-inverse input data order. 

Applying the separation formulas to the Fourier transformation {Z(k)}, we obtain the 
following two transformations: {Fk } and {Hk }, 

 Re(F(k))=0.5⋅(ReZ(k) + ReZ(N/2-k)) 
 Im(F(k))=0.5⋅(ImZ(k) - ImZ(N/2-k)) 
 Re(H(k))=0.5⋅(ImZ(k) + ImZ(N/2-k)) 
 Im(H(k))=0.5⋅(ReZ(k) - ReZ(N/2-k)), where k=1,..., N/2-1. 

The {G(N/2-k)} transformation is calculated according to the following formulas: 

 ReG(0)=ReZ(0)+ImZ(0)  
 ImG(0)=0 
 ReG(N/2)=ReZ(0)-ImZ(0)  
 ImF(N/2)=0 

Some specific comments regarding the use of the FFT algorithm will be presented in 
the description of the characteristics calculation algorithms description, and in 
Appendix B Recommendations to the processing algorithm application. 
 

Spectrum analysis 
Within the scope of the spectrum analysis the following characteristics estimates are 
calculated: 

• the amplitude spectrum, the power spectrum, the power spectral density, 
the energy spectral density, the complex spectrum; 

• the cross spectrum; 
• the coherence function, the coherent output power, the incoherent output 

power, the signal to noise ratio; 
• transfer functions. 

In order to decrease the undesired effects caused by the finiteness of observation 
intervals, you may use weighting functions. The WinPOS package contains the 
following weighting functions: 

• the rectangular function (no weighting function); 
• the Henning function: 

W(n)=0.5⋅(1-cos(2πn/N)),  n=0,...,N-1; 
• the Blackman-Harris function: 
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W(n)=A
0
-A

1
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2
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3
cos(3⋅2πn/N), n=0,...,N-1, 

where N is the number of discrete points within the process being weighted, 
A

0
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1
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• the triangular function: 
2 , : 0,1,..., ;2( )

( ), : 1,..., 12

n Nfor nNW n
NW N n for n N

 ⋅ == 
− = + −

 

• the Flat Top function: 
W(n)=1-A0⋅cos(2πn/N)+A1⋅cos(2⋅2πn/N)-A2⋅cos(3⋅2πn/N)+A3⋅cos(4⋅2πn/N),  
n=0,...,N-1, A

0
=1.93; A

1
=1.29; A

2
 =0.388; A

3
=0.0322; 

More details about the choice of the weighting function for use are presented in 
Appendix B Recommendations to the processing algorithm application. 

The spectrum 

The discrete Fourier transformation for the {x(n),n=0,...N-1} process sample is given 
by the following formula {x(n),n=0,...N-1}: 

1

0

1 2( ) exp
−

=

⋅ ⋅ ⋅ = ⋅ ⋅ − ⋅ 
 

∑
N

n
n

k nF k x j
N N

π  

Based on the discrete Fourier transformation F(k), a set of characteristics is 
determined. The type of a characteristic and a set of parameters for its determination 
are specified from the left part of the algorithm configuration window of the 
WinPOS program, while some of the parameters are set automatically. The 
"realization" term corresponds to the "portions" term in the WinPOS package. 

The power spectrum 

This characteristic is determined by averaging over M realizations and is measured 
in squared units: 

22 '
2

0 0 0

1 1 1 1( ) ( ) ( ) ( )
M M M

PS PSj j j
j j j

G k G k F k F k
M M M N= = =

= ⋅ = ⋅ = ⋅ ⋅∑ ∑ ∑
,where: 

'1( ) ( )= ⋅j jF k F k
N . 

When calculating the one-sided power spectrum (the one implemented in the 
WinPOS package), with the use if weighting windows, we have to introduce the 
following correcting factors: 

G'PS(k)= 2⋅Kn⋅GPS(k)/Kcpgf, where 2 shows that we are calculating the one-
sided power spectrum,  
 Kn = 1 for effective values, Kn  = 2 for peak values,  

Kcpgf is the coherent power gain factor (equal to the coherent gain factor 
squared) depending on the weighting function chosen, which is determined from the 
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table (see Appendix B Recommendations to the processing algorithm application), 
and is automatically accounted for in the WinPOS package. 

The power spectral density  

This characteristic is determined as the average over M realizations and is measured 
in squared units/Hz: 1( ) ( )PSD PSG k G k

f
= ⋅
∆

 

For the one-sided power spectral density, when the weighting functions are used, the 
formula looks as follows: 

 '
' ( )( ) PS
PSD

G kG k
f β

=
∆ ⋅

,  where β  is the equivalent noise band, 

the correction factor associated with the use of weighting functions, which is 
automatically accounted for in the package; ∆f is the sampling frequency. 

The energy spectral density 
The averaging is performed over M realizations and the characteristic is measured in 
squared units*seconds/Hz: 
 

0 0

1 1( ) ( ) ( ) ( )
M M

ESD ESDj PSDj PSD
j j

G k G k G k T G k T
M M= =

= ⋅ = ⋅ ⋅ = ⋅∑ ∑  

For the one-sided energy spectral density, taking into account the weighting 
windows: 

' '( ) ( )ESD PSDG k G k T= ⋅ . Here and above T is the observation interval. 

The amplitude spectrum (the RMS value) 

This characteristic is determined through the power spectrum and is measured in 
units: ( ) ( )A PSG k G k=  

For the one-sided amplitude spectrum, when the weighting windows are used, the 
formula becomes: ' '( ) ( )A PSG k G k=  

The complex spectrum  
The spectrum calculated as a complex measure, may be presented in one of the 
following two forms: 

• as the real and the imaginary part: 
 '

0 0

1 1 1Re ( ) Re ( ) Re ( )
= =

= ⋅ = ⋅ ⋅∑ ∑
M M

j j
j j

F k F k F k
M M N

 

 '

0 0

1 1 1Im ( ) Im ( ) Im ( )
= =

= ⋅ = ⋅ ⋅∑ ∑
M M

j j
j j

F k F k F k
M M N

 

• as the module and the phase: 
 2 2Mod ( ) ( ) (Re ( )) (Im ( ))= = +F k F k F k F k  
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 Im ( )Fas ( ) ( )
Re ( )

=
F kF k arctg
F k

 

Cross spectral characteristics 
The cross spectral characteristics for the a(t) and b(t) input processes are determined 
based on the momentary spectra A(f) and B(f), and the cross spectrum G

AB
(f). 

{ }
0

( ) ( ) exp 2 d= ⋅ −∫
T

A f a t j f t tπ ; { }
0

( ) ( ) exp 2 d= ⋅ −∫
T

B f b t j f t tπ  

In discrete form : 
1

0

2 1( ) ( exp ) ( )
N

n dft
n ref

knA k a j t À k
N F
π−

=

 = ⋅ − ⋅ ⋅∆ = ⋅ 
 

∑ ;  1( ) ( )dft
ref

B k B k
F

= ⋅  

The cross spectrum is determined by the momentary spectra A(f) and B(f), and is 
given by the following expression: 

S
AB

(k)= A*(k)⋅B(k), where “*“ is the complex conjugation sign. 

The relationships between one-sided and two-sided characteristics are established by 
the following expression: 

2 ( ), : 0
( ) ( ), : 0

0, : 0

AB

AB AB

S f for f
G f S f for f

for f

⋅ >
= =
 <

 

Similarly for the G
AA

(f) and G
BB

(f) auto spectra, where  
 S

AA
(k) = A*(k)⋅A(k)   and S

BB
(k) = B*(k)⋅B(k) . 

Everywhere below it is assumed, that the cross spectrum estimates, and the auto 
spectra estimates are those averaged over M realizations. 

The cross spectrum 
This characteristic is a complex value that may be represented in one of the 
following two ways: 

• as the real and the imaginary part (the co-spectrum, and the quad-
spectrum): 

 
0

2Re ( ) Re( ( ))
=

= ⋅∑
M

AB ABj
j

G k S k
M

 

 
0

2Im ( ) Im( ( ))
=

= ⋅∑
M

AB ABj
j

G k S k
M

 

• as the module and the phase: 
 Mod ( ) 2 ( ) ,

Im ( )Fas ( ) ( )
Re ( )

= ⋅

=

AB AB

AB
AB

AB

G k S k
S kG k arctg
S k
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The cross power spectral density 
The characteristic is measured in squared units /Hz: 

1( ) ( )psdÀÂ ABG k G k
T

= ⋅  

When the weighting windows are used, we have to introduce the correction factors, 
and the formula becomes: 
 G'psdAB

(k)= GpsdAB
(k)/(K

cpgf
⋅β) 

 where: K
cpgf

- is the coherent signal power gain factor; 
 β -  is the equivalent noise band width. 

The coherence function, and the incoherence function 
The coherence function is determined on the basis of the intrinsic spectra and the 
cross spectrum of the signals und investigation, according to the following formula: 

 2
2 ( )
( ) ,

( ) ( )
=

⋅
AB

AA BB

G k
k

G k G k
ν  

Note: the coherence function is determined on the basis of the averaged functions, and is the case of a 
single isolated estimate has unit values. 

The incoherence function is determined as 21 ( )− kν . 

The coherent output power. The incoherent output power 

The coherent output power is determined on the basis of the coherence function, and 
shows the measured (output) signal G

BB
(f) intrinsic spectrum share, which is 

perfectly coherent with a certain (input) signal represented by the function a(t) and 
the intrinsic spectrum G

AA
(f). 

The mathematical expression of this characteristic is as follows:
 2COP( ) ( ) ( )= ⋅ BBk k G kν .  

The incoherent output power expression becomes: 2NCOP( ) (1 ( )) ( )= − ⋅ BBk k G kν  

The signal to noise ratio 
The signal to noise ratio is determined on the basis of the coherence function using 
the following formula: 2

2

( )( )
1 ( )

=
−

kS kN k
ν
ν

 

The Transfer function 
Two complex frequency response characteristics of the system are determined, 
which are principally different from each other: 

1
( )( )
( )

= AB

AA

S kH k
S k

 and 
2

( )( )
( )

= BB

BA

S kH k
S k

. 
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Filtering 
The filtering subsystem implements digital recursive filtering, and is based on the 
consecutive connection of second order canonical links. 

Y
n
 = B

0
⋅Y

n-2
+B

1
⋅Y

n-1
+A

0
⋅X

n-2
+A

1
⋅X

n-1
+A

2
⋅X

n
, where: Y

n
 - is the filtered array, X

n
 - 

is the source array, B
0 

, B
1 

, A
0 

, A
1 

, A
2 - are filtering factors calculated according to the 

specified characteristics. 

The transfer function for the recursive set is: 
 2 1

0 1 2
2 1

0 1

( )
1

− −

− −

⋅ + ⋅ +
=

⋅ + ⋅ +
A Z A Z AH Z
B Z B Z

 

The following notes should be treated as recommended suggestions. In order to 
avoid obtaining periodic processes of great length you should take care that the 
following condition is met: 

2 100s

co

F
F

< <  , where Fco - is the filters cutoff frequency, Fs - is the sampling 
frequency. 

Thus, for example, the 12-th order filter will have no more that 700 periodic process 
points. 

If, for example, 2 50S

co

F
F

< < , then we may guarantee that the maximum length of the 

periodic process will not exceed 350 points. 

Median filtering 
The median filter cancels impulse noise with duration less than ½ of the aperture 
width.  

A certain number of sequential points, equal to the filter aperture width, is selected 
from the signal Further this sequence is sorted to select the average value (the value 
number N/2+1, where N - the aperture width) called a median. If the median at this 
point is different from the source signal value greater than at the threshold value, the 
median value is written to the respective point of the resulting signal; otherwise the 
source signal value is written. The filter window is offset at one value towards the 
signal end, and the process is repeated.  

The probabilistic characteristics 
For the sequence of points {xn, n=0,...N-1} evaluations of the abovementioned 
characteristics are performed according to the formulas given below.  
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The mathematical expectation (the mean value) 
1

0

1 −

=

= ⋅∑
N

x n
n

m x
N

 

Dispersion (Variance) 
Characterizes the scattering of the random value around 
its mathematical expectation value. 

1
2

0

1 ( )
1

−

=

= ⋅ −
− ∑

N

x n x
n

D x m
N

 

Root mean square error 
Characterized dispersion, but is measured in the same 
units as the random value. 

=x xDσ  

Skewness 
Is used to measure the asymmetry of the distribution. If 
the distribution is symmetrical around its mathematical 
expectation value, then the skewness is equal to 0. 

1
3

3
0

1 ( )
−

=

= ⋅ −
⋅ ∑

N

n x
nx

Sk x m
N σ

 

Kurtosis 
Characterizes the steepness (peakedness or 
flattoppedness) of the distribution. 

1
4

4
0

1 ( ) 3
−

=

= ⋅ − −
⋅ ∑

N

x n x
nx

E x m
N σ

 

Note: The kurtosis value for normal distribution is equal to 0. Curves that are more peaked as compared 
to the normal distribution curve, have positive kurtosis values. Curves that have more flat tops than the 
normal distribution curve, have negative kurtosis values. 
 

Probability density 
The probability density estimate is constructed either by using nuclear estimations 
with the square nuclear function, or as a histogram. 

The nuclear estimations method 

The PFD estimation using the nuclear estimations method with the square nuclear 
function is given be the following formula 

 2

2

( )1( ) exp
2

m k
m

x xP x
N h h

 −
= ⋅ − ⋅ ⋅ 

∑  

where:  {Xk } - is the process for which the PFD is constructed; 
  N  is the number of points in the source process, for which the PFD 
is estimated;  

h = σN-1/5;  
  σ  is the root mean square of the process; 
  M is the number of points in the estimated PFD function (selected 
by the user). 
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The histogram method 

The basis for the construction of the histogram is the so-called "statistical array": the 
whole range of the values of a random variable X is divided into intervals or "stages" 
(the number of these intervals is specified by the user); then the number of points mi 
falling within each i-th stage is calculated (if a point falls exactly between two 
stages, then 0.5 is added to the mi numbers of both stages), the resulting value is 
divided by the number of observations n, and so the frequency corresponding to the 
i-th stage is determined: p*i=mi /n . 

The histogram itself is plotted in the following way. The stages are plotted along the 
X axis, and a rectangle with an area equal to the frequency of the stage is drawn with 
the stage as the basis. In order to plot the histogram we divide the frequency of each 
stage by its length, and the resulting value is taken as the height of the rectangle. If 
we increase the amount of source data, and the number of stages, then the histogram 
will approach the frequency distribution graph for X. 
Note: It is recommended to have at least 5-10 observations within each stage. If the number of 
observations in some stages is small (1-2), then these stages should be merged. 

Taking the logarithm 
Taking the logarithm of the data is done according to the following formula: 

 
lg 10log ( )= ⋅

ref

UU k
U

, [dB], 

where k is a factor, which takes one of the two values (10 or 20) depending 
on the characteristic (for example, the value of this factor for the amplitude spectrum 
is equal to 20, and for the power the value of this factor is equal to 10); 

Uref - is a reference value. In the WinPOS package this parameter s 
specified by the user, either as a specific number, or by selecting the maximum 
value form the array, of which we are taking the logarithm. 

Autocorrelation 
To calculate the estimate of the random sequence normalized correlation function, 
which has the properties of stationarity and ergodicity, we use the following 
formulas: 

a) the correlation function estimate: 
0 0

1

1( ) ( ) ( ), k= 0,1,2,...,m
N k

x
j

K k x j x j k
N k

−

=

= ⋅ ⋅ +
− ∑  

where:  {x°(j)} is the centered realization; 



WinPOS. User’s Guide 

 152

  m is the maximum number of step (this parameter is specified by 
the use in the WinPOS package);  
  N is the number elements is the sequence. 
b) the normalized correlation function estimate: 

ρx(k) = Kx(k)/Dx, where Dx is the dispersion (variance). 

Cross-correlation 
The cross correlation function estimate is calculated on the basis of the following 
formulas: 

a) the cross correlation function: 
0 0

1

1( ) ( ) ( ), k= 0,1,2,...,m
N k

xy
j

K k x j y j k
N k

−

=

= ⋅ ⋅ +
− ∑  

 where {x°(j)}, {y°(j)}  are the centered realizations, 
b) the normalized cross correlation function: 
 ρxy(k) = Kxy(k)/(σx⋅σy), 

where σx, σy are root mean squares of the corresponding processes. 

Derivation 
The WinPOS implements the following three numeric differentiation algorithms: 

• "the three-point algorithm", which uses the following formula to calculate 
the first derivative: 

 '
1 1

1 ( )
2 + −= ⋅ −
⋅∆n n nY Y Y

x
 

• "the five-point algorithm": 
'

2 2 1 1
1 [( ) 8 ( )]

12 − + − += ⋅ − − ⋅ −
⋅∆n n n n nY Y Y Y Y

x
 

Integration 
Calculating the definite integral 

We used the trapezoid method to calculate a definite integral within a given range of 
values: 
 2

0 1
1

0.5 0.5
−

−
=

= ⋅ + + ⋅∑
N

n N
n

S Y Y Y
 

The numeric solution of the Cauchy problem 

The WinPOS package offers you three methods of the numerical 
integration of the first order differential equation 

y'=f(x,y) 
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The starting condition y(x0)=y0 may be either specified by the user, or is 
automatically set equal to 0. To exclude the zero-frequency component from the 
results, we have to center the process. 

The Eiler method consists of step-by step application of the third order formulas: 

 yn+1= yn + 0.5·(3·fn - fn-1)·∆x  

The Hamming method without modification (the fourth order formula), when the 
first three points are calculated using the Eiler method: 

1 3 1 2
4 (2 2 )
3+ − − −= + ⋅ ⋅ − + ⋅ ⋅∆pred

n n n n ny y f f f x  

1 2 1 1
1 3(9 ) ( 2 2 )
8 8+ − + −= ⋅ ⋅ − + ⋅ + ⋅ − ⋅ ⋅∆corr

n n n n n ny y y f f f x  

1 1 1 1
9 ( )

121+ + + += − ⋅ −corr corr pred
n n n ny y y y  

The RC-circuit method: 

the numeric analog of the RC-circuit (the first order low-pass filter) is given by the 
following formula yn+1= yn -yn/M+ fn+1·∆x, where M is the number of averaging 
points for the RC-circuit (specified by the user).  

The following formulas may be used to determine the number of averaging points 

M=Fs/(2πFb) or M=RC/∆t 

where:  Fs is the sampling frequency, 
  Fb is the cutoff frequency of the equivalent low-pass filter;  
  RC is the RC-circuit constant value, 
  ∆t is the sampling period. 

Vibro. 

This method uses a method of a RC-chain, but preliminary carries out a high-
frequency filtering in the set strip of frequencies that allows to adapt algorithm for 
conditions of measurement of vibrations.  

Normalization 
Normalization of a signal is made when it is necessary that resulting values of a 
signal changed in strictly certain limits. Procedure of normalization is reduced to 
multiplication of each value of a signal to some factor so, values of a signal do not 
exceed preset values. 

 0

max

= ⋅nor
i i

YY Y
Y

 

 

, where: Y0 is the set (demanded) maximal value; Ymax is the 
maximal measured value; Yi  is current value of a signal. 
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Centering 
The centering is carried out with the purpose cut-off a constant component of a 
signal: where Y  is the mathematical expectation (the mean value). 

Hilbert transformation. Envelope calculation  
To obtain a Hilbert transformation of the input signal it is necessary to execute the 
direct Fourier transformation:  

 

1

0

1 2( ) ( ) exp
N

n

k nF k f n j
N N

π−

=

⋅ ⋅ ⋅ = ⋅ ⋅ − ⋅ 
 

∑
 

The obtained spectrum is transformed to the genus: 

 

2 ( ),
( ) ( ),

0,

F k
Z k F k

⋅
= 

  

The analytical signal is obtain by the Z(k) spectrum inverse Fourier transformation:  

( ) ( ) ( )z n f n j f n= + ⋅ , where ( )f n  - Hilbert transformation of the input signal ( )f n . 

The signal envelope is determined by the expression:  
2 2( ) ( )z n f f n= +  

Envelope calculation using the peak detector method 
The input process must conform to the following conditions: the process must be 
centered, and must have a sufficiently narrow band to obtain reliable results. The 
algorithm for the calculation of the envelope in discrete form: 

1
1

n n
n n

x y
y y

K
−

−

−
′ = + ,  

,  
,  

n n n
n

n n n

y when y x
y

x when y x
′ ′ >

=  ′ ≤

 

 
where K=RC/∆t is the RC-averaging factor, 
∆t is the sampling period. 

The calculation of the octave spectrum 
The WinPOS program calculates octave, third- and 1/12-octave spectra by the two 
methods. 

The first method is based on recursive filtering, and is implemented according to 
the classical scheme: band-pass filter – quadratic detector – integrator, this scheme is 

at k=1,...,N/2-1; 

at k=0; 

at k=N/2,...,N-1 
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based on the mathematical definitions of the power spectrum. The band-pass filter in 
this scheme extracts the spectral components, which lie within the required band, 
and then the filtered signal is squared and averaged. To obtain a conditioned 
spectrum the result is divided by the current octave band width or octave portion. 

Thus, the third-octave power spectrum is calculated according to following formula: 
 0

0

(1 6)
2 2

1 3 0
(1 6)

1 1( ) ( ( )) d ( )d
+

−

= ⋅ = ⋅∫ ∫
oct

oct

f

f

A f L X t t A f t
T Tπ

 

 where:  T is the analysis period; 
  X(t) is the input signal; 
  L(X(t)) is the recursive band-pass filtering operator. 

The recursive filtering algorithms are applied here since they represent the most 
adequate analysis procedures with the same relative width of the elementary band. 
When using the third-octave analysis the ratio of the right and left boundaries of the 
elementary band is equal to 2

1/3
.  

There are two main filter precision requirements – the filter FRF (frequency-
response function) and deviation of the effective bandwidth from the nominal which 
should meet GOST 17168. The filters used in the WinPOS program meet the first 
class precision under GOST 17168-82.  (These are filters for precise laboratory and 
full-scale test application).  
Figure A.1 gives the frequency-response functions of the WinPOS octave and third-
octave filters and first class precision filters under GOST 17168-82 (see Table A.1).  
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Fig. A.1 FRF of Octave and third-octave WinPOS Filters and First Class Filters 
 

Table A.1 Parameters of First Class Precision Filters under GOST 17168-82 

Octave filter, 1st class precision Third-octave filter, 1st class precision 
Rel. freq, f / fm Attenuation, dB Rel. freq, f / fm Attenuation, dB 

0.125 < -65 0.2 < -75.0 
0.25 < -50 0.25 < -68.0 
0.5 < -23 0.5 < -45.0 

0.7071 От -6.0 до 0.5 0.7937 < -14.0 
0.8409 От -1.0 до 0.5 0.8909 От -6.0 до 0.5 
1.0000 От -1.0 до 0.5 0.9439 От -1.0 до 0.5 
1.1892 От -1.0 до 0.5 1.0000 От -0.5 до 0.5 
1.4142 От -6.0 до 0.5 1.0595 От -1.0 до 0.5 

2 < -23 1.1225 От -6.0 до 0.5 
4 < -50 1.2599 < -14.0 
8 < -65 2 < -45.0 
  4 < -68.0 
  5 < -75.0 

Table A.2 shows the deviation of the effective bandwidth from the nominal value of 
the bandwidth. The filter values with minimum errors are presented.  

Table A.2.  Deviation of Effective Bandwidth 

Efficient bandwidth deviation, % 
GOST 17168-82 Filter type Nominal value 
1 class 2 class 

Ordinary precision High precision 

Octave 0.7071 8 10 6.4 4.0 
Third-octave 0.2316 8 10 10.3 3.8 
1/12-octave 0.0576 8 10 7.7 4.9 

 

The second method is implemented applying the fast Fourier transformation; its 
description is given above. In the given case the GOST requirements are met not 
fully - the fact justified by the lower steepness of the frequency response curve. The 
1/24 -octave spectrum is calculated by FFT method only. 

Figure A.2 shows the dependence of the results from the chosen method. 
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Fig. A.2. A third-octave logarithmic spectrum of the is a sine with the frequency of 25 Hz 

calculated by different methods 

In most cases, it is recommended to use the FFT method at a calculation of an octave 
spectrum. Using FFT a calculation is carried out more rapidly than a filtration, does 
not require a plenty of initial data and provides a high accuracy (-160 dB) on all 
interval of frequencies. It is expedient to use a method of a filtration with filters of a 
high accuracy, if it is necessary to receive the maximal accuracy in the field of high 
frequencies and the initial signal has the greater length. The more long an initial 
signal, the more widely a range of frequencies on which a high accuracy (250 dB) is 
reached. Filters of usual accuracy allow to calculate a spectrum on a signal of a 
smaller length, provide an accuracy similar to the high -precision filters in the field 
of high frequencies, but for all that these filters have a more gentle AFC. Filters of 
usual accuracy allow receiving the values of a spectrum in low-frequency area. The 
more the length of an initial signal, the further to the low-frequency area the range of 
frequencies of a spectrum amplifies.  

The central and boundary frequencies 

The central frequencies are calculated by the following formulas: 
For octave and third-octave spectrums: fm = Gx/b *fr , 
For1/12-octave and 1/24-octave spectrums: fm = G (2x+1) /2b *fr , where 
G – an octave  coefficient (equals 2 or 1.995, depending on  the settings), 
fr -  a basic frequency, 1000kHz, b - a part of the filter octave (1, 3, 12 or 24 
accordingly), x – a number of the  octave or  an octave part.  

Boundary frequencies are calculated by the formulas: 

f1 = G-1/2b *fm , f2 = G+1/2b *fm 
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One should bear in mind that the analyzed frequency band is limited by the Nyquist 
frequency (Fs/2). For example for Fs = 1 kHz we get a band of up to 450Hz (see 
Table A3). 
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Table A. 3. 

The values of the central frequencies of the octave and third-octave spectrums. 

Octave third-octave Octave third-octave Octave third-octave 
 160000  630  2.5 
125000 125000 500 500 2 2 
 100000  400  1.6 
 80000  315  1.25 
63000 63000 250 250 1 1 
 50000  200  0.8 
 40000  160  0.63 
31500 31500 125 125 0.5 0.5 
 25000  100  0.4 
 20000  80  0.315 
16000 16000 63 63 0.25 0.25 
 12500  50  0.2 
 10000  40  0.16 
8000 8000 31.5 31.5 0.125 0.125 
 6300  50  0.1 
 5000  20  0.08 
4000 4000 16 16 0.063 0.063 
 3150  12.5  0.05 
 2500  10  0.04 
2000 2000 8 8 0.0315 0.0315 
 1600  6.3  0.025 
 1250  5   
1000 1000 4 4   
 800  3.15   
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Appendix B. Processing algorithm application 
guidelines  

(Methodical instructions) 
 

This chapter contains information concerning the practical application of 
characteristics in the analysis of signals. The information presented here is for 
reference purposes only, more detailed information may be obtained from the 
sources listed in the end of this Appendix. 

Practical signal analysis using the FFT algorithm 
One of the most important methods in the signal analysis field is the Fast Fourier 
Transformation (FFT) algorithm. The Fast Fourier Transformation algorithm allows 
you to determine a set of values and functions related to signal analysis, multi-
channel measurements, and the determination of such system characteristics as 
correlation functions, coherence, frequency responses, etc. One of the main 
advantages of the Fast Fourier Transformation-based analysis is the ability to 
preserve the phase information, and, consequently, the capability to perform simple 
forward and inverse transformations from the time domain to the frequency domain, 
and backwards. 

The limitations of the FFT method 

The inherent limitations of the FFT process arise essentially from the Discrete 
Fourier Transformation (DFT). These limitations are mainly based on the finite and 
discrete nature of the Discrete Fourier Transformation algorithm. The nature of these 
limitations will be made clearer if we look at the DFT as the result of the passing of 
the signal through a set of matched band-pass filters with the central frequencies 
equal to: 

 fi=i⋅(fs/N) , where fs is the sampling frequency, and N is the number of FFT 
points. 

The analyzed signal component with a frequency fa, which is not equal the DFT 
spectral line (bin) frequency will appear at the neighboring spectral line, and the 
amplitude values will be measured with some inaccuracies (see Figure B.1). 
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Figure B.1. The DFT as a set of matched and-pass filters 

The hashing effect 

The first operation in digital analysis is the sampling of time analysis data. The 
discrete presentation theorem formulated by Shannon states than the time function in 
its discrete representation must not contain any component with the frequencies 
higher than one-half of the sampling frequency (the Nyquist frequency). Otherwise 
the components of the spectrum G(f) of the source signal g(t) having the frequencies 
exceeding the Nyquist frequency, are incorrectly interpreted and represented as 
components with lower frequencies (the "hashing" effect). 

 
Recommendations: when analyzing stationary ad other signals with exactly determined 
frequency ranges, the problems arising from the hashing effect are usually eradicated by 
applying analog low-pass filters. 

Note: In the Bruel&Kjaer equipment this problem is solved by using low-pass filters with a sharp cut-off 
frequency equal to ≈80% of the Nyquist frequency. In order to effectively block the components with 
frequencies exceeding the working range, the slope of the amplitude-frequency response of the low-pass 
filter is set to about 120dB/octave. The indicator and the external equipment receive only those results, 
which are not affected by the presence of the filter in any way. For example, when performing a 
transformation using 1024 discrete samples in the time domain, 512 frequency-domain components are 
calculated, but the indicator and the external equipment receive only 400 frequency components. 

The weighting effect 

The next operation in our analysis is the limiting of the signal within the time 
domain (the final realization). This operation is equivalent to multiplication by the 
rectangular weighting function (the time window). The result of the application of 
the weighting function is relatively trivial, when working with spectra containing no 
marked peaks. But if the spectra contain discrete components, then, after the 
weighting function is applied, those components are replaced by the spectrum of the 
weighting function. The weighting window behaves as a filter (with the 
corresponding equivalent noise band and KKG characteristics, see Table B.1), and the 
signal power output by this filter is proportional to the power of the input signal 
harmonics within the bandwidth of the filter. This effect is known as "the weighting 
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effect", "the framing effect", "the sideband formation effect", or "the leakage effect" 
(the power inherent to the discrete component appears within the sidebands as a 
result if the leakage). 

 
Recommendations: The rectangular weighting function (or no weighting function) is not an 
optimal option when analyzing stationary signals, particularly when analyzing signals 
containing discrete components, because of the potential discontinuity at the connected 
ends of the realization being processed. 

The function that is optimal for stationary signal analysis must have zero values at 
both ends, and smoothly changing values within the specified length of the 
realization of the signal being analyzed. See the corresponding section on the 
selection of the weighting function. 

The fence effect 

The fence effect is associated with the discrete representation of continuous 
frequency spectra (see comments to Figure B.1). This effect can occur not only 
when using the FFT-based analysis, but also in situations where discrete (non-
adjusting) band-pass filters are used, e.g. in octave or 1/3 octave analysis. This 
effect, practically, consist of the following: while the frequency of a certain 
component of the signal being analyzed is not equal to the frequency of the 
corresponding spectral line, the amplitude and frequency values inherent to this 
component will be measured with some systematic inaccuracies (the frequency 
value will correspond to the value of the frequency nearest to the higher frequencies 
of the spectral line).  It is possible to compensate for these inaccuracies when the 
accounted component is an isolated and stable frequency component. 

The FFT with increasing frequency scale 

The Fast Fourier Transformation with increasing frequency scale is used when it is 
required to improve the frequency resolution within a certain spectrum band of the 
signal being analyzed. You may use two methods, which differ from each other: 

• "the real-time frequency scale increase", employing the lowering of the 
sampling frequency fs; 

• "the lossless frequency scale increase", employing the increasing of the 
length of the realization N. 

The real-time frequency scale increase 
The basic principles of this method are as follows: 

• multiply the time signal g(t) by the unit vector rotating with the frequency -
fk , the zero frequency value is placed at the fk frequency; 
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• the modified complex number signal is filtered by a digital low-pass filter 
to eliminate all components, whose inherent frequencies do not lie within 
the narrow band around the fk frequency. When performing the filtering, the 
part of the signal where hashing may have occurred as a result of the shift, 
is also eliminated. 

• the discrete value sampling process is repeated, with the new sampling 
frequency (for the ten times frequency scale increase, the sampling 
frequency must be increased as 20:1); 

• based on the complex discrete values obtained in this way, and using the 
Fast Fourier Transformation, we determine the spectrum with the increased 
frequency scale. 

The lossless frequency scale increase 

Using this method, we may account for a bigger number of discrete values during 
the sampling process, by repeating the transformation process that used a lower 
number of discrete values. The idea behind this method is as follows: 

• the source realization, consisting of a big number of discrete values, is 
subdivided into n realizations; 

• the shortened realizations are cyclically subjected to the Fast Fourier 
Transformation; 

• since the Discrete Fourier Transformation is linear, the sum of the 
transformations of the shortened realizations id equal to the transformation 
of the sum of these realizations. 

The sum of the shortened realizations is identical to the source realizations after 
compensation for slight shifts of some of the shortened realizations within the time 
domain. Within the frequency domain, this compensation consists of a linear change 
of the phase angle. 
Note: This method has high requirements to the memory storing the discrete values of the time signal. 
The maximum possible value of the frequency scale increase factor is often limited by the amount of this 
memory. 

Examples of the analysis based on the FFT 

This section is presented as a reference. 

The main frequency range during the analysis spans from 0 Hz to the Nyquist 
frequency, and does not depend upon the number of discrete values constituting the 
realization of the signal being analyzed. The Nyquist frequency f

N
 is related to the 

sampling frequency fs as follows: f
N
=fs/2 
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The real working frequency range is limited from above by the cutoff frequency 
value of the low-pass filter used.  

The number of the spectral lines when performing the analysis within the main 
frequency range depends upon the number of the discrete values N and is usually 
equal to N/2 within the range having the upper frequency boundary set by the 
Nyquist frequency.  

The frequency corresponding to the i-the spectral component (harmonic), is: 

 fi=i⋅(fs/N) , where  fs is the sampling frequency. 

The frequency resolution (∆f) or the interval between the neighboring spectral lines 
while performing the analysis is determined by the following relationship: 

 ∆f=1/T=1/(N⋅∆t)=fs/N, 

where T is the length of the transformed realization of the signal being analyzed; 

 N is the input number of discrete values (the size of the transformation); 

 ∆t is the sampling step; 

 fs is the sampling frequency. 

The frequency band width (B) in this analysis is usually bigger than the frequency 
resolution, and depends upon the weighting function used in within the time domain: 

 B=∆f⋅KENB, where K
ENB

 is the equivalent noise band factor 
corresponding to the selected weighting. 
 

Using weighting windows in harmonic analysis 
The finiteness of the observed time interval and the selection of the orthogonal 
trigonometric basis (either continuous or discrete) within this interval lead to the 
appearance of undesired dithering or leakage of spectral components.  

The windows (weighting functions) are used to decrease the dithering of spectral 
components. The impact of a weighting window upon the data array consists of the 
decrease of the order of the break at the periodic continuation boundary by using the 
smoothing effect. The window behaves as a filter, the output signal power of which 
is proportional to the power of the input signal harmonics within the filter bandwidth 
(see Figure B.2). The weighting windows affect many harmonic analysis factors, 
such as the detectability, the resolution, the dynamic range, the degree of reliability, 
and the ease of implementation if calculation operations. In order to be able to make 
the correct selection of a weighting function, lets look at the most significant 
weighting function parameters. 
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Figure B.2. The equivalent noise band of a window 

The equivalent noise band (ENB) 

Because of the presence of wide-band noise falling into the window bandwidth, the 
amplitude estimate for a specified frequency becomes shifted. We may minimize the 
cumulative noise using a narrow-band window. A convenient measure of the 
bandwidth is its equivalent noise band (ENB), which represents the bandwidth of a 
rectangular filter with the same maximum gain, which accumulates the same power 
as the window, see Figure B.2). 

The ENB values for the windows employed within the WinPOS package are given 
in Table B.1. The ENB calculation formula is as follows: 

2

2

( )

[ ( )]
n

n

w nT
ENB

w nT
=
∑
∑

  
, where w(nT) are the discrete values of the 
weighting function. 

Note: The ENB is normalized to N0 /T, where: N0 is the power of the noise within a unit bandwidth; T is 
the observation time interval. 

The transformation gain (TG) 

If we use weighting windows for a constant signal in the absence of any noise, the 
spectral component will be proportional to the input amplitude. The same is true for 
the mathematical expectation of this component when noise is present. This effect is 
maximal for a rectangular window. The decrease of the proportionality factor for 
one or another window in relation to the rectangular window characterizes the 
spectral component amplitude estimate error (shift). Table B.1 shows the values of 
coherent gain for windows (the proportionality factor), normalized with relation to 
the maximum possible value of N (where N is the number of points within the 
window). The transformation grain is determined as the quotient of the output and 
input signal to noise ratios, and is the reciprocal of the normalized ENB of the 
window. So, increasing the ENB leads to the decrease of the TG. 

F(w)2 

0 

Equivalent noise 
band 

Maximum gain,  
 noise band = F(0)2 
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The correlation of overlapping areas 

Let us consider the case of the division of the input sequence into several sequences 
of smaller length. The number of point N of the sequence is selected in such a way, 
as to provide the required spectral resolution, which is defined by the following 
formula: 

∆ = ⋅ Sff
N

β  

 

, where fs  is the sampling frequency; 
β - is the ratio characterizing the increase of the bandwidth of 
the selected window (is usually selected equal to the ENB of the 
window measured in bins, see Table B.1). 

In order to avoid losing the data lying close to interval boundaries (when the FFT 
affects the weighted data), we usually apply this transformation to the overlapping 
areas of the sequence. The overlapping degree is selected, in most cases, to be equal 
to 50 % or 75 %. In this case some questions arise concerning the degree of the 
correlation of random signal components in the transformations of two neighboring 
parts of the sequence, and, as a question, concerning the decrease of the dispersion 
(variance) after averaging the correlated measurements. The correlation factor 
values (when the noise spectrum is relatively flat within the bandwidth of the 
window) for each window used in the WinPOS package with 50 % and 75% 
overlaps are given in Table B.1. 

Now let us discuss the dispersion. If we average K independent values of an ergodic 
random variable, then the dispersion of the average is related to the dispersion of 
individual measurements by the following formula: 

2

2

1average

measured K
σ
σ

=  

When averaging correlated measurements: 

• for the 50 % overlap: 
2

2 2
2 2

1 2[1 2 (0,5)] [ (0,5)]average

measured

c c
K K

σ
σ

= ⋅ + − ⋅  

• for the 75 % overlap: 
2

2 2 2 2 2 2
2 2

1 2[1 2 (0,75) 2 (0,5) 2 (0,25)] [ (0,75) 2 (0,5) 3 (0,25)]average

measured

c c c c c c
K K

σ
σ

= ⋅ + + + − ⋅ + +

where c2(0.75), c2(0.5) and c2(0.25) are the correlation factors for the 75 %, 50 %, 
and 25 % overlaps. The negative terms describe the border effects of the averaging, 
when K > 10 we may omit them. For good window c2 (0.25)<<1, and may also be 
omitted. 
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Maximum transformation losses 

Maximum transformation losses arise from the maximum losses related to the 
parasite amplitude modulation of the spectrum (the fence effect) for the given 
window (in dB), and the transformation losses related to the shape of the window. 
The level of maximum losses always lies between 3.0 and 4.3 dB (windows having 
this value >3.8 dB are inadequate). 

Detection of two near tones 

The leakage of spectral components leads to the shift of amplitude estimates, and the 
positions of the harmonic components of the signal. This effect is the most 
troublesome when detecting weak signals in the presence of strong noises having a 
near frequency. To decrease the undesired consequences, the side-band amplitude 
far enough from the main band of the frequency range of the window must be small, 
and the transition from the central band to the low-amplitude side-bands must be 
very fast. The maximum side-band values (relative to the main band), and the values 
of the asymptotical decrease speed of the side-bands are given in Table B.1. 

Conclusions 

The applied window type is critically important when detecting a tone in the 
presence of other nearby tones.  In order to maximize the dynamic range of 
detectable signals, the transformation of the window must have a narrow main band, 
and very low levels of side-bands. 

The Bruel&Kjaer equipment gives preference to the Henning function. 

The WinPOS package implements the following weighting windows: triangular, 
Henning, Blackman-Harris, and Flat-Top Figure B.3 shows the spectra (the results 
of the Discrete Fourier Transformation) of the cos-function weighted within the time 
domain by the rectangular, Henning, Blackman-Harris, and Flat Top functions 
respectively. The frequency of this cos-function lies within the interval of two 
neighboring spectral lines (∆X=0.125, f=15.0625). 

 

Rectangular

Hanning

Flat-Top

Blackman-Harris
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 Flat Top Henning Blackman-Harris Rectangular 
Y (dB) -0.016 -1.424 -0.856 -3.937 

X 15.000 15.000 15.000 15.000 

Figure B.3. The spectra of the weighted cos-function 

It is evident from Figure B.3. that the rectangular window has the narrowest main 
band (bandwidth), but at the same time this window has the highest side-band level, 
which leads to additional transformation losses (the parasite signal power increases, 
and the leakages of spectral components increase). The Blackman-Harris window 
has the lowest level of side-bands, but a wide bandwidth. Among the window 
shown, the Henning window has optimal characteristics, and the lowest 
transformation losses, which allows us to recommend it for use in virtual devices. 
The Flat Top function, having the widest bandwidth, leads to a significant decrease 
of the fence effect, and is used for the calibration of analyzing equipment with the 
help of a tonal signal with a frequency lying within the interval between two 
neighboring spectral lines. 

Table B.1  Main parameters of the windows 

 Here: ENB is the equivalent noise band (bin); 
KCG is the coherent gain factor; 
MSL is the maximum sideband level (dB); 
MAI is the maximum amplitude inaccuracy (dB); 
SBDS is the sideband decrease speed (dB/octave); 
OAC is the overlapping area correlation. 

The correlation analysis 
The autocorrelation function and the cross-correlation function 

The cross-correlation function Rab(τ) expresses the degree of statistical connection 
between two signals a(t) and b(t) depending on their  mutual shift (the delay 
parameter) τ  within the time domain 

The cross-correlation function for short duration signals is given by the following 
expression: 

 ( ) ( ) ( )d
∞

−∞

= ⋅ +∫abR a t b t tτ τ  

OAC (%) Window 
 

ENB 
(bin) 

KCG 
 

MSL 
(dB) 

MAI 
(dB) 

SBDS 
dB/octave 75 50 

Rectangular 1.0 1 -13 3.92 -6 75.0 50.0 
Blackman-Harris 2.0 0.36 -92 0.83 -6 46.0 3.8 
Henning 1.5 0.5 -32 1.42 -18 65.9 16.7 
Flat Top  3.77   -93 0.01    0   
Triangular  1.33 0.5  -27 1.82 -12 71.9 25.0 
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In case of stationary signals this function has to be slightly modified (a move from 
"energy" to "power"): 

 
2

2

1( ) lim ( ) ( )d
→∞

−

= ⋅ +∫
T

ab T
T

R a t b t t
T

τ τ
 

A special case of the cross-correlation function (when a(t)=b(t)) is the 
autocorrelation function Raa(τ). 

Practically, it is more convenient to use the normalized autocorrelation function: 

 ( )( )
(0)

= aa
aa

aa

R
R

τρ τ  

and the normalized cross-correlation function: 
 ( )( )

(0) (0)
=

⋅
ab

ab
ab aa

R
R R

τρ τ  

Based on the Fourier transformation and the convolution theorem, we may prove the 
relationships between the autocorrelation function Raa(τ) and the intrinsic spectrum 
Saa(f), and between the cross-correlation function Rab(τ) and the cross-spectrum 
Sab(f): 

 { }1( ) ( )−=aa aaR S fτ F   and  { }1( ) ( )−=ab abR S fτ F  

 

Main areas of practical application 

The cross correlation function 

a) Determining time delays 

The cross-correlation function Rab(τ) of the a(t) and b(t) signals, recorded at points 
A and B lying on  the propagation path, has a peak value, the position of which 
corresponds to the delay time τ, that is the time of the propagation between the A 
and B points. 
Note: it is assumed that the signals are wide-banded, and their propagation is non-dispersive (the 
propagation speed is independent of the frequency). When the propagation of a signal is dispersive, the 
we may either limit the frequency range band, assuming that the propagation speed within this band is 

constant, or use the cross-spectrum phase to determine the time delay 0 ( )fτ  : 

0( ) 2 ( )=AB f f fφ π τ  

b) Identification of propagation paths 
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When there are several propagation paths between the A and B points, the cross-
correlation function Rab(τ) for the signals a(t) and b(t) recorded at these points, has 
the corresponding number of peaks. The peaks corresponding to separate 
propagation paths are located at positions with inherent delay time values τn 
corresponding to propagation times along different paths n. The amplitudes of these 
peaks show the relative quality of those propagation paths. 
Note: it is assumed that the signals are wide-banded, and their propagation is non-dispersive (the 
propagation speed is independent of the frequency). 

It is often more appropriate to use envelopes (amplitudes) of the respective 
analytical signals, instead of using the real-valued normalized autocorrelation 
function ρaa(τ) and the normalized cross-correlation function ρab(τ) . The 
amplitude curve is smooth (due to the absence of maximum and minimum values, 
which are often present in the source characteristic), so it is possible to identify 
peaks (caused by reflections, for example), and to correctly determine their inherent 
amplitudes.  With the amplitude representation we may use logarithmic scale, and, 
therefore, enjoy the benefits of the expanded dynamic range and the enhanced 
resolution of presented results. 

c) Detecting signals masked by noise 

If the a(t) and  b(t) signals contain a common signal s(t) masked by noise, that is, if  
a(t)=s(t)+n(t) and b(t)=s(t)+m(t), and the n(t) and m(t) components do not correlate 
with each other, then the cross-correlation Rab(t) contains only information only 
about the correlated component s(t) of the a(t) and b(t) signals, and the shape of this 
function corresponds to the autocorrelation function Rss(t) inherent to the s(t) signal, 
which has absolutely no n(t) and m(t) noise components. 

The autocorrelation function 

a) Detecting echoes (reflections) in signals 

If a signal, a(t) contains an echo with time delay τ0 , then the autocorrelation 
function Raa(t) of this signal, beside the peak at τ=0 has a peak at τ=τ0. Moreover, 
the value of ρaa(τ0) shows the relative intensity of the echo present. This is true for 
wide-band signals, the frequency bandwidths of which are enough to provide narrow 
and separated peaks for the autocorrelation function. 

b) Detecting periodic signals in noise signals 

An autocorrelation function of a periodic signal is always a periodic function. The 
masking noise (the background noise) is usually a random signal, and the amplitude 
of its autocorrelation function decreases with the increase of time delay, and after 
some the amplitude takes on a zero value. Therefore, the autocorrelation function 
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may help to detect a periodic signal after the time required for the noise component 
to disappear. 
Note: 

1. The amplitude of the normalized autocorrelation function of the wide-band random signal (noise) 
decreases rapidly in conformance with the so-called law of the uncertainty of the functions related 
through the Fourier transformation.  This law sets the relationships between the bandwidth, ∆f of the 
intrinsic spectrum GAA(f), and the length, ∆t, of the corresponding autocorrelation function, Raa(t), in the 
form of  ∆f⋅∆t ≥1 

2. In order to detect a periodic signal containing several frequency components, it is often more 
appropriate to use the intrinsic spectrum, instead of the autocorrelation function. Based on the intrinsic 
spectrum, we may determine not only the frequencies, but also the amplitudes of separate components of 
the periodic signal masked by noise. However, if the amplitudes of these components are small compared 
to the level of the masking signal (the background noise), then it is required to perform the analysis with 
the increase of the frequency scale. 
 

The correlation factor and the coherence function 
When performing systems analysis involving the processing of input and output 
signals, it is required to determine or estimate the degree of linear interdependence 
of the signals being processed. 

The correlation factor 

The quantitative measure of the degree of statistical interdependence of two random 
variables, x and y, which may represent input and output signals of the system under 
investigation, is the correlation factor ρxy, the formula for which is as follows. 

 =
⋅
xy

xy
x y

σ
ρ

σ σ
, where the covariance: [( ) ( )]= − ⋅ −xy x yE x yσ µ µ , and the 

standard deviations, σx and σу, of the x and y variables are determined by the 
following two expressions: 

 2[( ) ]= −x xE xσ µ   and 2[( ) ]= −y yE yσ µ  

The amplitude of the correlation factor, xyρ  lies between 0 and 1, and 

1. xyρ = 1 in the case of perfect linear interdependence between x and  y; 

2. xyρ = 0 in the case of absence of any dependence between the x and y variables 

(the case of random distribution of the corresponding values); 

3. xyρ < 1 in all other cases, and, in particular: 
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a) when there is come amount of random noise, that is, then the x and y 
values are somewhat dispersed, despite their linear interdependence x and y. 
This situation may be encountered in linear systems analysis, where there is 
random noise present in input and/our output signals. 
b) when there is a clearly defined, but non-linear interdependence between 
the noise- and dispersion-free variables, x and y. 

The coherence function 

Similarly to the correlation factor, the coherence function, 2 ( )fγ , shows within the 
frequency domain, and on the scale from 0 to 1 the quantitative measure of the linear 
interdependence between two processes,  a(t) and  b(t), inherent to separate 
frequency values, f. 

The coherence function is defined by the following expression: 
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The coherence function values, 2 ( )fγ , inherent to separate frequency values, f, 
correspond to the squared values of the correlation factor ρxy . 
Note: In the case of a uniform isolated evaluation (with no averaging), the coherence function has values 
equal to 1. 

The coherence function, 2 ( )fγ , may have values below 1 for the following 
reasons: 

1) the presence of uncorrelated noise in a(t) and/or b(t) signals; 
2) non-linear interdependence between the a(t) and b(t) signals; 
3) the presence of leakage due to and inadequate resolution and/or the 
application of a non-optimal weighting function (a special no-linearity type, 
conditional upon the analysis procedure); 
4) the presence of time delay between the a(t) and b(t), which is 
comparable to the lengths of their respective realizations. 

Applications of the coherence function 

The coherence function is used to check the validity of other function, and to 
determine the degree of noise influence upon the linearity and/or non-linearity of 
these functions. 
Note: Small values of the coherence function do not always indicate the invalidity of the determinate 
functions, and in some cases, indicate the need to increase the number of averaging cycles to guarantee 
valid results. 
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On the basis of the coherence function, you may define a number of other functions, 
having various practical applications. 

The coherent output power 

COP = 2 ( )fγ ⋅GBB(f) indicates the share of the measured intrinsic spectrum of the 
(output) signal GBB(f), which is perfectly coherent with a certain (input) signal a(t).  
Note: In the case of small coherence function values, the COP is valid only when the decrease of 
coherence is due only to noise superimposed upon the output signal. 

In the case when the only factor affecting the degree of coherence is the noise 
superimposed upon the output signal, the coherent output power (proportional to 

2 ( )fγ ) represents the "output signal", while the non-coherent output power 

(proportional to 1- 2 ( )fγ ) represents the "output noise". 

Frequency responses 
Frequency responses (transfer functions) show the ratio of the output values to the 
input values of various systems in the frequency domain, and, therefore, perfectly 
characterize stable, linear, time-invariant physical systems (such as mechanical, 
acoustic and electric systems). 

Based on the results of simultaneous measurements, and the FFT-based input and 
output signal analysis of the physical system, we may determine two different 
estimates of the complex frequency response of this system, i.e. 
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where a(t) is the input signal, and b(t) is the output signal of the system. 

Recommendations for the application of frequency responses 

1. In the presence of parasitic (non-correlated) noise at the output, or in the presence 
of several independent signals at the input, it is appropriate to use the H1(f) estimate 
as an optimal approximation of the frequency response of the corresponding system. 

2. In the presence of parasitic (non-correlated) noise at the output of the system, the 
optimal approximation for the frequency response of the system is the H2(f) 
estimate. 

3. In cases of leakage (caused by inadequate frequency resolution) in resonance 
areas, the H2(f) estimate is preferred, since it approximates the frequency response 
of the system more precisely , as compared to the H1(f) estimate. 
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In the anti-resonance areas of the system under investigation, where the presence of 
noise at the output is possible, it is usually appropriate to use the H1(f) estimate, 
while the H2(f) estimate is usually appropriate in resonance areas, where troubles 
may be caused by the noise at the input and/or the leakage.. 

In situations where parasitic (non-correlated) noises are present at both the input and 
the output of the system under investigation, and the leakage does not cause large 
systematic inaccuracies, the ¦H1(f) ¦ and ¦H2(f) ¦ estimates may be used as, 
respectively, the lower and the higher limits of the interval containing the true values 
of the frequency response amplitude, ¦H(f)¦ 

Recommendations for the application of analog filters 
The filtering subsystem built into the WinPOS package, implements recursive 
digital filtering when virtually any characteristics of frequency selection may be 
applied to the filter, but in order to obtain an optimal quality/speed ratio it is 
recommended to use the following filters: 

• the sixth-order elliptical filter (providing the attenuation at of at least 65 dB 
at double cut-off frequency); 

• the sixth-order Chebyshev filter (providing the attenuation at of at least 60 
dB at double cut-off frequency); 

• the eighth-order Butterworth filter (providing the attenuation at of at least 
55 dB at double cut-off frequency); 

All these filters comply on the safe side to Class 1 filter requirements (filters for 
precise measurements at laboratory and in the field) according to the Russian 
standards GOST 17168-82. 

To check the quality of the required characteristics you may obtain amplitude-
frequency and phase-frequency responses of the synthesized filter in the following 
frequency ranges: 

a) 0 < F < 2⋅Fco for the low-pass filter; 
b)  Fl/2 < F < 2⋅Fu for the band-pass filter; 
c)  Fco/2 < F < 2⋅Fco for the high-pass filter, where Fco if the cut-off frequency for 
low-pass and high-pass filters, Fl, Fu are the lower and upper cut-off frequencies for 
the band-pass filter.  
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The comparative characteristic of methods of numerical 
integration of the differential equation 
WinPOS offers three methods of numerical integration of the differential equation of 
the first order: 

• Eiler’s method; 
• Hamming’s mathod; 
• RC-chain method. 

First two methods, being the best approach of the ideal integrator, more 
considerably, than last, lift (amplify) a signal on low frequencies that is why at the 
decision of practical problems it is not enough applicable. The greatest practical 
value has a method of a RC-chain. As low-frequency effect though also much 
weaker, takes place and in this case, application of the high-pass filter is necessary.  

The second problem – a minimization of an error of a method. The greatest 
contribution is given with low and high frequencies (See figure B.4). 

 

 

error

RC-chain 

ideal integrator

 
Fig. B.4. Amplitude-frequency response of the ideal integrator and a RC-circuit 

The problem is solved exception of the analysis of those sites which have the 
greatest error 

• for area of low frequencies: 

if Fco=Fn/6 , (where Fco – cut-off frequency; Fn - the bottom frequency of 
an analyzed frequency range), error less than 1,5%; 

• in the field of high frequencies it is meaningful to use results of integration 
up to frequency F=Fs/6, where Fs is a sampling rate. 
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The third problem is connected with phase characteristic RC of a circuit which has 
nonlinear dependence on frequency. In this case introduction correcting phase-
frequency is necessary for function which is defined experimental by. 

Example: Fs=2000 Hz; Fn=10 Hz;   
For the given case Fco≈1.7 Hz; F≈333.3 Hz;  
number of points of averaging (refer Appendix A. Processing algorithms) - M≈180. 

 

Recommended reading 
1. Bendat, J., Pearsall, A. Measurement and analysis of random processes. - 
Moscow: Mir, 1974. 

2. Randall, R. B. Frequency analysis. Printed by: K. Larsen and Son, A/O, DK-2600 
Glostrup, Denmark, August 1989. 

3. Herlufsen, H. Two-channel FFT-based analysis, Part 1 and Part 2. Bruel&Kjaer. 
Technical Review, 1984. 

4. Antonew, A. Digital filters: analysis and design, Moscow: Radio i svyaz, 1983. 

5. Randall, R.B. & Hee, J.: "Cepstrum Analysis", B&K Technical Review, No.3, 
1981. 

6. Bradshaw, P. & Randall, R.B. Early Detection and Diagnosis of Machine Faults 
on the Trans Alaska Pipeline, MSA-Session, ASME Conf., Dearborn MI, Sept. 
1983, pp.7-17 
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Appendix C. File formats  

1. USML file structure  
1. The data file of USML type is characterized by the following structure:  

Data file heading Table of parameter passport Information 
32 bytes 58 • <number of parameters> Size not limited 

2. The file heading is characterized by the following structure:  

USML Product 
name 

Test name Test date 
ss/mm/yy 

Number of 
parameters 

(performances) 

Reserve field 

4b 8 bytes 8 bytes 8 bytes 2 bytes 2 bytes 

3. The structure of the parameter passport in the table of passport:  

Parameter Performance Size Discrete K0 K1 Massive 
size 

Fo
rm

at
 Tb Te 

R
ES

ER
VE

 

12b 12 bytes 8b 4b 4b 4b 4b 1b 4b 4b 1b 

4. The information is structured as follows:  

Value massive
of the 1st

parameter 

Massive 
end 
attribute  
(FFFF) 

Value massive
of the 2nd

parameter 

Massive 
end 
attribute  
 (FFFF) 

 . . .  Value 
massive of
the last
parameter 

Massive 
end 
attribute  
 (FFFF) 

5. General notes 

5.1. Each separate file may contain either direct parameter data entry, or the 
parameter characteristics. Direct records and characteristic should not be stored in 
one file.  

5.2. One file may contain performance of different parameters.  

5.3. The number of parameters (performances) in one file should not be more than 
65536. 

6. USML file heading  

6.1. "USML" letters must be found in the first 4-byte field. 

6.2. The fields "product name", "test name", and "test date" contain te symbol lines 8 
byte each.  

7. Parameter passport table  
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7.1. The field "characteristic name" contains a symbolic name of performance or the 
line "DR", in case the file contains direct entry of the parameter data.  

7.2. Sapling step, scaling coefficients K0 and K1, and the time of start and end of the 
data in the massive are set by the floating point format.  

7.3. The scaling coefficients are considered as follows:  

y = K1 · ( x – K0 ), where х - value of parameter or characteristic in the massive, y - 
transformed value of х. If K1=0.0, the scaling is not used.  

7.4. Massive length is an integer without sign.  

7.5. The value format field takes 1 byte and may contain the following data: 

Format Length Format C type Pascal type 
1 1 byte integer unsigned char byte 
2 2 bytes integer short integer 
3 4 bytes integer long longint 
4 4 bytes with floating point float single 
8 8 bytes with floating point double double 

7.6. The value of reserve byte equal to three means the signal writing with unequal 
step, i.e., by Y,X pairs, and the format of each value of the pair is defined by the 
format field. The first half of value massive is taken by the values of Y, the second – 
by the values of X.  

8. Arrays of the parameter (performance) values are arranged in the order of their 
passports in the passport table. The number of bytes of each value is defined by the 
passport field "value format".  

2. MERA file structure 
The present format is distinguished from USML primarily by another data 
representation: instead of one USML file (.usm) the MERA format data are 
distributed in several files (data type extensions).  

The list of files according to the data type is given below:  
Test name.mera - text data an parameter list 
Parameter name1.dat - parameter binary data 
Parameter name1.x - binary data on x axis (at unequal step) 
Parameter name1.prt - shift and time of portion start without registry interrupt 
Parameter name1.lbl - marks, modes, in association with time 
Parameter name1.stat - information on the signal status 
Name of settings.lvl - file containing settings list 
Name calibration.tx - linked calibration files 

1. File .mera (text) 
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Standard ini-file syntax: [section], field=field value, ”;” – comment. Any field can 
be skipped, and then the default value is used. The fields of [MERA] are the file 
heading (example of field listing): 
[MERA] - file signature 
Test=TestName - test name 
Prod=ObjectName - product name 
Date=03.02.01 - test date 
Time=12:34:45.789 - test time 
LinkAll=FALSE - the flag considering all files *.dat of this catalog as paramneters (at 

LinkAll=TRUE). All parameter data fields are filled by default values. 
If this flag is missing, commented or LinkAll=FALSE, the parameters 
of the file .mera only are used.  

Each parameter has a section [parameter name] in the file .mera (example of field 
listing):  
 [{16-1}-M2408] - parameter name 
Char=DR - performance name («DR», «AFR», «spectrum»,…) 
Comment=Test1 - comment 
StartTime=01:02:03.045 - start time of parameter writing, by default: Time(from 

heading) + Start(seconds) 
XUnits=s - X axis units, by default: “s“ 
YUnits=V - Y axis units  
Start=0.0 - start time (initial value of X) , by default: 0 
Step=3.125e-005 - sampling, by default: 1 
Freq=32000 - frequency, by default: 1 
k0=0 
k1=0.038 

- linear conversion coefficients, if not specified:  k0=0,  k1=1 

PolyTX=0 y=k1*(x-k0) if PolyTX=0, y=k1*x+k0 if PolyTX=1 
XFormat=R4 - data format by X, by default: I2 (see below) 
YFormat=R8 - data format by Y, by default: I2 (see below) 
maxY=11172 - maximum value of Y 
minY=-14358 - minimum value of Y 
TX0=calibration.tx - calibration files (must be found in the same catalog) 

 If k1 and k0 are set, the linear conversion is made first.  
If Calibration1=, Calibration2=,…, CalibrationN=, use sequence calibration 

Lvl=settings.lvl - settings file (must be in the same catalog). 
For 3D signals only:  
ZSize=0 - Z axis size: number of sections (for 3D parameters) 
ZStart=0 - Z start value (for 3D parameters) 
ZStep=1 - step by Z axis (for 3D parameters) 
ZUnits=s - Z axis units (for 3D parameters) 
ZFormat=I2 - data format by Z, by default: I2 (see below) 

Possible field values YFormat, XFormat and ZFormat. The line constants analog 
to VARTYPE should be used (Version 1). Example: YFormat=R8 
Values. 
Version 1 

Values. 
Version 2 

Description 

I1 byte - one byte integer with sign 
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UI1 - - one byte integer without sign 
I2 int - two byte integer with sign 
UI2 - - two byte integer without sign 
I4 int32 - four byte integer with sign 
I8 - - eight byte integer with sign 
R4 single - four byte integer with floating point (single precision) 
R8 double - eight byte integer with floating point (double precision)

2. File .dat (binary) 

It contains the parameter binary data. Data format is defined by the field XFormat 
(see above) of the file .mera 

3. File .x (binary) 

It contains the X axis parameter binary data. Data format is defined by the field 
XFormat (see above) of the file .mera 

At equal signal X scale this file is absent!  

4. File .prt (text) 

It contains the information on shifting and the time of portion start when writing and 
3D processing.  

Each line contains the information on one interval in the following formats: 

Field number Format Description 
1 number Initial time value of the next interval. 
2 number Shift in the file.dat, in indexes. 

The fields are separated by spaces, the line is finished by the enter line and line 
return symbols. 

This mode cannot be used with unequal X axis!  
 

5. File .lbl (text) 

It contains the information on modes and marks with association to the signal time 
scale.  

Each line contains the information on one mark in the following formats:  

Field 
number 

Format Description 

1 number Shift by the abscissa, in XUnits. 
2 key word, 

symbol line 
Key word «MODE» – attribute of new mode start. If skipped, a 
simple mark is set by the line. 

3 symbol line Name or mode or mark 
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The fields are separated by space symbols, the line is finished by the line feed and 
return symbols.  

Example: 
105.533 MODE Mode1  
112.178 M1 
145.300 M2 

6. File .lvl (text) 

Contains the information on settings. As well as a calibration file, can be connected 
(in a file .mera) to several parameters simultaneously. 

Each line contains the information on one setting in the following formats:  

Field 
number 

Format Description 

1 symbol “L“ or 
“H“ 

Attribute of high (“H“) or low (“L“) setting. The signal values 
above the high or below the low setting are considered beyond 
the setting. 

2 number setting level in YUnits. 

3 hexadecimal 
constant 

RGB color of setting 

4 symbol line text message of setting (if any) 

The fields are separated by space symbols, the line is finished by the line feed and 
return symbols.  

Example: 
H 5.500 0xFF0000 emergency temperature raise 
H 4.500 0xFFFF00 temperature above normal value 
L -6.500 0xFFFF00 temperature below normal value 
L -7.500 0xFF0000 emergency temperature fall 

7. File .stat (binary) 

Contains the information on changing the signal status in association with the shift. 
Contains the pair sequence of binary words: 

Field number Format Description 
1 binary word, 32 bits Shift in file .dat, in bytes. 
2 binary word, 32 bits Signal status code 

The values of separate status code bits are explained in the file .mera (section 
[MERA]) in format:  
st1=beyond the scale 
st2=unreliable 

The digit here corresponds the bit number of the double status word (1..32). 
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8. File .tx (text) 

Contains polynomial coefficients or interpolation nodes (line written numbers). Has 
two formats: 
x0 y0 
x1 y1 
… 

Each line of file contains a pair of numbers separated by space symbol, to set the 
portion linear conversion.  

  
k0 
k1 
k2 
… 

Each line of file contains one number, definition of polynomial coefficients.  
Number of coefficients matches the polynomial degree, i.e. 
k0, k1 – linear conversion, k0,…k7 –7th degree polynomial, etc. 

The fields are separated by space symbols; the line is finished by the line feed and 
return symbols.  

3. File structure of Vibration Report calculation settings  
The settings file has INI format and can contain several sections, one for each Excel 
page. The section name is written in square brackets and this name must match the 
name of respective page. After the section name the parameters are listed as follows: 

<name_parameter>=<value> 

Tolerable parameters:  

num_chars Number of estimations 
channel_cell Table cell coordinates corresponding the name of the 1st channel. 

Values: number_column, number_line 
channel_orient List of channels in the table.  

Values: HORZ – horizontal; VERT – vertical. 
num_named_channels Number of pre-set channels 
channel1_name Name of the 1st preset channel; 
channel1_chars List of estimation numbers calculated by the present channel 
…  
channel[n]_name Name of preset channel 
channel[n]_chars List of estimation numbers calculated by the present channel 
charact1_options Options of the 1st estimation. Note! This parameter should not be 

used manually. To change this parameter use the vibration report 
settings window and save the result by the menu item «Save 
settings». 

charact1_cell Table cell coordinates the corresponding name of the 1st channel. if 
this field is empty the estimation is not put into the report. 
Values: number_column, number_line  

…  
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charact[n]_options Options of the estimation. Note! This parameter should not be used 
manually. To change this parameter use the vibration report settings 
window and save the result by the menu item «Save settings». 

charact[n]_cell Table cell coordinates the corresponding name of the 1st channel. If 
this field is empty the estimation is not put into the report. 
Values: number_column, number_line 

 

Sample settings file (parameter names are shown by bold font): 
-------------------- start of file ------------------------ 
[Template1] 
num_chars=4 
channel_cell=4,9 
channel_orient=horz 
num_named_channels=1 
channel1_name=TAXO_1 
channel1_chars=4 
 

charact1_options=type=6,name=e1,username=0,srcTaho=-
1,tRez=0,tAxesX=0,tRezMag=0,tTransf=1,tWin=3,rGarm=1.000,deltaF=1.0
00000,nPointsSM=1000,fSortRez=1,fMonFase=1,LevelLo=0.000000,LevelHi
=1.000000,level_dF=1.000000,dPNTwide=0.500000,coefTaho=1.000000,fFr
ont=0,fAbsOtn=0,fFiltrTaho=1,fFiltrTahoSrc=0,nPNTAvr=5 
charact1_cell=4,10 
 

… [ some settings skipped ] … 
 
charact4_options=type=0,name=f1,username=0,srcTaho=,tRez=24,tAxesX=
1,tRezMag=0,tTransf=0,tWin=3,rGarm=1.000,deltaF=1.000000,nPointsSM=
1000,fSortRez=1,fMonFase=1,LevelLo=0.000000,LevelHi=1.000000,level_
dF=1.000000,dPNTwide=0.500000,coefTaho=1.000000,fFront=0,fAbsOtn=0,
fFiltrTaho=1,fFiltrTahoSrc=0,nPNTAvr=5 
charact4_cell= 
------------------- end of file ------------------------- 
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Appendix D. Troubleshooting 

Problem Cause Solution 

Mismatching of the key and 
installed WinPOS copy. 
E.g., the key «Professional» 
allows starting of 
professional and lower 
versions of WinPOS. 
WinPOS Expert does not 
operate with this key. 

Install WinPOS, matching the key marking. If 
marking is damaged run the program 
chknskw.exe from the subdirectory Active of the 
WinPOS installation folder. Usually this folder 
is found «c:\Program Files\MERA\WinPOS». 
The number in the field Mask means: 
001Fh – Expert, 000Fh – Professional, 
0003h – Standard, 0001h – View. 

WinPOS gives a 
message that the 
electronic key is not 
installed. WinPOS 
cannot be started. 

Incorrect installation of 
WinPOS or the system 
configuration disables USB 
driver installation (LPT). 

Check the following. 
1. In CMOS Setup: USB (or LPT) ports enabled. 
2. In NT/2000/XP the installation is made with 
Administrator rights. 
3. USB-key is connected after installation of the 
program and drivers (If Windows founds an 
unknown USB-unit – remove this unit). 
Try to reinstall WinPOS considering the above 
recommendations and following the prompts of 
the installation program. 
If the problem remains unresolved, run the 
program instdrv.exe from the folder Active. 
Press Configure driver and check setting of 
Yes in the field Use this port? Press the button 
Reinstall driver. 

Noticeable defects of 
the graph printout: 
wide black “frame” on 
the right and below, 
chaotic color strips or 
points, wrong printing 
of text, etc.  

Found at some types of 
Windows 2000 graphic 
adapters. This is caused by 
incorrect operation of 
OpenGL drivers from the 
standard Windows package. 

1. Preferable. 
Update drivers from the manufacturer's webpage 
or install a universal package for your adapter 
(Detonator for NVIDIA, Catalyst for ATI 
Radeon, etc) * 
2. Universal. 
If the video adapter drivers cannot be updated 
for some reason, disable graphic acceleration in 
WinPOS settings. 
Set EnableHAL=false in the file winpos.ini.  

The line extends 
beyond the graph field. 

Incorrect operation of 
OpenGL drivers of the 
Windows standard package. 

If the problems remains after updating the video 
adapter* drivers set in the winpos.ini file:  
SafeClip=true 

Empty page instead of 
graph printout.  

Insufficient memory for the 
printer to print the graph 
(half-tone). 

Try to reduce resolution in the printer settings 
from 1200dpi to 600dpi or from 600dpi to 
300dpi. 
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Problem Cause Solution 

In Windows XP if  
WinPOS is started the 
tooltips of the taskbar 
buttons contains 
incorrect text.   

According to the Microsoft 
Support Service the given 
problem emerges in 
Windows XP when any 
application with the 
OpenGL hardware 
acceleration is used.  

The error is corrected in the Windows XP 
Service Pack 2. You can find the instructions as 
to updating and auxiliary information at the 
address: 
http://support.microsoft.com/kb/814135 
 

* - You can find a universal drivers package for NVIDIA videocards (Windows 
2000 and XP) in the Drivers folder of the WinPOS installation disk. 

 

In case you have questions and find no answer in the present User's Guide, or 
detected errors of WinPOS operation, we recommend you to address the technical 
support service.  

WinPOS technical support contacts  

E-mail: winpos@nppmera.ru 

Phone: +7(495)783-42-49 
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Glossary  
Algorithm  

A mathematical description of the sequence of operations to convert one signal into 
another.  

Folder  

The software object created for convenience of storage and searching of the signals 
of similar type. The file of MERA and USML format can be regarded as a folder 
containing signals registered in the course of one test.  

Graph  

The domain limited by the coordinate axis, containing the plotted signal lines. One 
graph can contain several lines.  

Index  

The number of value, offset in the signal value massive. The first signal change is 
associated with zero index.  

Line  

A flat curve graphically representing changing of one signal parameter in respect to 
another one. As a rule, the line shows a change of registered or calculated parameter 
as a function of time.  

Operator  

The algorithm with the customization set.  

Page  

The software object uniting several graphs.  

Signal  

The information (data massive containing service information) registered in the 
course of test in one physical channel or obtained by the source signal processing.  

Tachosignal  

Tachosignal is the signal from the RPM sensor mounted on a rotating part of 
machine. 
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Tachocharacteristic 

The tachocharacteristic is the frequency characteristic of the tachosignal. It shows 
the rotation frequency expressed in Hertz (Hz) or RPM change over the time. The 
reduced designation of the tachocharacteristic – "tacho" – is also used in the 
WinPOS. 

Tachofrequency 

The tachofrequency is the calculated value of the tachocharacteristic in a given 
moment. 

Tree  

A hierarchy data storage structure used by WinPOS for systematization of access to 
the source data and results, algorithms, graphs, etc. In Windows the tree is displayed 
by a standard element.  

Work session 

The WinPOS state: the signals loaded and received during processing, the plotted 
graphs. The session can be saved on a disk and later is restored. 


